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Software Models
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Software engineering is the discipline of designing,
implementing and maintaining software. The process of
software engineering starts with requirements and
constraints as inputs, and results in programming code and
schemas that are deployed to a variety of platforms, creating
running systems.

Enterprise Architect has a rich set of tools and features that
assist Software Engineers to perform their work efficiently
and reduce the number of errors in implemented solutions.
The features include design tools to create models of
software, automated code generation, reverse engineering of
source code, binaries and schemas, and tools to synchronize
source code with the design models. The programming code
can be viewed and edited directly in the integrated Code
Editors within Enterprise Architect, which provide
Intelli-sense and other features to aid in coding.

c) Sparx Systems age 11o
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Another compelling aspect of the environment is the ability
to trace the implementation Classes back to design elements
and architecture, and then back to the requirements and
constraints and other specifications, and ultimately back to
stakeholders and their goals and visions.

Enterprise Architect supports a wide range of programming
languages and platforms and provides a lightweight and
seamless integration with the two most prevalent Integrated
Development Environments: Visual Studio and Eclipse. In
addition there is a fully featured Execution Analyzer that
allows the Software Engineer to design, build debug and test
software modules right inside Enterprise Architect.

Facilities
Facility Description
Development = Discover the tightly Integrated

Tools Development Environment with
outstanding tools and functionality.

Code, Build | Model, develop, debug, profile and
and Debug  manage an application from within the
modeling environment.

Visual Understand your code base by visually
Analysis of | analyzing running code. Use Test Points,

(c) Sparx Systems 2019 Page 12 of 674
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Executing
Code

Generate
Source Code

Importing
Source Code

%

(c) Sparx Systems 2019

profiling and automated diagram
generation.

Explore some of the ways to generate
source code for a single Class, a selection
of Classes, or a whole Package. Generate
from structural or behavioral models.

Examine existing systems by importing
source code into Enterprise Architect.
View and modify dialog definitions.
Synchronize the model with the latest
updates to source code.

Page 13 of 674
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Integrated Development

T T T N e ——

Enterprise Architect provides an unmatched set of tools and
features for the Software Engineer, to assist in the process of
creating robust and error free software systems. The
engineer can start by defining the architecture and ensuring
that it traces back to the requirements and specification.
Technology neutral models can be transformed to target a
comprehensive range of programming languages. The
Model Driven Development Environment fits the bill for
various technologies.

Features

Developmen e Model driven development with
t Tools best-in-class UML tools

e Generate and reverse engineer code

c) Sparx Systems age 140
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Traceability

Usage

Popular
Languages

(c) Sparx Systems 2019

e Customize code generation with
templates

e Analyzer Scripts to manage your
applications

e Code editors to author the code base
e Debuggers to investigate behavior

e Profilers to visualize behavior

e Analyzers to record behavior

e Testpoints for validation of
programming contracts

e Integration with jUnit and nUnit

e Eclipse or Visual Studio Integration
where required

At a glance traceability of
Generalizations, Realizations,
Associations, Dependencies and more.
Customize relationship views. Easily
navigate related elements in the model.

Quickly browse element usage across all
diagrams. Perform powerful element
searches using sophisticated queries.

. C/CH++

. Java

. Microsoft .NET family
. ADA

Page 15 of 674
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. Python
. Perl
. PHP

Toolboxes Toolboxes are provided for a vast array of
modeling technologies and programming
languages.

Application Enterprise Architect provides complete
Patterns starter projects, including model
information, code and build scripts, for
several basic application types.

c) Sparx Systems age 160
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Feature Overview

Code Engineering with Enterprise Architect broadly
encompasses various processes for the design, generation
and transformation of code from your UML model.

Features

Model
Driven Code
Engineering

Transformat
ions for
Rapid
Developmen
t

(c) Sparx Systems 2019

. Source code generation and reverse

engineering for many popular
languages, including C++, C#, Java,
Delphi, VB.Net, Visual Basic,
ActionScript, Python and PHP

. A built in 'syntax highlighting' source

code editor

. Code generation templates, which

enable you to customize the generated
source code to your company
specifications

. Advanced Model Driven Architecture

(MDA) transformations using
transformation templates

. Built-in transformations for DDL, C#,

Java, EJB and XSD

. One Platform Independent Model can

Page 17 of 674
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be used to generate and synchronize
multiple Platform Specific Models,
providing a significant productivity
boost

. XSL Transform diagram, toolbox,
editor and debugger.

Visual . Execute build, test, debug, run and
Execution deploy scripts

Analysis/ . Integrate UML development and

Debugging, modeling with source development and
Verification compilation

o an.d . Generate NUnit and JUnit test Classes
Visualizatio from source Classes using MDA

n Transformations

. Integrate the test process directly into
the Enterprise Architect IDE

. Debug .NET, Mono, Java and
Microsoft Native (C, C++ and Visual
Basic) applications

. Design and execute Test suites based
on Programming by Contract principles

. XSL Stylesheet debugging

Database Enterprise Architect enables you to:

Modeling . Reverse engineer from many popular
DBMSs, including SQL Server, My
SQL, Access, PostgreSQL and Oracle

(c) Sparx Systems 2019 Page 18 of 674
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. Model database tables, columns, keys,
foreign keys and complex relationships
using UML and an inbuilt data
modeling profile

. Forward generate DDL scripts to create
target database structures

XML Enterprise Architect enables you to
Technology rapidly model, forward engineer and
Engineering reverse engineer two key W3C XML
technologies:

. XML Schema (XSD)

. Web Service Definition Language
(WSDL)

XSD and WSDL support is critical for the
development of a complete Service
Oriented Architecture (SOA), and the
coupling of UML 2.5 and XML provides
the natural mechanism for implementing
XML-based SOA artifacts within an
organization.

c) Sparx Systems age 190
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Generate Source Code

UML
] ":.:. : :‘-"-'\ -' y -.\'i_'ﬁ."\-
L ST 5| /Cohsmf ChrsaiPHP

Source code generation is the process of creating
programming code from a UML model. There are great
benefits in taking this approach as the source code Packages,
Classes and Interfaces are automatically created and
elaborated with variables and methods.

o,

Enterprise Architect can also generate code from a number
of behavioral models, including StateMachine, Sequence
and Activity diagrams. There 1s a highly flexible template
mechanism that allows the engineer to completely tailor the
way that source code 1s generated, including the comment
headers in methods and the Collection Classes that are used.

From an engineering and quality perspective, the most
compelling advantage of this approach is that the UML
models and therefore the architecture and design are
synchronized with the programming code. An unbroken
traceable path can be created from the goals, business
drivers and the stakeholder’s requirements right through to
methods in the programming code.

Facilities

Facility Description

(c) Sparx Systems 2019 Page 20 of 674
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Languages Enterprise Architect supports code
generation in each of these software
languages:

. Action Script
. Ada

. ArcGIS

. C

. C# (for NET 1.1, NET 2.0 and .NET
4.0)

. C++ (standard, plus .NET managed
C++ extensions)

. Delphi

. Java (including Java 1.5, Aspects and
Generics)

. JavaScript

. MFQL

. MySql

. PHP

. Python

. Teradata SQL

. Visual Basic

. Visual Basic .NET
. WorkFlowScript

You can also generate Hardware
Definition Language code in these
languages:

c) Sparx Systems age 21o
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Elements

Settings

(c) Sparx Systems 2019

. VHDL
. Verilog
SystemC

Code is generated from Class or Interface
model elements, so you must create the
required Class and Interface elements to
generate from. All other types of element
to contribute to the code (such as
StateMachines or Activities) must be
child elements of a Class.

Add attributes (which become variables)
and operations (which become methods).
Constraints and Receptions are also
supported in the code.

Before you generate code, you should
ensure the default settings for code
generation match your requirements; set
up the defaults to match your required
language and preferences.

Preferences that you can define include
default constructors and destructors,
methods for interfaces and the Unicode
options for created languages.

Languages such as Java support
'namespaces' and can be configured to
specify a namespace root.

In addition to the default settings for

Page 22 of 674
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generating code, Enterprise Architect
facilitates setting specific generation
options for each of the supported

languages.
Code The Code Template Framework (CTF)
Template enables you to customize the way
Framework Enterprise Architect generates source

code and also enables generation of
languages that are not specifically
supported by Enterprise Architect.

Local Paths Local path names enable you to substitute
tags for directory names.

Behavioral You can also generate software code
Code from three UML behavioral modeling
paradigms:

. Interaction (Sequence) diagrams
. Activity diagrams
StateMachine diagrams (using Legacy

State Machine Templates in the code
generation operations under '"Tasks')

StateMachine diagrams (using an
Executable State Machine Artifact)

Live Code On the 'Develop > Preferences > Options'
Generation drop-down menu, you have the option to
update your source code instantly as you

c) Sparx Systems age 230
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make changes to your model.

Tasks When you generate code, you perform
one or more of these tasks:

. Generate a Single Class

. Generate a Group of Classes
. Generate a Package

. Update Package Contents

Notes

. Most of the tools provided by Enterprise Architect for
code engineering and debugging are available in the
Professional and higher editions of Enterprise Architect;
Behavioral Code Generation is available in the Unified
and Ultimate editions

. When security is enabled you require the access
permissions 'Generate Source Code and DDL' and
'Reverse Engineer from DDL and Source Code'

(c) Sparx Systems 2019 Page 24 of 674
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Generate a Single Class

Before you generate code for a single Class, you:

. Complete the design of the model element (Class or
Interface)

. Create Inheritance connectors to parents and Associations
to other Classes that are used

. Create Inheritance connectors to Interfaces that your Class
implements; the system provides an option to generate
function stubs for all interface methods that a Class
implements

Generate code for a single Class

Ste Action
p

1 | Open the diagram containing the Class or Interface
for which to generate code.

2 | Click on the required Class or Interface and select
the 'Develop > Source Code > Generate > Generate
Single Element' ribbon option, or press F11.

The 'Generate Code' dialog displays, through which
you can control how and where your source code is
generated.

(c) Sparx Systems 2019 Page 25 of 674



User Guide - Software Models 7 August, 2019

3

In the "Path’' field, click on the [-] button and select a
path name for your source code to be generated to.

In the 'Target Language' field, click on the
drop-down arrow and select the language to
generate; this becomes the permanent option for that
Class, so change it back if you are only doing one
pass in another language.

Click on the Advanced button.

The 'Object Options' dialog displays, providing
subsets of the 'Source Code Engineering' and code
language options pages on the 'Preferences' dialog.

Set any custom options (for this Class alone), then

click on the Close button to return to the 'Generate
Code' dialog.

In the 'Tmport(s) / Header(s)' fields, type any import
statements, #includes or other header information.
Note that in the case of Visual Basic this information
1s ignored; in the case of Java the two import text
boxes are merged; and in the case of C++ the first
import text area 1s placed in the header file and the
second 1n the body (.cpp) file.

Click on the Generate button to create the source
code.

c) Sparx Systems age 260
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9 | When complete, click on the View button to see
what has been generated.

Note that you should set up your default
viewer/editor for each language type first; you can
also set up the default editor on the 'Code Editors'
page of the Preferences window ('Start > Desktop >
Preferences > Preferences > Source Code
Engineering > Code Editors').

(c) Sparx Systems 2019 Page 27 of 674
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Generate a Group of Classes

In addition to being able to generate code for an individual
Class, you can also select a group of Classes for batch code
generation. When you do this, you accept all the default
code generation options for each Class in the set.

Generate Class Group

Ste Detail
P
1 | Select a group of Classes and/or interfaces in a

diagram.

Click on an element in the group and select the
'Develop > Source Code > Generate > Generate
Selected Element(s)' ribbon option (or press
Shift+F11).

If no code exists for the selected elements, the 'Save
As' dialog displays on which you specify the file
path and name for each code file; enter this
information and click on the Save button.

The 'Batch Generation' dialog displays, showing the
status of the process as it executes (the process might
be too fast to see this dialog).

(c) Sparx Systems 2019 Page 28 of 674
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If code already exists for the selected Class
elements, and changes have been made to the Class
name or structure, the 'Synchronize Element
<package name>.<element name>' dialog might also
display; this dialog helps synchronize the model and
code.

Notes

e If any of the elements selected are not Classes or
interfaces the option to generate code is not available

(c) Sparx Systems 2019 Page 29 of 674
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Generate a Package

In addition to generating source code from single Classes
and groups of Classes, you can generate code from a
Package. This feature provides options to recursively
generate code from child Packages and automatically
generate directory structures based on the Package
hierarchy. This helps you to generate code for a whole
branch of your project model in one step.

Access

Ribbon Develop > Source Code > Generate >
Generate All

Keyboard Ctrl+Alt+K
Shortcuts

Generate code from a Package, on the
Generate Package Source Code dialog

Ste Action
P

(c) Sparx Systems 2019 Page 30 of 674
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1 Inthe 'Synchronize' field, click on the drop-down
arrow and select the appropriate synchronize option:

. 'Synchronize model and code': Code for Classes
with existing files 1s forward synchronized with
that file; code for Classes with no existing file is
generated to the displayed target file

. 'Overwrite code': All selected target files are
overwritten (forward generated)

. 'Do not generate': Generate code for only those
selected Classes that do not have an existing file;
all other Classes are ignored

2 Highlight the Classes for which to generate code;
leave unselected any to not generate code for.

If you want to display more of the information
within the layout, you can resize the dialog and its
columns.

3 | To make Enterprise Architect automatically generate
directories and filenames based on the Package
hierarchy, select the 'Auto Generate Files' checkbox;
this enables the 'Root Directory' field, in which you
select a root directory under which the source
directories are to be generated.

By default, the 'Auto Generate Files' feature ignores
any file paths that are already associated with a
Class; you can change this behavior by also selecting
the 'Retain Existing File Paths' checkbox.

(c) Sparx Systems 2019 Page 31 of 674
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4 | To include code for all sub-Packages in the output,
select the 'Include Child Packages' checkbox.

5 | Click on the Generate button to start generating
code.

As code generation proceeds, Enterprise Architect
displays progress messages. If a Class requires an
output filename the system prompts you to enter one
at the appropriate time (assuming Auto Generate
Files 1s not selected). For example, if the selected
Classes include partial Classes, a prompt displays to
enter the filename into which to generate code for
the second partial Class.

Further information on the dialog options

Option Action

Root Package Check the name of the Package for which
code 1s to be generated.

Synchronize | Select options that specify how existing
files should be regenerated.

Auto Specify whether Enterprise Architect

c) Sparx Systems age 320
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Generate
Files

Root
Directory

Retain
Existing File
Paths

Include all
Child
Packages

Select
Objects to
Generate
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7 August, 2019

should automatically generate file names
and directories, based on the Package
hierarchy.

If Auto Generate Files is selected, display
the path under which the generated
directory structures are created.

If Auto Generate Files is selected, specify
whether to use existing file paths
associated with Classes.

If Auto Generate Files 1s unselected,
Enterprise Architect generates Class code
to automatically determined paths,
regardless of whether source files are
already associated with the Classes.

Also generate code for all Classes in all
sub-Packages of the target Package in the
list.

This option facilitates recursive

generation of code for a given Package
and 1ts sub-Packages.

List all Classes that are available for code
generation under the target Packages;
only code for selected (highlighted)
Classes is generated.

Classes are listed with their target source

Page 33 of 674



User Guide - Software Models 7 August, 2019

file.
Select All Mark all Classes in the list as selected.
Select None Mark all Classes in the list as unselected.

Generate Start the generation of code for all
selected Classes.

!

Cancel Exit the 'Generate Package Source Code
dialog; no Class code 1s generated.

(c) Sparx Systems 2019 Page 34 of 674
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Update Package Contents

In addition to generating and importing code, Enterprise
Architect provides the option to synchronize the model and
source code, creating a model that represents the latest
changes in the source code and vice versa. You can use
either the model as the source, or the code as the source.

The behavior and actions of synchronization depend on the
settings you have selected on the 'Attributes and Operations
page of the 'Preferences' dialog. Working with these
settings, you can either protect or automatically discard
information in the model that is not present in the code, and
prompt for a decision on code features that are not in the
model. In these two examples, the appropriate checkboxes
have been selected for maximum protection of data:

'

. You generated some source code, but made subsequent
changes to the model; when you generate code again,
Enterprise Architect adds any new attributes or methods
to the existing source code, leaving intact what already
exists, which means developers can work on the source
code and then generate additional methods as required
from the model, without having their code overwritten or
destroyed

. You might have made changes to a source code file, but
the model has detailed notes and characteristics you do
not want to lose; by synchronizing from the source code
into the model, you import additional attributes and
methods but do not change other model elements

(c) Sparx Systems 2019 Page 35 o0of 674



User Guide - Software Models 7 August, 2019

Using the synchronization methods, it i1s simple to keep
source code and model elements up to date and
synchronized.

Access

Ribbon Develop > Source Code > Synchronize >
Synchronize Package

Synchronize Package contents against source
code

Field/Button | Action

Update Type @ Select the radio button to either Forward
Engineer or Reverse Engineer the
Package Classes, as appropriate.

Include child | Select the checkbox to include child
packages in Packages in the synchronization.
generation

OK Click on the button to start
synchronization.

c) Sparx Systems age 360
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Enterprise Architect uses the directory
names specified when the project source
was first imported/generated and updates
either the model or the source code
depending on the option chosen. If:

. Performing forward synchronization
AND

. There are differences between the
model and code AND

. The 'On forward synch, prompt to
delete code features not in model'
checkbox is selected in the 'Options -
Attributes and Operations' dialog

THEN the 'Synchronize Element
<package name>.<element name>' dialog
displays.

Otherwise, no further action 1s required.

Notes

. Code synchronization does not change method bodies;
behavioral code cannot be synchronized, and code
generation only works when generating the entire file

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Generate Source Code and DDL' permission to

(c) Sparx Systems 2019 Page 37 of 674
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synchronize source code with model elements

c) Sparx Systems age 380
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Synchronize Model and Code

Y ou might either:

. Synchronize the code for a Package of Classes against the
model in the Browser window, or

. Regenerate code from a batch of Classes in the model

In such processes, there might be items in the code that are
not present in the model.

If you want to trap those items and resolve them manually,
select the 'On forward synch, prompt to delete code features
not in model' checkbox in the 'Options - Attributes and
Operations' dialog, so that the 'Synchronize Element
<package name>.<element name>' dialog displays,
providing options to respond to each item.

Synchronize Items

Button Detail

Select All Highlight and select all items in the
Feature column.

Clear All Deselect and remove highlighting from
all items 1n the Feature column.

Delete Mark the selected code features to be
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Reassign

Ignore

Reset to
Default

OK

(c) Sparx Systems 2019

removed from the code (the value in the
Action column changes to Delete).

Mark the selected code features to be
reassigned to elements in the model.

This is only possible when an appropriate
model element is present that is not
already defined in the code.

The Select the Corresponding Class
Feature dialog displays, from which you
select the Class to reassign the feature to.
Click on the OK button to mark the
feature for reassignment.

Mark the selected code elements not
present in the model to be ignored
completely (the default; the value in the
Action column remains as or changes to
<none>).

Reset the selected items to Ignore (the
value in the Action column changes to
<none>).

Make the assigned changes to the items,
and close the dialog.
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Namespaces

Languages such as Java support Package structures or
namespaces. In Enterprise Architect you can specify a
Package as a namespace root, which denotes where the
namespace structure for your Class model starts; all
subordinate Packages below a namespace root will form the
namespace hierarchy for contained Classes and Interfaces.

To define a Package as a namespace root, click on the
Package in the Browser window and select the 'Develop >
Preferences > Options > Set as Namespace Root' ribbon
option. The Package icon in the Browser window changes to
show a colored corner indicating this Package is a

namespace root.
A

Generated Java source code, for example, will automatically
add a Package declaration at the beginning of the generated
file, indicating the location of the Class in the Package
hierarchy below the namespace root.

To clear an existing namespace root, click on the namespace
root Package in the Browser window and deselect the
'Develop > Preferences > Options > Set as Namespace Root'
ribbon option

To view a list of namespaces, select the 'Configure >
Reference Data > Settings > Namespace Roots' ribbon
option; the 'Namespaces' dialog displays. If you
double-click on a namespace in the list, the Package is
highlighted in the Browser window; alternatively,
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right-click on the namespace and select the 'Locate Package
in Browser' option.

You can also clear the selected namespace root by selecting
the 'Clear Namespace Attribute' option.

To omit a subordinate Package from a namespace definition,
select the 'Develop >Preferences > Options > Suppress
Namespace' ribbon option; to include the Package in the
namespace again, deselect the ribbon option.

Notes

e When performing code generation, any Package name that
contains whitespace characters is automatically treated as
a namespace root
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Importing Source Code

UML
&% Es '
Cy yavf C, ¥01 PHP A5 50

The ability to view programming code and the models it is
derived from at the same time brings clarity to the design of
a system. One of Enterprise Architect's powerful code
engineering features is the ability to Reverse Engineer
source code into a UML model. A wide range of
programming languages are supported and there are options
that govern how the models are generated. Once the code is
in the model it is possible to keep it synchronized with the
model regardless of whether the changes were made directly
in the code or the model itself. The code structures are
mapped into their UML representations; for example, a Java
class 1s mapped into a UML Class element, variables are
defined as attributes, methods modeled as operations, and
interactions between the Java classes represented by the
appropriate connectors.

The representation of the programming code as model
constructs helps you to gain a better understanding of the
structure of the code and how it implements the design,
architecture and the requirements, and ultimately how it
delivers the business value.

It 1s important to note that if a system 1s not well designed,
simply importing the source into Enterprise Architect does
not turn it into an easily understandable UML model. When
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working with a poorly designed system it is useful to assess
the code in manageable units by examining the individual
model Packages or elements generated from the code; for
example, dragging a specific Class of interest onto a
diagram and then using the 'Insert Related Elements' option
at one level to determine the immediate relationships
between that Class and other Classes. From this point it is
possible to create Use Cases that identify the interaction
between the source code Classes, providing an overview of
the application's operation.

Several options guide how the code 1s reversed engineered,
including whether comments are imported to notes and how
they are formatted, how property methods are recognized
and whether Dependency relationships are created for
operation return and parameter types.

Copyright Ownership

Situations that typically lend themselves to reverse
engineering tend to operate on source code that:

. You have already developed

. Is part of a third-party library that you have obtained
permission to use

. Is part of a framework that your organization uses
. Is being developed on a daily basis by your developers

If you are examining code that you or your organization do
not own or do not have specific permission to copy and edit,
you must ensure that you understand and comply with the
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copyright restrictions on that code before beginning the
process of reverse engineering.

Supported languages for Reverse
Engineering

Language

Action Script

Ada 2012 (Unified and Ultimate editions)
C

C#

C++

CORBA IDL (MDG Technology)

Delphi

Java

PHP
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Python
SystemC (Unified and Ultimate editions)
Verilog (Unified and Ultimate editions)

VHDL (Unified and Ultimate editions)
Visual Basic

Visual Basic .NET

Notes

. Reverse Engineering 1s supported in the Professional,
Corporate, Unified and Ultimate editions of Enterprise
Architect

. If security 1s enabled you must have 'Reverse Engineer
From DDL And Source Code' permission to reverse
engineer source code and synchronize model elements
against code

. Using Enterprise Architect, you can also import certain

types of binary files, such as Java .jar files and .NET PE
files

. Reverse Engineering of other languages is currently
available through the use of MDG Technologies listed on
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the MDG Technology pages of the Sparx Systems website
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Import Projects

Enterprise Architect provides support for importing software
projects authored in Visual Studio, Mono, Eclipse and
NetBeans. Importing projects has multiple benefits, not least
the immediate access to Enterprise Architect's renowned
modeling tools and management features, but importantly
the access to development tools such as simulation,
debugging and profiling.

Access

Ribbon Develop > Source Code > Solutions >
Import a <project type>

Import Options

Option Description
Prompt for For C++ projects, the parser might
Missing encounter unrecognized macros. If you
Macro select this option, you will be prompted
Definitions when such an event occurs and will have
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the opportunity to define the macro. If
you do not select this option, the resultant
Class model could be missing certain

items.
Create When selected, a Class diagram 1s created
Diagram for = depicting the Class model for each
Each Package. The result is a larger but more
Package colorful model. Deselecting this option

will cause diagram creation to be skipped
and the import to run faster.

Generate Selecting this option will generate
Analyzer Analyzer Scripts for each project
Scripts configuration in addition to scripts for

each Solution configuration. The scripts
will allow for building and debugging the
program(s) described by the solution
immediately after the import completes.
Note: Select the 'Windows' platform. If
you do not select this option, no
Execution Analyzer features will be

configured.
Startup When this is selected, the script for this
Project Project will become the model default.

The Execute ribbon and Toolbar buttons
will automatically target this program.
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Import Visual Studio Solution

This option allows you to import one or more projects from
an existing Visual Studio Solution file or a running instance
of Visual Studio. The wizard will generate a Class model for
cach of the projects and the appropriate Analyzer Scripts for
each Visual Studio configuration.

Import Mono Solution

This option allows you to import Mono projects from a
solution file. The dialog that 1s presented 1s the same as the
'Visual Studio Import' dialog, but you can choose to target
either Linux or Windows. The wizard will generate a Class
model for each of the projects and configure them for
debugging.

Import Options

Option Description
Find and The Mono Solution files have a .sln file
Select the extension, as for Visual Studio.
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Solution File.

Select the After the solution is selected, the projects

Projects to in the solution are displayed. Select the

Import projects from the list that should be
imported by the wizard.

Prompt for Not applicable.

Missing

Macros

Create When selected, a Class diagram is created

Diagram for = depicting the Class model for each

Each Package. The result is a larger but more

Package colorful model. Deselecting this option
will cause diagram creation to be skipped
and the import to run faster.

Generate This option allows you to target either

Analyzer Linux or Windows. If you select Linux, it

Scripts 1s assumed the machine on which
Enterprise Architect 1s running is Linux,
that the platform (Java or Mono) 1s
installed there, and that the compiled
programs run on Linux.

Startup Selecting the Startup project means that

Project the debugging tools will be set to target

that program by default.
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Import Eclipse Project

The Eclipse 'Wizard' can reverse engineer a Java project
described by its Eclipse .project file and ANT build. The
feature will result in a UML Class model and Analyzer
Scripts for each of the ANT targets you select. The process
will also generate a script for each debug protocol you select
through the 'Wizard'. You will be presented with the choice
of JDWP (Java Debug Wire Protocol), good for servers, and
JVMTI (Java Virtual Machine Tools Interface), which 1s
suited to standalone Java applications. These scripts should
be used for debugging the project in Enterprise Architect.

Import NetBeans Project

The NetBeans 'Wizard' can reverse engineer a Java project
described by a NetBeans XML project file and ANT build.
The 'Wizard' will create a UML Class model of the project
and Analyzer Scripts for each of the ANT targets you select.
The process will also generate a script for each debug
protocol you select through the 'Wizard'. These scripts
should be used for debugging the project in Enterprise
Architect. You will be presented with the choice of JDWP
(Java Debug Wire Protocol), good for servers, and JVMTI
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(Java Virtual Machine Tools Interface), which is suited to
standalone Java applications
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Import Source Code

You can import source code into your Enterprise Architect
model, to reverse-engineer a module. As the import
proceeds, Enterprise Architect provides progress
information. When all files are imported, Enterprise
Architect makes a second pass to resolve associations and
inheritance relationships between the imported Classes.

Procedure - Import source code

Ste Action
p

1 | Inthe Browser window, select (or add) a diagram
into which to import the Classes.

2 Click on the diagram background and either:

. Select the 'Develop > Source Code > Files' ribbon
option and click on the appropriate language, or

. If the Code Generation toolbar is displayed, click
on the 'Tmport' drop-down arrow and select the
language to import

The list of languages will include any customized
languages you have created model structures for.

3 | From the file browser that appears, locate and select
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one or more source code files to import.

4 | Click on the Open button to start the import process.
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Notes on Source Code Import

You can import code into your Enterprise Architect project,
in a range of programming languages. Enterprise Architect
supports most constructs and keywords for each coding
language. You select the appropriate type of source file for
the language, as the source code to import.

If there is a particular feature you require support for that
you feel 1s missing, please contact Sparx Systems.

Notes

. When reverse engineering attributes with parameter
substitutions (templated attributes):
- If a Class with proper template parameter definitions
1s found, an Association connector 18
created and its parameter substitutions are configured
- An Association connector is also created if a
matching entry is defined as a Collection Class or
in the 'Additional Collection Classes' option (for C#,
C++ and Java); for an example, see Example
Use of Collection Classes

Programming Language notes
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Language

ActionScript

C++

(c) Sparx Systems 2019

Notes

Appropriate type of source file: .as code
file.

Appropriate type of source file: .h header
files and/or .c files.

When you select a header file, Enterprise
Architect automatically searches for the
corresponding .c implementation file to
import, based on the options for
extension and search path specified in the
C options.

Enterprise Architect does not expand
macros that have been used, these must
be added into the internal list of
Language Macros.

Appropriate type of source file: .h header
file.

Enterprise Architect automatically
searches for the .cpp implementation file
based on the extension and search path
set in the C++ options; when it finds the
implementation file, it can use it to
resolve parameter names and method
notes as necessary.

When importing C++ source code,
Enterprise Architect ignores function
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pointer declarations.

To import them into your model you
could create a typedef to define a
function pointer type, then declare
function pointers using that type; function
pointers declared in this way are imported
as attributes of the function pointer type.
Enterprise Architect does not expand
macros that have been used; these must
be added into the internal list of
Language Macros.

C# Appropriate type of source file: .cs.
Delphi Appropriate type of source file: .pas.
Java Appropriate type of source file: .java.

Enterprise Architect supports the AspectlJ
language extensions.

wBSpacts
ThingObserving

SENENS. Veoor = new vech

+ addObsenverThing, Thing) : woid
+ memovelbsernverThing, ThingCOhsanser) : void
~ updateCbserver(Thing, ThingObhsener) : void

wadvices
+ after(Thing) : void

~ changes({Thing) : wvoid

Aspects are modeled using Classes with
the stereotype aspect; these aspects can
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then contain attributes and methods as for
a normal Class.

If an intertype attribute or operation 1s
required, you can add a tag 'className'
with the value being the name of the
Class it belongs to.

Pointcuts are defined as operations with
the stereotype <<pointcut>>, and can
occur in any Java Class, Interface or
aspect; the details of the pointcut are
included in the 'behavior' field of the
method.

Advice is defined as an operation with
the stereotype <<advice>>; the pointcut
this advice operates on is in the 'behavior'
field and acts as part of the method's
unique signature.

afterAdvice can also have one of the

Tagged Values returning or throwing
PHP Appropriate type of source file: .php,

.php4, or .inc.

Nested if condition syntax is enabled.

Python Appropriate type of source file: .py.

Visual Basic = Appropriate type of source file: .cls Class
file.
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Visual Basic ~ Appropriate type of source file: .vb Class
NET file.
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Import Resource Script

Enterprise Architect supports the import and export of
Microsoft Windows Resource Scripts (as .rc files), which
contain the Win32® dialog definitions (those with the
stereotype «win32Dialogy) for an application's graphical
user interface. Dialog resources are imported and exported
for a specific language, defaulting to the locale of the
current computer system.

Access
Ribbon Develop > Source Code > Files > Import
Resource Script
Keyboard F7 (synchronize element with code)
Shortcuts

Import dialog resources from a .rc file

Option Action

Resource File = Click on the [-] button and locate the .rc
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file to import the screen elements(s) from.

Resource ID @ Either:

. Leave the default value 'All' to import
all screen elements from the file, or

. Click on the drop-down arrow and
select the screen ID of a specific dialog
to import

Language Click on the drop-down arrow and select
the language version (such as English -
United States) of the dialog(s) to import.

Import Click on this button to import the screens
from the resource file.

The progress of the import is reported in
the field underneath the 'Language' field.

Export a dialog to a .rc file

Option Action

Screen ID Defaults from the Win32UI ID Tagged
Value of the selected Screen element.

(If the dialog does not have this ID, open
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Resource File

Language

Export

Notes

the 'Win32UI' page of the element's

'Properties' dialog and provide a value for
the ID tag.)

Click on the [ | button and locate the .rc
file into which to export the screen
clement(s).

If the element was previously imported,
this field defaults to the source file.

Click on the drop-down arrow and select
the language version (such as English -
United States) of the exported dialog.

Click on this button to export the screens
from the resource file.

The progress of the export is reported in
the field underneath the 'Language’ field.

. New dialogs are exported to an existing .rc file

. In an export to an existing .rc file, no dialogs are ever
deleted from the file, even when they are deleted from the

model

. In an import, no dialogs are deleted from the model even
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when omitted from the original .rc file
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Import a Directory Structure

You can import from all source files in a complete directory
structure, which enables you to import or synchronize
multiple files in a directory tree in one pass.

Enterprise Architect creates the necessary Packages and
diagrams during the import process.

Access

Ribbon Develop > Source Code > Files > Import
Source Directory

Keyboard Ctrl+Shift+U
Shortcuts

Import a directory structure, using the
'Import Source Directory' dialog

Ste Action
p

1  Select the options you require; you can configure:
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. The source directory

. The source type

. The file extensions to look at

. Whether to process sub directories

. Whether to create a diagram for each Package

. Whether to import additional files as described in
the 'Import Component Types' dialog

. Whether to exclude private members from
libraries being imported from the model

. Whether to Synchronize or Overwrite existing
Classes when found; if a model Class is found
matching the one in code:

- 'Synchronize' updates the model Class to
include the details
from the one in code, which preserves
information not
represented in code, such as the location of
Classes 1n diagrams
- 'Overwrite' deletes the model Class and
generates a new one
from code, which deletes and does not
replace the additional
information

. Whether to create a Package for every directory,
namespace or file; this might be restricted
depending on the source type selected

. How to handle Classes not found during the
import (prompt for action enables you to review
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Classes individually)
. What 1s shown on diagrams created by the import

2 | Click on the OK button to start.
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Import Binary Module

Enterprise Architect enables you to reverse-engineer certain
types of binary modules.

Access
Ribbon Develop > Source Code > Files > Import
Binary Module
Use

Currently the permitted types are:
. Java Archive (.jar)

. .NET PE file (.exe, .dll) - Native Windows DLL and EXE
files are not supported, only PE files containing .NET
assembly data

. Intermediate Language file (.il)

Enterprise Architect creates the necessary Packages and
diagrams during the import process; selecting the 'Do not
import private members' checkbox excludes private
members from libraries from being imported into the model.

When importing .NET files, you can import via reflection or
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via disassembly, or let the system select the best method -
this might result in both types being used.

The reflection-based importer relies on a .NET program, and
requires the .NET runtime environment to be installed.

The disassembler-based importer relies on a native
Windows program called Ildasm.exe, which is a tool

provided with the MS .NET SDK; the SDK can be
downloaded from the Microsoft website.

A choice of import methods is available because some files
are not compatible with reflection (such as mscorlib.dll) and
can only be opened using the disassembler; however, the
reflection-based importer is generally much faster.

You can also configure:

. Whether to Synchronize or Overwrite existing Classes
when found; 1f a model Class 1s found matching the one in
the file:

- Synchronize updates the model Class to include the
details from the one in the file, which
preserves information not represented in the file,
such as the location of Classes in diagrams
- Overwrite deletes the model Class and generates a
new one from the file, which deletes and
does not replace the additional information

. Whether to create a diagram for each Package
. What is shown on diagrams created by the import
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Classes Not Found During Import

When reverse engineering from your code, there might be
times when Classes are deliberately removed from your
source code.

The 'Tmport Source Directory' functionality keeps track of
the Classes it expects to synchronize with and, on the
'Import Directory Structure' dialog, provides options for how
to handle the Classes that weren't found.

You can select the appropriate option to make Enterprise
Architect, at the end of the import, ignore the missing
Classes, automatically delete them or prompt you to manage
them.

On the 'Import Directory Structure' dialog, if you select the
'Prompt For Action' radio button to manually review
missing Classes, a dialog displays on which you specify the
handling for each Class that was missing in the imported
code.

By default, all Classes are marked for deletion; to keep one
or more Classes, select them and click on the Ignore button.
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Editing Source Code

Enterprise Architect contains a powerful source code editor
that helps you to view, edit and maintain your source code
directly inside the tool. Once source code has been
generated for one or more Classes it can be viewed 1n this
flexible editing environment. Seeing the code in the context
of the UML models from which it is derived brings clarity
to both the code and the models, and bridges the gap
between design and implementation that has historically
introduced errors into software systems.

The Source Code Editor is fully-featured, with a structure
tree for easy navigation of attributes, properties and
methods. Line numbers can be displayed and syntax
highlight options can be configured. Many of the features
that software engineers are familiar with in their favorite
IDE, such as Intelli-sense and code completion are included
in the editor. There are many additional features, such as
macro recording that makes it easy to manage the source
code inside Enterprise Architect. There are also many
options for managing the code, available through the code
editor context menu, toolbar and function keys.
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BEE- -8 B8 h-E8E

¥Parse Error on line 337 1import java.util.*; -
2

4/

5 ™ @auther Paulene Dean

6 ™ @version 1.0

7 ™ @created 22-Jul-2019 18:37:21 AM

8 "/

9 public class Order implements StateMachineContext {
10

11 private Date date;
12 private String deliveryInstructions;
13 private String orderNumber;
14 private Lineltem m_Lineltem;
15
16 public OrderStatus getStatus(){
17 return status;
18 1
19
20 i
21 "
22 * @param newVal
23 "/
24 public void setStatus(OrderStatus newval){
25 status = newVal;
26 1
27
28 public Lineltem getLineItem(){
4
@Startpage |=| specification Manager | =] Orderjava x 4k

For most programming languages a single file is created
from a UML Class, but in the case of C++ both header and
implementation classes are created and the source code
editor displays these files in separate tabs.

A number of options change the way the source code editor
works; they can be altered using the 'Preferences' dialog
available from the Start ribbon:

'Start > Desktop > Preferences > Preferences > Source
Code Engineering > Code Editors'

There are variants of the Source Code Editor, with different
access methods. The variants are discussed in the Compare
Editors topic.

Access
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Ribbon

Keyboard
Shortcuts

Facilities

Facility

Source Code
editor

(c) Sparx Systems 2019

7 August, 2019

Execute > Source > Edit > Open Source
File (external file) or

Execute > Source > Edit > Edit Element
Source (for an existing source file) or

Execute > Source > Edit > Edit New
Source File or

Design > Element > Behavior or
Develop > Source Code > Behavior

F12 or Ctrl+E (for existing code for
model elements)

Ctrl+Alt+O (to locate external files)

Description

By default the Source Code editor is set
to:

. Parse all opened files, and show a tree
of the results

Show line numbers

= CStation 1 #pragma once
¢ Location 2
# MName 3 class CStation
4 CStation{LPCTSTR, int) a{
s SetPosition{CPoint, size_t) 5 public:
s ~CStation() CStation(LPCTSTR
7 ~Cstation(veid);

: public TObject
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Structure
Tree

Notes

If you are editing an XML file, the
structure tree mirrors the exact order and
structure of the document.

= 3 ws:schema
J xmins:xs = http: fwww . w3.0rgf2001/XMLSchema
= [E5 xs:element "ContactInfo™
# type = ContactInfo
= [E5 ws:complexType "ContactInfo®
= [E5 wsisequence
= [E3 ws:element "Contactinfo.homePhone™
/ type = xs:siring

The structure tree is available for
supported language files, such as C++,
C#, Java and XML. The tree can be
helpful to navigate content quickly in
much the same way a table of contents
would for other documents.

. For most selected elements you can use the keys F12 or
Ctrl+E to view the source code.

. When you select an element to view source code, if the
element does not have a generation file (that 1s, code has
not been or cannot be generated, such as for a Use Case),
Enterprise Architect checks whether the element has a
link to either an operation or an attribute of another
element - if such a link exists, and that other element has
source code, the code for that element displays

(c) Sparx Systems 2019

Page 74 of 674



User Guide - Software Models 7 August, 2019

. You can also locate the directory containing a source file
that has been created in or imported to Enterprise
Architect, and edit it or its related files using an external
editor such as Notepad or Visual Studio; click on the
clement in the Browser window and press Ctrl+Alt+Y
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Languages Supported

The Source Code Editors can display code in a wide range
of languages, as listed here. For each language, the editor
highlights - in colored text - the standard code syntax.

. Ada (.ada, .ads, .adb)

. ActionScript (.as)

. BPEL Document (.bpel)

. C++ (.h, .hh, .hpp, .c, .cpp, .cXX)

. C# (.cs)

. DDL Structured Query Language (.sql)

. Delphi/Pascal (.pas)

. Diff/Patch Files (.diff, .patch)

. Document Type Definition (.dtd)

. DOS Batch Files (.bat)

. DOS Command Scripts (.cmd)

. HTML (.html)

. Interface Definition Language (.idl, .odl)
. Java (.java)

. JavaScript (.javascript)

. JScript (.js)

. Modified Backus-Naur Form Grammar (.mbnf)
. PHP (.php, .php4, .inc)

. Python (.py)
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. Standard Generalized Markup Language (.sgml)
. SystemC (.sc)

. Visual Basic 6 (.bas)

. VB.NET (.vb)

. VBScript (.vbs)

. Verilog (.v)

. VHSIC Hardware Description Language (.vhdl)
. Visual Studio Resource Configuration (.rc)

. XML (eXtensible Markup Language) (.xml)

. XSD (XML Schema Definition)

. XSL (XML Stylesheet Language)
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Configure File Associations

If you are a Windows® user, you can configure Enterprise
Architect to be the default document handler for your
language source files.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Code Editors : Configure Enterprise
Architect File Associations [
Actions

For each file type that you would prefer to open in
Enterprise Architect, click on the checkbox to the left of the
file type name. After selecting all of the document types you
require, click on the Save button.

After this, clicking on any corresponding file in Windows®
Explorer will open it in Enterprise Architect.
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Notes

. You can change the default programs, or documents
handled by them, directly through the 'Default Programs'
option in Windows ® Control panel.
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Compare Editors

Enterprise Architect provides four principal code editor
variants, available through a number of access paths. The
most direct access options are 1dentified in these
descriptions.

The first three code editor variants listed have the same
display format, option toolbar, context menu options and
internal function keys. They differ in their method of access
and display mechanism.

Editor Variants

Variant Details

Source Code | F12
View Ctrl+E

Class context menu | 'View Source Code'

Description: Displays the code on a tab of
the Diagram View; the tab label shows
the file name and extension (such as
Java); again, for C++, there are two tabs
for the Header and Implementation files.

You can display the source code for other
Classes on additional tabs, by reselecting
the menu option/keys on the next Class.
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Source Code @ Alt+7

window 'Execute > Source > Edit > Open Source
(Dockable) File'

Description: Displays the contents of the
source file for a selected Class (except if
the language 1s C++, when the window
displays a tab for the Header file and a
tab for the Implementation file).

If you select a different Class, the

window changes to show the code for the
new Class (unless the first Class calls the
second, in which case the window scrolls
down to the second Class's code instead).

Internal Ctrl+Alt+O
Editor, 'Execute > Source > Edit > Open Source
External File' ribbon option

Source Code Description: Use this option if you intend

to edit external code, XML or DDL files
(that 1s, code not imported to or generated
in Enterprise Architect).

Displays an external browser, then opens
the specific selected code file as a tab of
the Diagram View (for C++, not two code
files); otherwise this is identical to the
F12 option.

External Ctrl+-Alt+Y
Editor,
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Internal or Class context menu | Open Source
External Directory

Source Code  Description: Displays an external file
browser, open to the directory containing
the selected Class's source files; you can
open the files in Notepad, Visual Studio
or other tools you might have on your
system.
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Code Editor Toolbar

When you are reviewing the code for a part of your model in
the Source Code editor, you can access a wide range of
display and editing functions from the editor toolbar.

Code Editor Toolbar

ﬂ[ﬁéf@ﬁﬁ*ﬂlﬁ|%@|§|%i&@ﬂ|€lassub £ || Dispose() g

Toolbar Options

Structure Click on this icon to show or hide the
Tree clement hierarchy panel (the left panel of
the Source Code editor).

Line Click on this icon to show or hide the line
Numbers numbers against the lines of code.

Source Code Click on the drop-down arrow to display
Engineering a menu of options to select individual
Properties 'Source Code Engineering' pages of the
'Preferences' dialog, from which you can
configure display and behavior options
for source code engineering:
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. Language

. Syntax Highlighting Options
. Code Editor Options

. Code Engineering Options

. Code Editor Key Bindings

Editor Click on the drop-down arrow to display

Functions

(c) Sparx Systems 2019

a menu providing access to a range of
code editing functions:

. 'Open Corresponding File'

(Ctrl+Shift+O) - opens the header or
implementation file associated with the
currently-open file

. 'Go to Matching Brace' (Ctrl+E) - for a

selected opening or closing brace,
highlights the corresponding closing or
opening brace in the pair

. 'Go to Line (Ctrl+QG) - displays a dialog

on which you select the number of the
line to highlight; click on the OK
button to move the cursor to that line

. 'Cursor History Previous' (Ctrl+-) - the

Source Code viewer keeps a history of
the previous 50 cursor positions,
creating a record when the cursor 1s
moved either more than 10 lines away
from its previous position, or in a
find-and-replace operation; the menu
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option moves the cursor to the position
in the immediately-previous cursor
history record

. 'Cursor History Next' (Ctrl+Shift+-) - if
you have moved to an earlier cursor
position, this option moves the cursor
to the position in the
immediately-following cursor history
record

. 'Find' (Ctrl+F) - displays a dialog in
which you define a text string and
search options to locate that text string
in the code

. 'Replace’ (Ctrl+R) - displays a dialog in
which you define a text string and
search options to locate that text string
in the code and replace it with another
text string; the dialog has options to
locate and replace each occurrence as
you decide, or to replace all
occurrences immediately

. 'Highlight Matching Words' - (Ctrl+3)
Enables or disables the highlighting of
matching words during a find

operation; by default this option is
enabled

. 'Record Macro' - records your next
keystrokes to be saved as a macro

. 'Stop Recording and Save Macro' -
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stops recording the keystrokes and
displays the 'Save Macro' dialog on
which you specify a name for the
macro

. 'Play Macro' - displays the 'Open
Macro' dialog from which you select
and execute a saved macro, to repeat
the saved keystrokes

. 'Toggle Line Comment' (Ctrl+Shift+C)
- comments out (//) or re-establishes the
code for each full line in which text is
highlighted

. '"Toggle Stream Comment'
(Ctrl+Shift+X) - inserts a stream
comment (/* */) at the cursor position
(comments out only the highlighted
characters and lines), or re-establishes
the commented text as code

. 'Toggle Whitespace Characters'
(Ctrl+Shift+W) - shows or hides the
spacing characters: --> (tab space) and .
(character space)

. 'Toggle EOL Characters'
(Ctrl+Shift+L) - shows or hides the

end-of-line characters: CR (carriage
return) and LF (line feed)

. 'Toggle Tree Synchronization' - selects
the tree item automatically as context
changes within code editor
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Save Source
and
Resynchroni
ze Class

Code
Templates

Find in
Project
Browser

Search in
Files
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7 August, 2019

. 'Open Containing Folder' - opens the
file browser at the folder containing the
code file; you can open other files in
your default external editor for
comparison and parallel work

Click on this icon to save the source code
and resynchronize the code and the Class
in the model.

Click on this icon to access the Code
Templates Editor, to edit or create code
templates for code generation.

For a selected line of code, click on this
icon to highlight the corresponding
structure in the Browser window. If there
1s more than one possibility the 'Possible
Matches' dialog displays, listing the
occurrences of the structure from which
you can select the required one.

Click on this icon to search for the
selected object name in associated files,
and display the results of the search in the
File Search window. You can refine and
refresh the search by specifying criteria
on the Find in Files window toolbar.
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Search in
Model

Go to
Declaration

Go to
Definition

Autocomplet
e List

Parameter
Information

Find
Current
Class in
Browser
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Click on this icon to search for the
selected text throughout the model, and
display the results of the search in the
Find in Project view.

Click on this icon to locate the
declaration of a symbol in the source
code.

Click on this icon to locate the definition
of a symbol in the source code
(applicable to languages such as C++ and
Delphi, where symbols are declared and
defined in separate files).

Click on this icon to display the
autocompletion list of possible values;
double-click on a value to select it.

When the cursor is between the
parentheses of an operation's parameter
list, click on this icon to display the
operation's signature, highlighting the
current parameter.

Click on this icon to display the name of
the currently-selected Class in the code,
and highlight that name in the Browser
window; 1f there 1s more than one
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Window possibility the 'Possible Matches' dialog
displays, listing the occurrences of the
Class from which you can select the
required one.

Find Click on this icon to display the name of

Member the currently-selected attribute or method
in the code, and highlight that name in
the Browser window; if there 1s more
than one possibility the 'Possible
Matches' dialog displays, listing the
occurrences of the feature from which
you can select the required one.

Notes

. The 'Record Macro' option disables Intelli-sense while the
macro is being recorded

. You can assign key strokes to execute the macro, instead
of using the toolbar drop-down and 'Open Macro' dialog

(c) Sparx Systems 2019 Page 89 of 674



User Guide - Software Models 7 August, 2019

Code Editor Context Menu

When working on a file with a code editor, you can perform
a number of code search and editing operations to review
the contents of the file. These options are available through
the editor context menu, and can vary depending on which
code editor you are using.

Access
Context Right-click on the code text string you
Menu are working on

Options

Go to Locate and highlight the declaration of a
Declaration symbol in the source code.

Go to Locate and highlight the definition of a
Definition symbol in the source code (applicable to
languages such as C++ and Delphi, where
symbols are declared and defined in
separate places).
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Open in
Grammar
Editor

Synchronize
Tree to
Editor

Auto
Synchronize

Tree and
Editor

XML
Schema
Validation

Search for
'<string>'
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Opens a view that lets you examine or
validate the code using the appropriate
grammar.

Finds and displays the current element
(method for example) in the structure
tree.

When selected, the structure tree will
automatically show the element being
worked on in the editor.

Allows an XML schema to validated.

Display a submenu providing options to
locate the selected text string in a range
of locations.

. 'Find 1n Project Browser' - Highlight
the object containing the selected text
in the Browser window

. 'Search in Open Files' - Search for the
selected text string in associated open
files and display the results of the
search in the Find in Files window; you
can refine and refresh the search by
specifying criteria on the Find in Files
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(c) Sparx Systems 2019

window toolbar

. 'Search in Files' - Search for the

selected text string in all associated
files (closed or open), and display the
results of the search in the Find in Files
window; you can refine and refresh the
search by specifying criteria on the

Find in Files window toolbar (shortcut
key: F12)

. 'Search in Model' - Perform an

'Element Name' search in the Model
Search facility, and display the results
on the Model Search tab

. 'Search in Scripts' - (Available while

working in the Script Editor) Open the
Find in Files window, set the 'Search
Path' field to 'Search in Scripts' and the
'Search Text' field to the selected text,
then search all scripts for the text string
and display the results of the search;
you can refine and refresh the search
by specifying criteria on the Find in
Files window toolbar

. 'EA User Guide' - Display the

description of the code item in the
Enterprise Architect User Guide

. 'Google' - Display the results of a

Google search on the text

. 'MSDN' - Display the results of a
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Search
Intelli-sense
| <list of

query
names>

Set
Debugger to
Line

Display
Variable
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search on the text in the Microsoft
Developer Network (MSDN)

. 'Sun Java SE' - Display the results of a
search on the text in the Sun
Microsystems 'Sun Search' facility

. 'Wikipedia' - Display any entry on the
object on the Wikipedia web site

. 'Koders' - Display the results of a
search for the text string on
Koders.com

Perform an Intelli-sense search on the
specified string using one of the listed
queries, displayling the results in the Find
in Files window, 'Intelli-sense Search'
tab.

Shortcut key: Shift+F12

(If the debugger 1s executing and has
reached a breakpoint.) Move the
execution point to the current line. Check
that you do not skip over any code or
declarations that affect the next section of
code being debugged.

(If the debugger 1s executing.) Open the
Locals window and highlight the local
variable for the current point in the code.
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Show in
String
Viewer

Create Use
Case for
'<string>'

Breakpoint

Testpoints

(c) Sparx Systems 2019

Display the full contents of a variable
string in the String Viewer.

Display the 'Create Use Case For Method'
dialog, through which you create a Use
Case for the method containing the text
string.

Display a submenu of options for creating
a recording marker on the selected line of
code. The recording markers you can add
include:

. Breakpoint

. Start Recording Marker

. End Recording Marker

. Stack Auto Capture Marker

. Method Auto Record Marker
. Tracepoint

Display options to add a new Testpoint,
show the Testpoints Manager (Testpoints
window) or edit an existing Testpoint 1f
one or more are already defined at the
selected location.

(The sub-options depend on the type of
code file you are reviewing.)
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Allows an XML document to be checked
for compliance with its own schema
references or using a user-specified

schema; either a local schema file or a
URL.

Open (or close) the Input Method Editor,
so that you can enter text in a selected
foreign language script, such as Japanese.
You set the keyboard language using the
Windows Control Panel - Regional and
Language Options facility.

(Script Editor only.) Show or hide the
code line numbers on the left hand side of
the editor screen.

These six options provide simple
functions for editing the code.

. The options 1n the lower half of the 'Search for <string>'

(c) Sparx Systems 2019
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submenu (after 'Search in Scripts') are configurable; you
can add new search tools or remove existing ones by
editing the searchProviders.xml file in the Sparx Systems
> EA > Config folder - this file 1s in OpenSearch
description document format
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Create Use Case for Method

Using the code editor context menu, you can create a Use
Case element for a method that you select from the code.
You can also:

. Link the Use Case directly to the method

. Add the parent Class to a diagram (if it is not already in
the selected diagram) and/or add the Use Case element to
the diagram

. Block from display any attributes or methods that are not
also the targets of feature links

Create a Use Case for a method, through the
code editor

Ste Action
p

1 | (If you want to depict the Use Case and its link to the
method in a diagram) click on the diagram name 1n
the Browser window.

2 In the code editor, right-click on either the method
name or any part of the method body, and select the
'Create Method for <methodname>' option.

The 'Create Use Case for Method' dialog displays.
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3 | The basic function of this dialog is to create a Use
Case for the selected method:

. If this 1s all that 1s required, click on the OK
button; the Use Case element 1s created in the
Browser window, in the same Package as the
parent Class for the method, and with the same
name as the method

. If you intend to make the relationship tangible,
continue with the procedure

4 | To create a Trace connector linking the Use Case to
the method, select the 'Link Use Case to Method'
checkbox.

5 | To add the method's parent Class to the diagram, if it
1s not already there, select the 'Add Class to
Diagram' checkbox.

6 | To add the newly-created Use Case to the diagram,
select the 'Add Use Case to Diagram' checkbox; this
would now show the Use Case, Class and Trace
connector on the diagram.

7 | To only show the features (attributes and methods)
of the parent Class that are the targets of 'link to
feature' relationships, select the 'Display only linked
features in Class' checkbox.

The Class might contain any number of attributes
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and methods, but those without a 'link to feature'
relationship are hidden.

8 | Click on the OK button to create and depict the Use
Case and relationship; if you selected all options, the
diagram now contains linked elements resembling
this illustration:

ClassLib

memoryCancel — — — — — — — — > memoryCancel{bool*)
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Code Editor Functions

The common Code Editor provides a variety of functions to
assist with the code editing process, including:

. Syntax Highlighting
. Bookmarks

. Cursor History

. Brace Matching

. Automatic Indentation
. Commenting Selections
. Scope Guides

. Zooming

. Line Selection

. Intelli-sense

. Find and Replace

. Find in Files

A range of these functions is available through keyboard
key combinations and/or context menu options.

You can customize several of the Code Editor features by
setting properties in the Code Editor configuration files; for
example, by default the line containing the cursor 1s always
highlighted, but you can turn the highlighting off.
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Function Details

Code Editor Functions

Function

Syntax
Highlighting

Bookmarks

(c) Sparx Systems 2019

Description

The Code Editor highlights - in colored
text - the standard code syntax of all
language file formats supported by
Enterprise Architect

1 #pragma once
2 #include "aftwxwin.h"
3 #include "afxcmn.h"

A

2

6 // CToolBox dialog

7

8 class CTeolBox : public CDialog

91

18 DECLARE_DYNAMIC(CToolBox)
CRect m_rect;

12 int m_offset;

You can define how the Code Editor
implements syntax highlighting for each
language, through the 'Code Editors' page
of the 'Preferences' dialog.

Bookmarks denote a line of interest in the
document; you can toggle them on and

off for a particular line by pressing
Ctrl+F2.

Additionally, you can press F2 and
Shift+F2 to navigate to the next or
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previous bookmark in the document.
To clear all bookmarks 1n the code file,

press Ctrl+Shift+F2.
Cursor The Code Editor Control keeps a history
History of the previous 50 cursor positions; an

entry in the history list 1s created when:

. The cursor 1s moved more than 10 lines
from its previous position

. The cursor is moved 1n a find/replace
operation

You can navigate to an earlier point in the
cursor history by pressing Ctrl+-, and to a
later point by pressing Ctrl+Shift+-.

Brace When you place the cursor over a brace

Matching or bracket, the Code Editor highlights its
corresponding partner; you can then
navigate to the matching brace by
pressing Ctrl+E.

B function ProtectedFunctionTest: boolean;
procedore ProtectedPrDcedareTestl:a: WideString) :

Automatic For each supported language, the Code

Indentation Editor adjusts the indentation of a new
line according to the presence of control
statements or scope block tokens in the
lines leading up to the cursor position.
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358 {

359 for{size t t = B; t ¢ Stations.size(); t+H)
360 {

361 if(Stations[t]-»Location == loc)

362 return Stations[t];

363 }

354 return NULL;

365 }

The levels of indent are indicated by pale
horizontal lines.

You can also manually indent selected
lines and blocks of code by pressing the
Tab key; to un-indent the selected code,
press Shift+Tab.

Commenting = For languages that support comments, the
Selections Code Editor can comment entire
selections of code.

The Code Editor recognizes two types of
commenting:

. Line Commenting - entire lines are
commented from the start (for
example:

// This 1s a comment)

. Stream Commenting - sections of a line
are commented from a specified start
point to a specified end point (for
example:

/* This 1s a comment */)

You can toggle comments on the current
line or selection by pressing:
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. Ctrl+Shift+C for line comments, or
. Ctrl+Shift+X for stream comments

Scope Guides | If the cursor 1s placed over an indentation
marker, the Code Editor performs a 'look
back' to find the line that started the scope
at that indentation level; if the line is
found and is currently on screen, it is
hlghhghted n hght blue.

DNSPacket responsePacket = Helpers.createResponsePacket | answers, this.theS
* responsePacket.querylD = receivedPacket.gueryID;

return responsePacket;

Alternatively if the line 1s off screen, a
calltip is displayed advising of the line
number and contents

f// If there were an a:swe:s, then return a packet, if not then just return null
f/ to indicate the server has no response

35 if { answers. 51ze(] >0

96 .[_me 73: private DNSPacket processQuery(DNSPacket receivedPacket) |

97 DNSPacket responsePacket = Helpers.createResponsePacket ( answers, this.theSt
responsePacket.queryID = receivedPacket.gueryID;

return responsePacket;

Zooming You can zoom into and out of the
contents of the Code Editor using:

. Ctrl+keypad + and
. Ctrl+keypad -

Zoom can be restored to 100% using
Ctrl+keypad /.

Line If you want to move the cursor to a
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Selection specific line of code, press Ctrl+G and, in
response to the prompt, type in the line
number.

Press the OK button; the editor displays
the specified line of code with the cursor
at the left.
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Intelli-sense

Intelli-sense 1s a feature that provides choices of code items
and values as you type. Not all code editors use
Intelli-sense; for example, Intelli-sense 1s disabled while you
record a macro in the Source Code Viewer.

Intelli-sense provides you with context-based assistance
through autocompletion lists, calltips and mouseover
information.

Facilities
Facility Description

Autocompleti = An autocompletion list provides a list of

on List possible completions for the current text;
the list 1s automatically invoked when
you enter an accessor token (such as a
period or pointer accessor) after an object
or type that contains members.
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public vold memoryRecall ()
i

[T s

this.

i B ol |
61 T
N . # Dispose
a2 puklid .
- 2 finalize
;f » m_delivery
;_’ ¢ memaory
T ] ¢ memoryCancel ] N
1 publid - pberl, int numberz )
- . ¢ memoryMinus
o . ¢ memoryPlus N
a5 iy £l + numberd;
- ¢ memoryRecall
a3 )

You can also invoke the autocompletion
list manually by pressing Ctrl+Space; the
Code Editor then searches for matches for
the word leading up to the invocation
point.

Select an item from the list and press the
Enter key or Tab key to insert the item
into the code; to dismiss the
autocompletion list, press Esc.

Calltips Calltips display the current method's
signature when you type the parameter
list token (for example, opening
parenthesis); 1f the method 1s overloaded,
the calltip displays arrows that you can
use to navigate through the different
method signatures
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S /PostDraw LRdornments
S /5tereoctyped Static Adornments

S /hdd Stakeholder's STAEE
setpenwidth(;
// Rdd a th{SetPenWidth(int penwidth) |
startpath():
moveto(25,37): =
linmeto(25,52);
endpath ()
strokepath () ;

S/odd tip

You can display supporting
documentation for code elements (for

example, attributes and methods) by
hovering the cursor over the element in
question.
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dockable = "none";

string
{ Dock elements together.
Walid Values: none, standard

//Prelraw Derived Attribute I

Tagged W
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Find and Replace

Each of Enterprise Architect's code editors facilitates
searching for and replacing terms in the editor, through the
'Find and Replace' dialog.

Access

Keyboard
Shortcuts

Highlight the required text string and
press:

. Ctrl+F for the find controls only, or

. Ctrl+R for both find and replace
controls

In each instance, the 'Find what' field is
populated with the text currently selected
in the editor. If no text 1s selected in the
editor, the 'Find what' field is populated
with the word at the current cursor
position. If no word exists at the current
cursor position, the last searched-for term
1s used.

Basic Operations - Commands

(c) Sparx Systems 2019
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Command Action

Find Next Locate and highlight the next instance
(relative to the current cursor position) of
the text specified in the 'Find what' field.

Replace Replace the current instance of the text
specified in the 'Find what' field with the
text specified in the 'Replace with' field,
and then locate and highlight the next
instance (relative to the current cursor
position) of the text specified in the 'Find
what' field.

Replace All  Automatically replace all instances of the
text specified in the 'Find what' field with

the text specified in the 'Replace with'
field.

Basic Operations - Options

Option Action

Match Case Specify that the case of each character in
the text string in the 'Find what' field 1s
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significant when searching for matches in
the code.

Match whole = Specify that the text string in the 'Find

word what' field 1s a complete word and should
not be matched with instances of the text
that form part of a longer string.

For example, searches for ARE should

not match those letters in instances of the
words AREA or ARENA.

Search up Perform the search from the current
cursor position up to the start of the file,
rather than in the default direction of
current cursor position to end of file.

Use Regular | Evaluate specific character sequences in
Expressions | the 'Find what' and 'Replace with' fields
as Regular Expressions.

Concepts
Concept Description
Regular A Regular Expression 1s a formal

Expressions | definition of a Search Pattern, which can
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Metasequenc
es

(c) Sparx Systems 2019

be used to match specific characters,
words or patterns of characters.

For the sake of simplicity, the Code
Editor's 'find and replace' mechanism
supports only a subset of the standard
Regular Expression grammar.

Text in the 'Find what' and 'Replace with'
fields 1s only interpreted as a Regular
Expression if the 'Use Regular
Expressions' checkbox is selected in the
'Find and Replace' dialog.

If the 'Use Regular Expressions'
checkbox is selected, most characters in
the 'Find what' field are treated as literals
(that 1s, they match only themselves).

The exceptions are called metasequences;
each metasequence recognized in the
Code Editor 'Find and Replace' dialog is
described in this table:

. \< - Indicates that the text is the start of
a word; for example: \<cat 1s matched
to catastrophe and cataclysm, but not
concatenate

. \> - Indicates that the text is the end of
a word; for example: hat\> is matched
to that and chat, but not hate

. (...) - Indicates alternative single
characters that can be matched - the
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characters can be specific (chr) or in an
alphabetical or numerical range (a-m);
for example: (hc) at 1s matched to hat
and cat but not bat, and (a-m) Class 1s
matched to any name in the range
aClass-mClass

. (”...) - Indicates alternative single
characters that should be excluded
from a match - the characters can be
specific (“chr) or in an alphabetical or
numerical range (“a-m); for example:
(“hc) at 1s matched to rat and bat, but
hat and cat are excluded, and (“a-m)
Class 1s matched to any name in the
range nClass to zClass, but aClass to
mClass are excluded

. N - Matches the start of a line
. $ - Matches the end of a line

* - Matches the preceding character (or
character set) O or more times; for
example: ba*t 1s matched to bt, bat,
baat, baaat and so on, and b(ea) *t is
matched to bt, bet, bat, beat, beet, baat
and so on

. + - Matches the preceding character (or
character set) 1 or more times; for
example: ba+t is matched to bat, baat
and baaat but not bt, and b(ea) +t 1s
matched to bet, bat, beat, beet and baat
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but not bt

If a single character metasequence 1s
preceded by a backslash (\) it 1s treated as
a literal character: c\(at\) matches c(at) as
the brackets are treated literally.

When the 'Use Regular Expressions'
checkbox 1s selected, a metasequence
helper menu is available to the right of
both of the 'Find what' and 'Replace with'
fields; selecting a metasequence from this
menu 1nserts the metasequence into the
field, replacing or wrapping the currently
selected text as appropriate.

Tagged When 'find and replacing' with Regular
Regions Expressions, up to nine sections of the
original term can be substituted into the
replacement term.
The metasequences "\(' and "\)' denote the
start and the end of a tagged region; the
section of the matched text that falls
within the tagged region can be included
in the replacement text with the
metasequence "\n' (where 7 1s the tagged
region number between 1 and 9).
For example:
Find: \((A-Za-z) +\)'s things
Replace with items that belong to \1
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Original text: These are all Michael's
things.

Replaced text: These are all items that
belong to Michael.
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Search in Files

File Text Searches are provided by the Find in Files window
and from within the Code Editors, to search files for data
names and structures. These files can be external code files,
code files that you have already opened in Enterprise
Architect, internal model scripts or the Help subsystem.

The 'File Search' tab maintains a history of the file paths you
have explored, helping you to quickly return to
frequently-used folders in your file system. You can
similarly select a previously-used search string, if you need
to repeat a search several times. When you are searching
code files, you can also confine the search to files of specific
types, by selecting the file extensions, and to include just the
selected folder or all of its sub-folders as well. Another
useful facility 1s being able to select to show the results of
the search as either a list of every instance of the string, or a
list of files containing the string with the instances grouped
under the file in which they are found.

For all searches, you can qualify the search to be
case-sensitive and/or to match the search string to complete
words.

Access

Ribbon Explore > Search > Files
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Execute > Source > Find
Execute > Source > Edit > Search 1n Files

Context Right-click on selected text | Search for
Menu <selected text> | Search in Files

Keyboard F12, Ctrl+Shift+Alt+F
Shortcuts

Search Toolbar

You can use the toolbar options in the Find in Files window
to control the search operation. The state of each button
persists over time to always reflect your previous search
criteria.

~ || Search in scripts - || *.cpp,*.h,*.tbd - Qa. Aa a= OO0 E & = @]

Options

Option Action

The 'Search Text' field. Type the text
string to search for.

Any text you type in is automatically
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VAR

saved in the drop-down list, up to a

mare

i maximum of ten strings; text added after
%QLT: that overwrites the oldest text string in
QU the list. You can click on the drop-down
Ui arrow and select one of these saved text

strings, if you prefer.

The 'Search Path' field. Specify the folder
to search, or the type of search.

o,
CHNEAVWEA\Microsoft Mative\CityLoop

You can type the folder path to search
directly into the text box, or click on the
drop-down arrow and select 'Browse for
folder' to search using the 'Browse for
Folder' dialog.

Any paths you enter are automatically
saved in the drop-down list, up to a
maximum of ten; paths added after that
overwrite the oldest path in the list. You
can select one of these saved paths if you
prefer.

Apart from 'Browse for folder', there are
three other fixed options in the
drop-down list:

. 'Search 1in scripts', which searches the
local and user-defined scripts in the
'Scripts' tab of the Scripting window

. 'Search in open files', which confines
the search to the files that you have
open in Enterprise Architect
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s bt
*pp, b, * bt
&

* java,*. o

Aa

(c) Sparx Systems 2019

. 'Search 1n local help', which searches
the local Help files that have been
installed from the Sparx Systems web
site; the results list the Help topics
containing the search term, and the line
number and line in which the text
occurs

These options disable the 'Search File
Types' list box.

The 'Search File Types' field. Click on the
drop-down arrow and select the file types
(file extensions) to search.

Click on this icon to begin the search.

During the course of the search all other
buttons in the toolbar are disabled. You
can cancel the search at any time by
clicking on the Search button again.

If you switch any of these toggle buttons,
you must run the search again to change
the output.

Click on this icon to toggle the case
sensitivity of the search. The tool-tip
message 1dentifies the current setting.

Click on this icon to toggle between
searching for any match and searching for
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only those matches that form an entire
word. The tool-tip message identifies the
current setting.

E Click on this icon to toggle between
limiting the search to a single path and
including all subfolders under that path.
The tool-tip message identifies the
current setting.

- Click on this icon to select the
presentation format of the search results;
you have two options:

. List View - (as shown) each result line
consists of the file path and line
number, followed by the line text;
multiple lines from one file are listed as
separate entries

. Tree View - (&) each result line
consists of the file path that matches
the search criteria, and the number of
lines matching the search text within
that file; you can expand the entry to
show the line number and text of each
line

* Click on this icon to add a new search
tab. You can create up to four new search
tabs. Searches can also run concurrently.
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Click on this icon to clear the results.

il

If necessary, click on this icon to remove
all the entries in the Search Path, Search
Text and Search File Types drop-down
lists.

Click on this icon to display this Help
topic.

(c) Sparx Systems 2019 Page 121 of 674



User Guide - Software Models 7 August, 2019

Find File

The Find in Files window 'Find File' tab provides a tool that
can help you find files quicker. The tab acts as a file system
explorer and offers a speedy alternative to the common open
file dialog. File searches are quick and simple, allowing you
to look up files of interest without losing your current
workflow. The display can be switched between report and
list view.

Access
Ribbon Explore > Search > Files > Find File
Keyboard Ctrl+Shift+F
Shortcuts

Toolbar

The toolbar provides a search filter and folder navigation
combo box. The toolbar provides options to remember

search locations and alternate between list and report views.
1 |import e’ \NIEM\niem4 MEE RN
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Options

(c) Sparx Systems 2019

Click to navigate to the parent folder.

The filter control allows you to exclude
files that do not match the criteria you
type. The wildcard symbol * is
automatically appended to the text so it is
not necessary to add it yourself. To
search for all files that contain the term
jvm simply type jvm. To find png images
containing the term red you could type
*red*.png. Press the Enter key to update
the results.

Enter the path of a directory and press the
Enter key to display the files in that
location

Use the drop down list to select from
book marked locations. Locations can be
managed by using the toolbar menu.

Allows you to manage the locations
displayed in the directory combo.
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In this view the list displays the columns
'filename', 'modified date', 'file type' and
'file size'.

Columns can be sorted in either
ascending or descending order. Click the
column a third time to remove the sort
order.

The list view removes columns and is
convenient when a folder contains many

files.

Keyboard Shortcuts

(c) Sparx Systems 2019

Sets focus to the filter control
Navigates to the parent folder
Navigates to the parent folder

If a folder 1s selected, opens the folder,
otherwise opens the selected files.
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Search Intelli-sense

The Intelli-sense capabilities of Enterprise Architect are
built using Sparx Systems' Code Miner tool. The Code
Miner provides fast and comprehensive access to the
information in an existing code base. The system provides
complete access to all aspects of the original source code,
either on the fly as one might in a code editor, or as search
results produced by queries written in the Codeminer mFQL
language.

This feature 1s available from Enterprise Architect Release
14.1.

Access

On the Find in Files window, click on the 'Code Miner' tab.
Ribbon Explore > Search > Files

Keyboard Ctrl+Shift+Alt+F
Shortcuts

The Code Miner Control

This control presents an interface for performing queries on
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several code bases at once. The code bases it uses are
databases built using Enterprise Architect's Code Miner tool.
These databases form a library. The Library can also be
shared when deployed as a service. The queries that can be
run are listed and selected using the toolbar. The control
allows easy access to the source code for the queries, for
editing and composition. Queries do not need to be
compiled. They are viewed, edited and saved as one would
any source code file. Queries that take a single parameter
can utilize any selection in an open code editor. The
interface also supports manual parameter entry for queries
that take multiple arguments.

The first control on the toolbar lists the namespaces
available. Selecting a namespace limits the queries that are
displayed to those within that namespace.

cpp

The next control 1s a combo box that lists all the queries in
the query file for the selected namespace.

java.findClass -

The next control is an edit combo box. By default a single
query parameter is taken from the selected text in an any
open code editor, but you can also type the parameter(s)
directly into this field. Multiple parameters should be
separated by commas. This 1s followed by the Search button
to run the query. Queries can be edited at any time using the
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Edit button next to it.

Use Code Editor Selection -8 J @

The results window 1s a tree control that lists the results of
the query grouped by file

Result
eyjava'jdk-1.8.0_ 91 srchcomisuntorghapacheixerces\internal\utifhdomutil java

efjavahjdk-1.8.0_9T\srchjavalutilstrearn pipelinehelper.java

it T — T —

efvjavahjdk-1.8.0_ 91\src\javalutifvector.java

eryjavajdk-1.8.0_91srchjavaxswinghdefaultlistrmodel java

Code Miner Libraries

Code Miner libraries are a collection of databases that can
be used by Enterprise Architect Intelli-sense providers to
obtain and query for information across several code bases.
Each database is created from the root source code directory
of a code base, using a specialized grammar appropriate for
its language (C++, Java or C#).

The libraries are created, updated, removed or added 1n the
'Analyzer Script Editor'. A typical scenario for using this
feature would be to create a database for a development
project and additional databases for frameworks referenced
by the project. Your development database can be updated
frequently as code changes accrue, while the static
frameworks would be updated less often. Libraries can be
searched 1n a similar way to the 'File Search' tool, but offers
advanced search capabilities due to its mFQL language.
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. Multiple domains / frameworks can be searched at once

. A query can be run in a fraction of the time required for a
File Search

. Queries can be coded to assist with complex search
criteria

. Queries can take multiple parameters

. All files are indexed based on equivalent UML constructs,
allowing intelligent searches producing meaningful results
in a modeling setting

Code Miner Query Files

Code Miner queries are maintained in a single source code
file which should have the . mFQL extension. A basic set of
queries is provided with each Enterprise Architect
installation; these can be located in the config\codeminer
sub directory. This query file should be named by default in
any Analyzer Script you edit.

Before editing any queries it is advisable that you copy this
file to a working location and name the copy in any
Analyzer Script you use. This way you will always have a
reference file to go back to.

Queries are best considered as functions that are written in
the mFQL language. As such they have unique names, can
be qualified by a single namespace and can specify
parameters. The file provides the queries listed in the
Intelli-sense control's toolbar. Whenever edits to a query file
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are saved, the queries listed in the search toolbar combo box
will be updated accordingly. This image 1s an example of a
simple query written in mFQL.

188

189 namespace java

190 {

191 //

192 // Find all references

193 //

194 query: : findByName($paraml)

195 {

196 distinct(GetByvalue( Fparaml +))
197 }

198

199 query: : findMethodByName ($name)

200 {

201 move( 1, "METHOD", intersect( GetByMode("MNAME"), GetByvalue( $name ) ) )
202}

203

204 query: : findMethodcall($name)

205 {

206 filter( "METHOD_ACCESS", intersect(GetByMNode("NAME"), GetByvalue( $name }) )
207}

208
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Code Editor Key Bindings

Keys

Key
Ctrl+G
l
Shift+]
Ctrl+]

Alt+Shift+]

T

Shift+1
Ctrl+1
Alt+Shift+1

Ctrl+(
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Description

Move cursor to a specified line
Move cursor down one line
Extend selection down one line
Scroll down one line

Extend rectangular selection down one
line

Move cursor up one line

Extend selection up one line

Scroll up one line

Extend rectangular selection up one line

Move cursor up one paragraph
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Ctrl+Shift+(
Ctrl+)

Ctrl+Shift+)

Shift+«—
Ctrl+«

Ctrl+Shift+

D

Alt+Shift+«—

Shift+—
Ctrl+—

Ctrl+Shift+

—

Alt+Shift+—
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Extend selection up one paragraph
Move cursor down one paragraph
Extend selection down one paragraph
Move cursor left one character
Extend selection left one character
Move cursor left one word

Extend selection left one word

Extend rectangular selection left one
character

Move cursor right one character.
Extend selection right one character
Move cursor right one word

Extend selection right one word

Extend rectangular selection right one
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character
Ctrl+/ Move cursor left one word part
Ctrl+Shift+/ = Extend selection left one word part
Ctrl+\ Move cursor right one word part
Ctrl+Shift+\ | Extend selection right one word part

Home Move cursor to the start of the current
line

Shift+Home Extend selection to the start of the current
line

Ctrl+Home Move cursor to the start of the document

Ctrl+Shift+H | Extend selection to the start of the

ome document
Alt+Home Move cursor to the absolute start of the
line

Alt+Shift+Ho Extend rectangular selection to the start
me of the line

End Move cursor to the end of the current line
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Shift+End

Ctrl+End

Ctrl+Shift+E
nd

Alt+End

Alt+Shift+En
d

Page Up

Shift+Page
Up

Alt+Shift+Pa
ge Up

Page Down

Shift+Page
Down

Alt+Shift+Pa
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Extend selection to the end of the current
line

Move cursor to the end of the document

Extend selection to the end of the
document

Move cursor to the absolute end of the
line

Extend rectangular selection to the end of
the line

Move cursor up a page

Extend selection up a page

Extend rectangular selection up a page

Move cursor down a page

Extend selection down a page

Extend rectangular selection down a page
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ge Down

Delete Delete character to the right of the cursor
Shift+Delete = Cut selection

Ctrl+Delete Delete word to the right of the cursor

Ctrl+Shift+D | Delete until the end of the line
elete

Insert Toggle overtype

Shift+Insert = Paste

Ctrl+Insert Copy selection

Backspace Delete character to the left of the cursor

Shift+Backsp = Delete character to the left of the cursor
ace

Ctrl+Backspa = Delete word to the left of the cursor
ce

Ctrl+Shift+B | Delete from the start of the line to the
ackspace cursor
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Alt+Backspa
ce

Tab
Ctrl+Shift+]
Shift+Tab

Ctrl+keypad(
+)

Ctrl+keypad(
)

Ctrl+keypad(
/)

Ctrl+Z
Ctrl+Y
Ctrl+X
Ctrl+C

Ctrl+V
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Undo delete

Indent cursor one tab
Indent cursor one tab
Unindent cursor one tab

Z.00m in

Z.00m out

Restore Zoom

Undo

Redo

Cut selection
Copy selection

Paste

7 August, 2019
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Ctrl+L

Ctrl+T

Ctrl+Shift+T

Ctrl+A

Ctrl+D

Ctrl+U

Ctrl+Shift+U

Ctrl+E

Ctrl+Shift+E

Ctrl+Shift+C

Ctrl+Shift+X

Ctrl+F2

F2

Shift+F2

(c) Sparx Systems 2019

7 August, 2019

Cut line

Transpose line

Copy line

Select entire document

Duplicate selection

Convert selection to lowercase
Convert selection to uppercase
Move cursor to matching brace
Extend selection to matching brace
Toggle line comment on selection
Toggle stream comment on selection.
Toggle bookmark

Go to next bookmark

Go to previous bookmark
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Ctrl+Shift+F | Clear all bookmarks in current file
2

Ctrl+-Shift+W | Toggle whitespace characters
Ctrl+-Shift+L. = Toggle EOL characters
Ctrl+Space Invoke autocomplete.

Ctrl+- Go backwards 1n cursor history

Ctrl+Shift+- | Go forwards in cursor history

F12 Start/Cancel search for keyword 1n file(s).
Ctrl+F Find text
Ctrl+R Replace text

Notes

. In addition to these keys, you can assign (Ctrl+Alt+<n>)
key combinations to macros that you define within the
Source Code Editor
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Application Patterns (Model + Code)

To get you going with a code based project as fast as
possible, Enterprise Architect helps you to generate starter
projects including model information, code and build scripts
for one of several basic application types. Patterns include:

. MFC Windows applications
. Java programs
. ASP.NET web services

Access
Ribbon Design > Model > Add > Model Wizard
> Application Patterns
Context In Browser window | Right-click on a
Menu Package | Add a Model using Wizard >

Application Patterns

Keyboard Ctrl+Shift+M > Application Patterns
Shortcuts

Generate Models
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Model Wizard v 2 X

Model Patterns Diagram Process Guidance| Application Patterns| VEA Examples

Select a template from the list of applications, to add to your project. Create Pattern...
-
Technology Name _~
i=;,i Java

= : 4 Repository
8 Microsort

E Microsoft C++

Repositorylnterface 3.5

Repositorylnterface 4.0

4 Web
‘Web Application 2008 b

Sparx Systems, Repositonylnterface 4.0, C#, Microsoft NET Framework 4.0
C# project demonstrating the powerfull high level language support provided by Enterprise Architect to the model.

Destination_folder: Use Local Path

Compiler command: "CAWindows\Microsoft. NET\Framework'\w4.0.30313\csc.exe” [debug /target.exe /platform:x86 /r:5parxs Edit Local Paths

Option Action
Technology Select the appropriate technology.

Name Displays the Application Patterns
available for the selected technology;
select the required Pattern to import.

<description> Displays a description of the selected
Pattern.

Destination Browse for and select the directory in
folder which to load the source code for the
application.

Use Local Enable the selection of an existing local
Path path to place the source code under;
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Compiler
command

Edit Local
Paths

Notes

changes the 'Destination folder' field to a
drop-down selection.

Displays the default compiler command
path for the selected technology; you
must either:

. Confirm that the compiler can be found
at this path, or

. Edit the path to the compiler location

Many application Patterns specify their
compiler using a local path.

The first time you use any Pattern you
must click on this button to ensure the
local path points to the correct location.

The 'Local Paths' dialog displays.

. Ifrequired, you can publish custom application Patterns
by adding files to the AppPatterns directory where
Enterprise Architect is installed; top level directories are
listed as Technologies and can contain an icon file to
customize the icon displayed for the technology
Directories below this are defined as groups in the
Patterns list; the Patterns are identified by the presence of
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four files with a matching name: a zip file (.zip), XMI file
(.xml), config file (.cfg) and optional icon (.ico)

. The config file supports these fields:

- [provider], [language], [platform], [url],
[description], [version] - all displayed in the
<description>

field

- [xmirootpaths] - the root path of the source code in

the exported XMI; this is replaced with the
selected destination folder when the user applies the
Application Pattern
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MDG Integration and Code
Engineering

MDG Integration for Eclipse and MDG Integration for
Visual Studio are products that help you to create and
maintain your UML models directly inside these two
popular Integrated Development Environments, using the
Enterprise Architect Browser window. Models can be
generated to source code using the powerful and flexible
template engine that gives the engineer complete control
over how the code is generated. Existing source code can
also be reverse engineered and synchronized with the UML
models. With the integration installed the IDE will become a
feature rich modeling platform, saving time and effort and
reducing the risk of error by linking requirements
management, architecture and design to source code
engineering.

Rich and expressive documentation can be generated
automatically into a wide range of formats including Docx,
PDF and HTML. The documentation can include diagrams
of requirements, design and architecture as well as source
code descriptions, putting the source code into context.

You can purchase MDG Integration for Eclipse and MDG
Integration for Visual Studio or download trial versions,
from the Sparx Systems web site.
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Behavioral Models
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Enterprise Architect’s powerful system engineering
capability can be used to generate code for software, system
and hardware description languages directly from behavioral
models, such as StateMachine, Sequence (Interaction) and
Activity diagrams. The supported languages include C(OO),
C++, C#, Java, VB.Net, VHDL, Verilog and SystemC.

Software code can be generated from StateMachine,
Sequence and Activity diagrams, and hardware description
languages from StateMachine diagrams (using the Legacy
State Machine templates).

Generate code from behavioral diagrams
using the EAExample project

Ste Action
p

1 | Open the EAExample.eap file by selecting the 'Start
> Help > Help > Open the Example Model' ribbon
option.
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2 | From the Browser window, select any of these
Packages:

Software Language Examples:

. Example Model > Software Engineering > Java
Model With Behaviors

Generate the Account and Order classes

. Example Model > Systems Engineering >
Implementation Model > Software > C#

Generate the DataProcessor Class

. Example Model > Systems Engineering > SysML
Example > Implementation Model > Software >
C++

Generate the 10 Class

. Example Model > Systems Engineering > SysML
Example > Implementation Model > Software >
Java

Generate the 10 Class

. Example Model > Systems Engineering > SysML
Example > Implementation Model > Software >
VBNet

Generate the 10 Class
Hardware Language Examples:

. Example Model > Systems Engineering > SysML
Example: Portable Audio Player >
Implementation Model > Hardware > SystemC

Generate the PlayBack Class
. Example Model > Systems Engineering > SysML
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Example: Portable Audio Player >
Implementation Model > Hardware > VHDL

Generate the PlayBack Class

. Example Model > Systems Engineering > SysML
Example: Portable Audio Player >
Implementation Model > Hardware > Verilog

Generate the PlayBack Class

3 | When completed, press Ctrl+E to open the generated
source code.

Y ou should see methods generated in the code.

Notes

. Software code generation from behavioral models 1s
available in the Unified and Ultimate editions of
Enterprise Architect

. Hardware code generation from StateMachine models i1s
available in the Unified and Ultimate editions of
Enterprise Architect

. For C(OO), on the 'C Specifications' page of the
'Preferences' dialog set the 'Object Oriented Support'’
option to True

. To be able to generate code from behavioral models, all
behavioral constructs should be contained within a Class;
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if the behavioral constructs refer to external elements
outside the current Package, you must add an Import
connector from the current Package to the Package
containing the external elements

. Code synchronization is not supported for behavioral code
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Code Generation - Activity Diagrams

Code generation from Activity diagrams in a Class requires
a validation phase, during which Enterprise Architect uses
the system engineering graph optimizer to analyze the
diagram and render it into various constructs from which
code can be generated. Enterprise Architect also transforms
the constructs into one of the various action types (if
appropriate), similar to the Interaction diagram constructs.

Actions

Action Description

Call Actions = Used to invoke operations or behaviors in

(Invocation an Activity diagram; the two main

Actions) variants of Call Actions supported in
behavioral code generation are:

. CallOperation Action - used to invoke
operations, which can be within the
same Class or in other Classes within
the same Package; if referencing
operations from other Classes within
the same Package, you must have a
target to which the request 1s passed

. CallBehavior Action - used to invoke
another Activity in an activity flow; the
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CreateObject
Action

DestroyObjec
tAction

Loops

(c) Sparx Systems 2019

referenced Activity 1s expected to be
within the same Class

Arguments

Call Actions can specify argument values
corresponding to the parameters in the
associated behavior or behavioral feature.

You can add the arguments manually or
create them automatically using the
Synchronize button of the 'Arguments'
dialog.

Used to denote an object creation in the
activity flow; you can set the result Pin of
the CreateObjectAction as the object to
be created, using the 'Assign Action Pins'
dialog.

The Classifier of the CreateObjectAction
signifies the Classifier for which an
instance is to be created.

Used to denote an object deletion in the
activity flow; you can set the target Pin of
the DestroyObjectAction as the object to
be destroyed, using the 'Assign Action
Pins' dialog.

Enterprise Architect's system engineering
graph optimizer is also capable of
analyzing and identifying loops; an
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identified loop is internally rendered as
an Action Loop, which is translated by
the EASL code generation macros to
generate the required code.

You can have a single loop, nested loops,
and multiple levels of nested loops.

Conditional To model a conditional statement, you
Statements use Decision/Merge nodes.

Alternatively, you can imply
Decisions/Merges internally; the graph
optimizer expects an associated Merge
node for each Decision node, to facilitate
efficient tracking of various branches and
analysis of the code constructs within
them.

Notes

. To be able to generate code from behavioral models, all
behavioral constructs should be contained within a Class
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Code Generation - Interaction
Diagrams

During code generation from Interaction (Sequence)
diagrams in a Class, Enterprise Architect applies its system
engineering graph optimizer to transform the Class
constructs into programmatic paradigms. Messages and
Fragments are identified as two of the several action types
based on their functionality, and Enterprise Architect uses
the code generation templates to render their behavior
accordingly.

Actions

Action Description

Action Call A Message that invokes an operation.

Action A Message with Lifecycle = New.
Create

Action A Message with Lifecycle = Delete.
Destroy

Action Loop = A Combined Fragment with Type = Alt.
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Action If A Combined Fragment with Type = loop.

Assign To A Call Message with a valid target
attribute set using the 'Assign To' field 1s
rendered 1n the code as the target attribute
of a Call Action.

Notes

. To be able to generate code from behavioral models, all
behavioral constructs should be contained within a Class

. For an Interaction (Sequence) diagram, the behavioral
code generation engine expects the Sequence diagram and
all its associated messages and interaction fragments to be
encapsulated within an Interaction element
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Code Generation - StateMachines

A StateMachine illustrates how an object (represented by a
Class) can change state, each change of state being a
transition initiated by a trigger arising from an event, often
under conditions or constraints defined as guards. As you
model how the object changes state, you can generate and
build (compile) code from it in the appropriate software
language and execute the code, visualizing the execution via
the Model Simulator.

It 1s also possible, in Enterprise Architect, to combine the
StateMachines of separate but related objects to see how
they interact (via Broadcast Events), and to quickly create
and generate code from variants of the model. For example,
you might model the behavior of:

. The rear off-side wheel of a vehicle in rear-wheel drive
and front-wheel drive modes (one StateMachine)

. The steering wheel and all four drive wheels of a vehicle
in 4-wheel drive mode (five StateMachines)

. The wheels of an off-road vehicle and of a sports car (two
Artifacts, instances of a combination of StateMachines)

Of critical importance in generating and testing code for all
of these options 1s the Executable StateMachine Artifact
element. This acts as the container and code generation unit
for your StateMachine models.

You do not use this method to generate code for Hardware
Definition Languages, but you can also generate both HDL
code and software code from StateMachines using the
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generic Code Generation facilities in Enterprise Architect
(see the Generate Source Code procedures).

Prerequisites

. Select 'Configure > Model > Options > Source Code
Engineering' and, for the appropriate software coding
language (Java, C, C# or ANSI C++), set the 'Use the new
Statemachine Template' option to 'True’

. If working in C++, select 'Configure > Model > Options >
Source Code Engineering > C++' and set the 'C++
Version' option to 'ANST'

This code generation method does not apply to the Legacy
StateMachine code generation templates developed prior to
Enterprise Architect Release 11.0, nor to generate Hardware
Definition Language code.

Access

Drag an Executable StateMachine Artifact from the
'Artifacts' page of the Diagram Toolbox, onto your diagram.
The 'Artifacts' page of the Diagram Toolbox can be accessed
using any of the methods outlined in this table.

Ribbon Design > Diagram > Toolbox > Artifacts

Keyboard
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Shortcuts Ctrl+Shift+3 > Artifacts

Other You can display or hide the Diagram
Toolbox by clicking on the »/ or «l1icons
at the left-hand end of the Caption Bar at
the top of the Diagram View.

Prepare your StateMachine diagram(s)

Ste Action
p

1 | For each StateMachine you want to model, create a
Class diagram.

2 | From the 'Class' page of the Diagram Toolbox, drag
the 'Class' icon onto your diagram and give the
element an appropriate name.

3 | Right-click on the Class element and select the "New
Child Diagram | State Machine' context menu option.

Give the StateMachine diagram an appropriate
name.

4 | Create the StateMachine model to reflect the
appropriate transitions between States.
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Set up the Executable StateMachine Artifact

Ste Action
p

1 | Create a new Class diagram to contain the modeled
StateMachine(s) from which you intend to generate
code.

2 | From the 'Artifacts' page of the Diagram Toolbox,
drag the 'Executable StateMachine' icon onto the
diagram to create the Artifact element. Name the
element and drag its borders out to enlarge it.

3 From the Browser window, drag the (first) Class
element containing a StateMachine diagram onto the
Artifact element on the diagram.

The 'Paste <element name>' dialog displays. In the
'Drop as' field, click on the drop-down arrow and
select the value "Property’.

(If the dialog does not display, press Ctrl as you drag
the Class element from the Browser window.)

4 | Click on the OK button. The Class element is pasted
inside the Artifact as a Part.
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5 | Repeat steps 3 and 4 for any other Classes with
StateMachines that you want to combine and
generate code for. These might be:

. Repeat 'drops' of the same Class and
StateMachine, modeling parallel objects

. Different Classes and StateMachines, modeling
separate interacting objects

6 | Right-click on the Artifact element and select the
'Properties > Properties' option, expand the
'Advanced' category and, in the 'Language' field,
click on the drop-down arrow and set the code
language to the same language as 1s defined for the
Class elements.

You can now drag this Executable StateMachine
Artifact element from the Browser window onto the
diagram any number of times, and modify the Parts
to model variations of the system or process, or the
same system or process with different programming
languages.

Generate Code From Artifact

Ste Action
p
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1 Click on the Executable StateMachine Artifact
element and select the 'Simulate > Executable States
> Statemachine > Generate' ribbon option.

The 'Executable Statemachine Code Generation'
dialog displays.

2 | In the 'Project output directory' field, type or browse
for the directory path under which to create the
output files.

During code generation, all existing files in this
directory are deleted.

3 | Select the Target System. If you are running on
Windows select the '"Local' option. If you are
working on Linux choose the '"Remote' option. The
choice affects the scripts generated to support the
Simulation.

!

4 | In the 'Location of <compiler> installation directory
field, type or browse for the path of the compiler
installation directory, to be automatically mapped to
the local path (displayed to the left of the field). For
each programming language, the paths might
resemble these examples:

. Java
JAVA_ HOME C:\Program Files
(x86)\Java\dk1.7.0 17

. C/C++
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VC HOME C:\Program Files (x86)\Microsoft
Visual Studio 9.0

. C#
CS HOME
C:\Windows\Microsoft. NET\Framework\V3.5

5 | Click on the Generate button. The code files are
created appropriate to the programming language.

The System Output window displays with an
'Executable StateMachine Output' tab, showing the
progress and status of the generation.

During code generation, an automatic validation
function is executed to check for diagram or model
errors against the UML constraints. Any errors are
identified by error messages on the 'Executable
StateMachine Output' tab.

Double-click on an error message to display the
modeling structure in which the error occurs, and
correct the mistake before re-generating the code.

6  When the code generates without error, click on the
Artifact element and select the 'Simulate >
Executable States > Statemachine > Build' ribbon
option to compile the code.

The System Output window displays with a 'Build’
tab, showing the progress and status of the
compilation. Notice that the compilation includes
configuration of the simulation operation.
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Code Generation Macros

You can also use two macros in the code generation for
StateMachines.

Macro Name Description

SEND EVE | Send an event to a receiver (the Part). For
NT example:

%SEND EVENT("eventl",
"Part1")%

BROADCAS @ Broadcast an event to all receivers. For
T EVENT example:

%BROADCAST EVENT("event2")%

Execute/Simulate Code From Artifact

Ste Action
p

1 | Select the ribbon option 'Simulate > Dynamic
Simulation > Simulator > Apply Workspace' to
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display the Simulation window and the Simulation
Events window together

Dock the two windows 1n a convenient area of the
screen.

2 | On the diagram or Browser window, click on the
Artifact element and select the 'Simulate >
Executable States > Statemachine > Run' ribbon
option.

The first StateMachine diagram in the series displays
with the simulation of the process already started. In
the Simulation window, the processing steps are
indicated in this format:

[03516677]
Partl[Classl].Initial 367 TO State4 142 Effect

[03516683] Partl[Classl].StateMachine State4
ENTRY

[03516684] Partl[Classl].StateMachine State4
DO

[03518375] Blocked

3 | Click on the appropriate Simulation window toolbar
buttons to step through the simulation as you prefer.

When the simulation finishes at the Exit or
Terminate element, click on the Stop button in the
Simulation window toolbar.

4 | Where the trace shows Blocked, the simulation has
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reached a point where a Trigger event has to occur
before processing can continue. On the Simulation
Events window, in the "Waiting Triggers' column,
double-click on the appropriate Trigger.

When the Trigger is fired, the simulation continues
to the next pause point, Trigger or exit.

Notes

. If you are making small changes to an existing
StateMachine model, you can combine the code
generation, build and run operations by selecting the
'Simulate > Executable States > Statemachine > Generate,
build and run' ribbon option

. You can also generate code in JavaScript
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Legacy StateMachine Templates

Code generation operates using a set of generation
templates. From Release 11.0 of Enterprise Architect, a
different set of templates are available as the default for
software code generation from a StateMachine diagram into
Java, C, ANSI C++ or C# code. You can still use the
original templates, as described here, for models developed
in earlier releases of Enterprise Architect, i1f you do not want
to upgrade them for the new template facilities.

Switch Between Legacy and Release 11
templates

Access

Display the 'Manage Project Options' dialog, then show the
'Language Specifications' page for your chosen language,
using one of the methods outlined in this table. If necessary,
expand the 'StateMachine Engineering (for current model)’
grouping and set the 'Use the new StateMachine Template'
option to True (to use the later templates) or False (to use
the Legacy templates).

Ribbon Configure > Model > Options > Source
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Code Engineering > [language name]

Legacy Template Transformations

A StateMachine in a Class internally generates a number of
constructs in software languages to provide effective
execution of the States' behaviors (do, entry and exit) and
also to code the appropriate transition's effect when
necessary.

Model Code Objects
Objects

Enumerations . StateType - consists of an enumeration
for each of the States contained within
the StateMachine

. TransitionType — consists of an
enumeration for each transition that has
a valid effect associated with it; for
example,
ProcessOrder Delivered to ProcessOr
der Closed

. CommandType — consists of an
enumeration for each of the behavior
types that a State can contain (Do,
Entry, Exit)
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Attributes . currState:StateType - a variable to hold
the current State's information

. nextState:StateType - a variable to hold
the next State's information, set by each
State's transitions accordingly

. currTransition:TransitionType - a
variable to hold the current transition
information; this is set if the transition
has a valid effect associated with it

. transcend:Boolean - a flag used to
advise 1f a transition is involved in
transcending between different
StateMachines (or Submachine states)

. xx_history:StateType - a history
variable for each
StateMachine/Submachine State, to
hold information about the last State
from which the transition took place

Operations . StatesProc - a States procedure,
containing a map between a State's
enumeration and its operation; it
de-references the current State's
information to invoke the respective
State's function

. TransitionsProc - a Transitions
procedure, containing a map between
the Transition's enumeration and its
effect; it invokes the Transition's effect
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. <<State>> - an operation for each of
the States contained within the
StateMachine; this renders a State's
behaviors based on the input
CommandType, and also executes its
transitions

. 1nitializeStateMachine - a function that
initializes all the framework-related
attributes

. runStateMachine - a function that
iterates through each State, and
executes their behaviors and transitions
accordingly

Notes

. To be able to generate code from behavioral models, all
behavioral constructs should be contained within a Class
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Java Code Generated From Legacy
StateMachine Template

+ do/
[status==0rderStatus.delivered]
fsatStatus(OrderStatus.closed)
Closed ' Delivered
+ do fupdaeteStatus

private enum StateType: int

{

ProcessOrder Delivered,
ProcessOrder Packed,
ProcessOrder Closed,
ProcessOrder Dispatched,
ProcessOrder New,

ST NOSTATE

b

private enum TransitionType: int

{

ProcessOrder Delivered to ProcessOrder Closed,
TT NOTRANSITION
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b

private enum CommandType
d
Do,
Entry,
Exit
)
private StateType currState;
private StateType nextState;
private TransitionType currTransition;
private boolean transcend;
private StateType ProcessOrder history;

private void processOrder Delivered(CommandType
command)

{

switch(command)

{

case Do:

{
// Do Behaviors..

setStatus(Delivered);
// State's Transitions
if((status==Delivered))

d

nextState = StateType.ProcessOrder Closed;
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currTransition =
TransitionType.ProcessOrder Delivered to ProcessOrder
Closed;

h
break;

b

default:

{
break;

b

private void processOrder Packed(CommandType
command)

{
switch(command)
d
case Do:
d
// Do Behaviors..
setStatus(Packed);
// State's Transitions
nextState =
StateType.ProcessOrder Dispatched;
break;
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b
default:

d
break;

b

private void processOrder Closed(CommandType
command)

{

switch(command)

{

case Do:

{
// Do Behaviors..

// State's Transitions
break;

b
default:

{
break;

h
private void processOrder Dispatched(CommandType
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command)

{

switch(command)

{

case Do:
{
// Do Behaviors..
setStatus(Dispatched);
// State's Transitions
nextState = StateType.ProcessOrder Delivered;

break;

b
default:

d
break;

b

private void processOrder New(CommandType
command)

{

switch(command)

{

case Do:

d
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// Do Behaviors..

setStatus(new);

// State's Transitions

nextState = StateType.ProcessOrder Packed;

break;

b
default:

d
break;

b

private void StatesProc(StateType currState,
CommandType command)

{

switch(currState)

{

case ProcessOrder Delivered:

d

processOrder_Delivered(command);
break;

b

case ProcessOrder Packed:

{

processOrder Packed(command);
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break;
h

case ProcessOrder Closed:

{

processOrder_Closed(command);
break;

b

case ProcessOrder Dispatched:

d

processOrder Dispatched(command);
break;

b

case ProcessOrder New:

{

processOrder New(command);
break;

h

default:
break;

7 August, 2019

private void TransitionsProc(TransitionType transition)

{

switch(transition)

{
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case
ProcessOrder Delivered to ProcessOrder Closed:
{
setStatus(closed);
break;
)
default:
break;
b
§
private void initalizeStateMachine()
{

currState = StateType.ProcessOrder New;
nextState = StateType.ST NOSTATE;

currTransition =
TransitionType. TT NOTRANSITION;
h
private void runStateMachine()
{
while (true)
1
if (currState == StateType.ST NOSTATE)
{
break;
)
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currTransition =
TransitionType. TT NOTRANSITION;

StatesProc(currState, CommandType.Do);

// then check if there is any valid transition
assigned after the do behavior

if (nextState == StateType.ST NOSTATE)

d
break;

b

if (currTransition !=
TransitionType. TT _NOTRANSITION)

{

TransitionsProc(currTransition);

b

if (currState != nextState)

{

StatesProc(currState, CommandType.Exit);
StatesProc(nextState, CommandType.Entry);
currState = nextState;

(c) Sparx Systems 2019 Page 175 of 674



User Guide - Software Models 7 August, 2019

StateMachine Modeling For HDLs

To efficiently generate Hardware Description Language
(HDL) code from StateMachine models, apply the design
practices described 1n this topic. Hardware Description
Languages include VHDL, Verilog and SystemC.

In an HDL StateMachine model, you might expect to:
. Designate Driving Triggers

. Establish Port—Trigger Mapping

. Add to Active State Logic

Operations

Operation Description

Designate . A 'Change' Trigger is deemed to be an
Driving asynchronousTrigger if:
Triggers - There is a transition from the

actual SubMachine State (which
encapsulates the actual logic) that
it triggers, and
- The target State of that transition
has a self transition triggered
by the same Trigger

. Asynchronous Triggers should be
modeled according to this pattern:
- The Trigger should be of type
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Establish
Port-Trigger
Mapping

(c) Sparx Systems 2019

Change (specification: True / False)
- The active State (SubMachine
State) should have a transition
triggered by it
- The target State of the triggered
transition should have a self
transition with the same Trigger

. A Trigger of type "Time', which
triggers the transitions to the active
state (SubMachine State), is deemed to
be the Clock; the specification of this
trigger should conform to the target
language:
- VHDL - rising_edge /

falling edge
- Verilog - posedge / negedge
- SystemC - positive / negative

After successfully modeling the different
operating modes of the component, and
the Triggers associated with them, you
must associate the Triggers with the
component's Ports.

A Dependency relationship from the Port
to the associated Trigger 1s used to
signify that association.
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class HDL

Active State  Designating the driving Trigger and

Logic establishing the Port-Trigger mapping put
in place the preliminaries required for
efficiently interpreting the hardware
components.

The actual StateMachine logic is now
modeled within the Active (SubMachine)
state.

Notes

. To be able to generate code from behavioral models, all
behavioral constructs should be contained within a Class

. The current code generation engine supports only one
clock Trigger for a component
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Win32 Ul Technology

Using the MDG Win32 UI Technology, you can design user
interface screens that render as Win32® controls. The user
interface produced can be used in any resource definition
script. Resource definition scripts, or RC files, are a
Microsoft technology that - as for other code - can be
compiled and the assets used by native desktop applications.
User interface screens or dialogs can be created from scratch
or reverse engineered. User interface models can also be
forward engineered using the synchronize code function
(F7). Interface modeling takes place on diagrams in the
exact same fashion as you would work with any technology
in Enterprise Architect. An interesting aspect of User
Interface design in Enterprise Architect 1s that components
can take an active role in the simulation of StateMachines
and Activities, enabling a simulation to interact with users,
much like a real program
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Access
Ribbon Design > Diagram > Add > Type > User
Interface Win32
Context Right-click on Package | Add Diagram >
Menu Type | User Interface Win32
Other Browser window caption bar menu | New
Diagram | User Interface Win32
Support

The MDG Win32® User Interface Technology i1s available
in the Enterprise Architect Professional, Corporate and Suite
editions

Enabling Win32 User Interface Technology
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Win32® User Interface Modelling
Wersiom 1

ToGH0R s Tomsoiog

Description

Dragramy, slemerés and wrepd for modeiling
Windaws user interfaces. Depends on
EAScnpiLib)

Wndd noa regiviered Irademark ol Merencf
Corperabian In the Unged Stakes and'or o5her

‘Ii_l_l_l'ﬂ'ﬂ_l_lTl__l_l_lTl__l_l_l_l__l_l_l_l i

The Win32® UI Technology in Enterprise Architect is
enabled or disabled using the 'MDG Technologies' dialog
(select the 'Specialize > Technologies > Manage-Tech'
ribbon option).

Default technology

You can set the MDG Win32® UI Technology as the active
default technology to access the Toolbox pages directly.
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Modeling Ul Dialogs

The Win32 User Interface MDG Technology provides the
tools to help you design a user interface that closely
emulates the visual style and available options for Windows
dialogs.

L] Property Restrictions
Property: [}
IDC_MAME XML
~ Cardinality

Minimum: E Maxdmum: E D Unbounded
-Options
(_j Mone
C}' Redefined by | |DC_COMBO1 A
() As choice of hems
ftem 1
0 ftem 2
3 ftem 3
2 tem 4

C}' By Reference

(] Inline Definition [ 0K ]| Cancel

Win32 Dialog

These user interface components are supported, each
matching the equivalent-named RC resource.

Component | Details

win32Dialog = The equivalent of the RC format
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win32StaticT
ext

win32Edit

win32Button

win32Check
Box

win32ScrollB
arH

win32ScrollB
arV

win32Group
Box

win32Combo
Box
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DIALOG and DIALOGEX resources.

The equivalent of the RC format LTEXT,
RTEXT, CTEXT resources.

The equivalent of the RC format
EDITTEXT resource.

The equivalent of the RC format
BUTTON, DEFPUSHBUTTON and
other resources.

The equivalent of the RC format
CHECKBOX resource.

The equivalent of the RC format
SCROLLBAR resource with SBS HORZ
style

The equivalent of the RC format
SCROLLBAR resource with SBS VERT
style.

The equivalent of the RC format
GROUPBOX resource.

The equivalent of the RC format
COMBOBOX resource.

Note: When you initially drag the 'Combo
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Box' icon - of type 'Drop Down' or 'Drop
Down List' - onto a diagram, the middle
'tracking handle' on each side of the
element 1s white, indicating that you can
only adjust the width of the element. To
adjust the height of the element as well as
the width, click on the drop-down arrow
part of the image; the middle 'tracking
handle' on the bottom edge 1s now white,
indicating that you can drag the base
down to set the virtual height (the height
of the element when it is expanded to

show all possible values in the drop-down
list).

win32ListBo | The equivalent of the RC format
X LISTBOX resource.

win32RadioB The equivalent of the RC format
utton RADIOBUTTON resource.

win32TabPan | The equivalent of the RC format
e TABPANE resource.

win32Picture = The equivalent of the RC format STATIC
resource with SS BITMAP style.

The control can render an image when
applied from your model. An image can
be applied by selecting it first and
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pressing Ctrl+Shift+W to display the
Image Manager. Afterwards, you might
need to change the value of the resource
ID 1in the appropriate Tagged Value.

win32Custo | The equivalent of the RC format
mControl CONTROL resource.
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Import Single Dialog from RC File

You can quickly import a single dialog by name.

Win32 Resource Import: IDD_RAS STORAGE

Resource File:  C:\projects\projectiprojecti.rc
Resource |D: | IDD_RAS_STORAGE

Language: English ( United States )

Starts 6/10/2015 11:12:26 AM
win32Dialog, IDD_RAS_STORAGE
Completed: 6/10/2015 11:12:28 AM

1/1

Cloze

Help

Access

In the Browser window, click on the target Package.

Ribbon Develop > Source Code > Files > Import

Resource Script
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Import All Dialogs from RC File

All dialogs 1n a single RC file can be imported into your
model. This image was captured one minute into the import,
at which time over 200 large dialog definitions had been
imported.

Resource File: | C:'Code Samplesiwin32ui.rc
Resource (D: | all

Language: English { United States )

win32Dialog, IDD_NEWVIEW DLG
win32Dialog, IDD_PKG_CONTROL
win32Dialog, IDD_USAGE_DLG
win32Dialog, IDD_OPT_PAGES
win32Dialog, IDD_NAMESPACE_DLG
win32Dialog, IDD_RUNSTATE
win32Dialog, IDD_APPEARANCE

—

Access

Ribbon Develop > Source Code > Files > Import
Resource Script
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Export Dialog to RC File

Once a screen design is modified or a new one created, you
might want to get it back to the RC file you use to build
your application, so that you can see how it looks with real
data. Begin by selecting the Win32Dialog element in the
Browser window, then use the ribbon to perform the
synchronization.

Save Screen x

Screen 10:
Resource File:

Language:

IDD_RAS_STORAGE
F:\projectsproject1\project1.rc

Endlish { United States )

Close Help

Export

Access

Click on the win32Dialog element.

Ribbon Develop > Source Code > Generate >
Generate Single Element

Keyboard F11

Shortcuts
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Design a New Dialog

Creating a new Win32 dialog is easy and mostly visual. You
will probably need a workspace that shows:

. The new diagram (select the 'Design > Diagram > Add >
User Interface - Win32 > User Interface - Win32' ribbon
path)

. The Win32 User Interface Toolbox (select the 'Design >
Diagram > Tooolbox' ribbon option) and

. The Tagged Values tab of the Properties window

L] Class Markup Selection

~Add Markers To...
() Existing marker set

r
() New marker ...

Name | IDC_SET_NAME

Expanded Mode
- Expanded Mode
t— Leaf
- Leaf
- Collapsed Mode
= Leaf

o4

] &

Marker Type: | IDC COMBOH - | D Include disabled operations

Frame Depth Limit: E| %

[ oK ] | Cancel
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The Ul Toolbox

All of the common RC elements can be found on the Ul
toolbox

The Tags Tab

This tab 1s provided on the Properties window and
'Properties' dialog for an object, and is where all the
properties of a control can be viewed and edited.
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Tagged Values 1
BE|8) & B X | Lo FE
B win32Ul:-win32DateTime (U Control)

Accept Files Falze
Allow Edit Falze
Client Edge Falze
Dizabled False
Format Short Date [w]
Group Short Date
Help ID Long Date
Time
D
Left Scrollbar Falze
Madal Frame Falze
Right Align True

Using the Picture Control

Images from your model (see Image Manager) can be
applied by selecting the control on the dialog and pressing
Ctrl+Shift+W. You might have to enter the value of the
resource ID in the appropriate Tagged Value.

Note

. You can copy and paste dialog Packages
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GoF Patterns

A Design Pattern 1s a template for solving commonly
recurring design problems; it consists of a series of elements
and connectors that can be reused in a new context. The
advantage of using Patterns is that they have been tested and
refined in a number of contexts and so are typically robust
solutions to common problems. Enterprise Architect
provides the Gang of Four Patterns as an MDG Technology
that can be loaded into the current repository.

The Gang of Four (Gof) Patterns are a group of twenty three
Design Patterns originally published in a seminal book
entitled Design Patterns: Elements of Reusable
Object-Oriented Software; the term 'Gang of Four' refers to
the four authors. Enterprise Architect displays these Patterns
in its powerful Pattern engine, helping you to visualize the
elements of the Pattern and adjust the Pattern to the context
of your software design problem.

GoF Patterns in Enterprise Architect

Features Description

GoF Pattern | The GoF Patterns are provided in the
Facilities form of:

. GoF Behavioral Patterns, GoF
Creational Patterns and GoF Structural
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Patterns pages in the Toolbox

7 August, 2019

. Gang of Four Pattern entries in the

Toolbox Shortcut Menu
GoF Pattern Toolbox Pages

You can access the 'GoF Pattern' pages of
the Toolbox by clicking on i to display
the 'Find Toolbox Item' dialog and
specifying 'GoF Patterns'; these icons are
available:

| - GoF Behavioral Patterns

%
%
%
%
%
%

Chain of Responsibility

Command
Interpreter
Heratar
Mediator
Memento
Observer

State

Strategy
Template Method
Wisitor

| =

GoF Creational Patterns

Abstract Factory
Builder

Factory Method
Prototype

Singleton

| =

GoF Structural Patterns

Adapter
Eridge
Composite
Decorator
Facade
Flyweight
Prowxy

When you drag one of the Pattern
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clements onto a new diagram, the 'Add
Pattern GoF <pattern group><pattern
type>' dialog displays; if necessary,
modify the action and/or default for the
component elements, then click on the
OK button to create a diagram based on
the Pattern.
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Configuration Settings
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You can set the default code options such as the editors for
cach of the programming languages available for Enterprise
Architect and special options for how source code is
generated or reverse engineered. These options are defined
according to whether they apply to:

. All users of the current model, set on the 'Manage Project
Options' dialog, or

. All models that you access (other users can define their
own settings that apply to the same models), set on the
'Preferences' dialog

You can also:

. For each programming language used in the model, for all
users working on the model, define Collection Classes for
generating code from Association connectors where the
target role has a multiplicity setting greater than 1

. Define a local path for yourself, using the 'Local Path'
dialog; these settings apply to all Enterprise Architect
models that you access

. Define language macros within the model, which are
useful in reverse engineering and can be exported from
and imported to the model
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Source Code Engineering Options

The 'Source Code Engineering' options apply to the
languages in which you generate code from Enterprise
Architect. They are divided into Model-specific options and
User-specific options, as explained here.

Model-Specific Options

These options are defined on the '"Manage Project Options'
dialog.

Access
Ribbon Configure > Model > Options > Source
Code Engineering
Types of Option

Option Type Detail

Source Code @ You can define a number of settings for
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Generation generating code in the model, such as the

Options default language to generate code in and
the Unicode character set for code
generation.

Options - You can configure various options

Object concerning Object Lifetimes.

Lifetimes

Code For each of the code languages that

Language Enterprise Architect supports, you can

Options define the model-specific options and set

any Collection Classes required.

User-Specific Options

These options are defined on the 'Preferences' dialog.

Access

On the 'Preferences' dialog, click on 'Source Code
Engineering' in the left-hand list.

Ribbon Start > Desktop > Preferences >
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Preferences
Keyboard Ctrl+F9
Shortcuts
Types of Option
Option Type | Detail

Source Code
Generation
Options

Code Editors

Attributes/Op
erations

Code
Language
Options
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You can define a number of settings for
generating code in any model that you
access under the same user ID.

These are options for accessing and
configuring the source code editor.

Use these options for configuring
attributes and operations.

For each of the code languages that
Enterprise Architect supports, you can
define the user-specific options that apply
to any model that you access under your
user ID.
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Code Generation Options

When you generate code for your model, you can set certain
options. These include:

. The default language
. Whether to generate methods for implemented interfaces
. The Unicode options for code generation

Access

Ribbon Configure > Model > Options > Source
Code Engineering

Configure code generation options

Option Action

Always Select the radio button to synchronize
synchronize  imported code with an existing file.
with existing

file

(recommende

d)
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Replace
(overwrite)
existing
source file

Component
Types

Default
Language for
Code
Generation

DDL Name
Templates

Default name
for associated
attrib

Generate
methods for
implemented
interfaces

(c) Sparx Systems 2019

Select the radio button to overwrite the
existing source file with imported code.

Click on this button to open the 'Tmport
component types' dialog, to set up the
importation of component types.

Click on the drop-down arrow and select
the default language for code generation.

Click on the [-] button to define the
template names for Primary Key, Unique
Constraint, Foreign Key and Foreign Key
Index Name templates.

Type in a default name to be generated
from imported attributes.

Select the checkbox to indicate that
methods are generated for implemented
interfaces.
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Code page Click on the drop-down arrow and select
for source the appropriate Unicode character
editing embedding format to apply.

Notes

. It 1s worthwhile to configure these settings, as they serve
as the defaults for all Classes in the model; you can
override most of these on a per-Class basis using the
custom settings (from the 'Code Generation' dialog)
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Import Component Types

Using the 'Tmport Component Types' dialog you can
configure what elements you would like to be created for
files of any extension found while importing a source code
directory.

Access

Ribbon Configure > Model > Options > Source
Code Engineering: Component Types

Define Import Component Types

Option Action

Extension Type in the extension name for a
component type.

Type Click on the drop-down arrow and select
the component type.

Stereotype Type in any stereotype name that further
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identifies a component of this type.

Component Lists the currently-defined component
List types.

Save Click on this button to saves the
component definition and add it to the
component list.

New Click on this button to clear the dialog
fields so that you can define a new
component type.

Delete Click on this button to delete the selected
component type from the component list.

Notes

. You can transport these import component types between
models, using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options
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Source Code Options

You can set a wide range of options for generating code in
the models you work with. These include:

. How to format the generated code
. How to respond to certain events during code generation
. Whether to generate a diagram from the code

Access

On the 'Preferences' dialog, select the 'Source Code
Engineering' option

Ribbon Start > Desktop > Preferences >
Preferences

Keyboard Ctrl+F9
Shortcuts

Configure code generation options

Field Action

Wrap long Type in the number of characters to allow
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comment
lines at

Auto Layout
Diagram on
Import

Output files
use both CR
& LF

Prompt when
synchronizin
g (reversing)

Remove hard
breaks from
comments on
import

Auto
generate role
names when
creating code

Do not
generate
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in a comment line before wrapping the
text to the next line.

Click on the drop-down arrow and select
if and when a diagram 1s automatically
generated on code import.

Select the checkbox to include carriage
returns and line feeds; set this option
according to what operating system is
currently in use, as code might not render
correctly.

Select the checkbox to display a prompt
when synchronization occurs.

Select the checkbox to remove hard
breaks from commented sections on
importation.

Select the checkbox to generate role
names when creating code.

Select the checkbox to prevent generation
of members if the Association direction is
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members
where
association
direction 18
'Unspecified'

Create
dependencies
for operation
returns and
parameter

types

Comments:
Generate

Comments:
Reverse

Remove
prefixes
when
generating

Get/Set
properties

Treat as
suffixes
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unspecified.

Select the checkbox to generate
dependencies for operation returns and
parameter types.

Select the checkbox to generate
comments.

Select the checkbox to generate reverse
comments.

Type 1n the prefixes, separated by
semi-colons, used in your variable
naming conventions, to be removed in the
variables' corresponding get/set functions.

Select the checkbox to use the prefixes
defined in the 'Remove prefixes when
generating Get/Set properties' field as
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suffixes.

Capitalized Select the checkbox to capitalize attribute
Attribute names for properties.

Name for

Properties

Use 'Is' for Select the checkbox to use the Is keyword
Boolean for the Boolean property Get().

property
Get()

Notes

. It is worthwhile to configure these settings, as they serve
as the defaults for all Classes in the model; you can
override most of these on a per-Class basis using the
custom settings (from the 'Code Generation' dialog)
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Options - Code Editors

You access the source code editor options via the 'DDL'
page of the 'Preferences' dialog. On this page you can
configure options for Enterprise Architect's internal editor,
as well as the default editor for DDL scripts. You can
configure external editors for code languages on each
language options page.

Access

On the 'Preferences' dialog, select the 'Source Code
Engineering > Code Editors' option.

Ribbon Start > Desktop > Preferences >
Preferences

Keyboard Ctrl+F9
Shortcuts

Options

Option Action
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DDL Editor

Default
Database

MySQL
Storage

Use inbuilt
editor 1f no
external
editor set

Show Line
Numbers

Show
Structure
Tree

Automaticall

y Reverse
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Defaults to blank, indicating that the
Enterprise Architect code editor is the
DDL editor in use.

You can select a different default editor if
necessary; click on the [--] button to
browse for and select the required DDL
editor. The editor name then displays in
the 'DDL Editor' field.

Click on the drop-down arrow and select
the default database to be used.

Click on the drop-down arrow and select
the MySQL storage engine to be used.

Select the checkbox to use the inbuilt
editor for code in any language if no
external editor 1s defined for that
language 1n the user-specific options.

Select the checkbox to display line
numbers in the editor.

Select the checkbox to show a tree with
the results of parsing the open file (if the
file 1s parsed successfully).

If you select this checkbox, pressing
Ctrl+S to save in the source code editor
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Engineer on | automatically reverse engineers the code
File Save in the same way as the Save Source and
Re-Synchronize Class button does.

Don't parse Click on the drop-down arrow and select
files larger the upper limit on file size for parsing.
than Setting this option prevents performance

decrease due to parsing very large files.

Syntax Click on the -] button to display the

Highlighting  'Editor Language Properties' dialog, in

Options which you can set both global and
language-specific editor language
properties.

Configure Click on the [-] button to display the 'Set

Enterprise Associations for a Program' dialog, and

Architect File = select the file extensions for files that you
Associations | want to open through the Enterprise
Architect Document Handler
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Editor Language Properties

Using the 'Editor Language Properties' dialog, you can
specify syntax highlighting properties for any of the
programming languages that Enterprise Architect supports
at installation.

Access

In the 'Preferences' dialog, select the 'Source Code
Engineering | Code Editors' option and click on the [
button next to 'Syntax Highlighting Options'.

Ribbon Start> Desktop > Preferences >
Preferences, select 'Source Code
Engineering | Code Editors' option > click
on the [~/ button next to 'Syntax
Highlighting Options:

Other In the Code Editor window, click on the
toolbar icon &z | Syntax Highlighting
Options

Options
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Panel

Language
Panel
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Description

The panel on the left of the dialog lists
the languages for which you can set
properties.

At the top of the list are three

non-language options:

. (Dark Theme) - assigns a dark
background to the property fields and
to the code panel in the code editor
screen (you can apply a different color
to specific properties)

. (Light Theme) - assigns a pale
background to the property fields and
to the code panel in the code editor
screen (you can apply a different color
to specific properties)

You can also set the background
themes on the 'Application Look’
dialog

. (Global) provides properties that you
can set for all programming languages;
however, you can reset a global
property to a different value for a
particular language, in the properties
specifically for that language
Resetting a global property for one
language does not affect that property's
value for the other languages

Page 215 of 674



User Guide - Software Models 7 August, 2019

Properties
Panel
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Click on the required language in the list,
to display the properties for that
language:

. Properties shown in bold indicate that
this 1s the highest level at which this
property can be defined (for most
language options other than 'Global',
this 1s effectively the only point at
which the property 1s defined)

. Properties shown in normal font are
generally the global properties that you
can reset just for the current language

Scroll through the property categories and
individual properties for the language.
You can collapse and expand categories
as necessary, using the expansion box
next to the category name (=).

When you click on a property name, an
explanation of that property displays in
the panel at the bottom right of the dialog.

To define a property, click on the value
field following the property name;
depending on the type of property, either
the field is enabled for direct editing or a
drop-down arrow or -] button displays
(as described for the 'Tags' tab of the
Properties window) so that you can select
the values to define the property.

Page 216 of 674



User Guide - Software Models 7 August, 2019

Select or type in the required values.
Use the Toolbar icons to:
. Save your changes to the properties

. Reset all properties fields to the default
settings shipped with Enterprise
Architect

. Reset the current style field to the
default setting (not enabled for
non-style fields)

Assign Keys  In the 'Macros' category of the properties,

to Macros you can assign (Ctrl+Alt+<n>) keystroke
combinations to coding macros that you
have created yourself in the 'Source Code
Viewer'.
When you click on the Browse button in
a selected 'Macro' field, the 'Open Macro'
dialog displays; this dialog lists the
existing macros and, if a key combination
has been assigned to a macro, what that
key combination is.

Click on the name of the macro and on
the Open button to assign the selected
keys to the macro.

Notes
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. You cannot currently set properties for any additional
languages you include through an MDG Technology

. You can resize this dialog, if required
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Options - Object Lifetimes

You can use these options to configure various Object
Lifetime settings such as:

. Defining constructor details when generating code
. Specifying whether to create a copy constructor
. Defining Destructor details

Access
Ribbon Configure > Model > Options > Source
Code Engineering > Object Lifetimes
Options
Option Action

Constructor | If necessary, select the checkboxes to
specify that a constructor 1s generated and
(for C++) that the constructor is in-line.

Click on the drop-down arrow and select
the appropriate visibility of the default
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constructor - Private, Protected or Public.

Copy If necessary, select the checkboxes to

Constructor | specify that a copy constructor is
generated and (for C++) that the copy
constructor 1is in-line.

Click on the drop-down arrow and select
the appropriate visibility of the default
copy constructor - Private, Protected or
Public.

Destructor If necessary, select the checkboxes to
specify that a destructor is generated and
(for C++) that the destructor is in-line
and/or virtual.

Click on the drop-down arrow and select
the appropriate visibility of the default
destructor - Private, Protected or Public.
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Options - Attribute/Operations

Y our use of attributes and operations can be configured in a
number of ways. You can set options to:

. Delete model attributes not included in the code during
reverse synchronization

. Delete model methods not included in the code during
reverse synchronization

. Delete code from features contained in the model during
forward synchronization

. Delete model associations and aggregations that
correspond to attributes not included in the code during
reverse synchronization

. Define whether or not the bodies of methods are included
and saved in the model when reverse engineering

. Create features in quick succession, clearing the
Properties window when you click on 'Save' so that you
can enter another feature name

You configure these options on the 'Attribute/Operations'
page of the 'Preferences' dialog.

Access

On the 'Preferences' dialog, select the 'Source Code
Engineering > Attribute/Operations' option.
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Ribbon

Keyboard
Shortcuts

Options

Field

On reverse
synch, delete
model
attributes not
1n code

On reverse
synch, delete
model
associations
not in code

On reverse
synch, delete
model
methods not
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Start > Desktop > Preferences >
Preferences

Ctrl+F9

Action

Select the checkbox to indicate that on
reverse synchronization, attributes in the
model that are not included within code
are automatically removed from the
model.

Select the checkbox to indicate that on
reverse synchronization, associations in
the model that are not included within
code are automatically removed from the
model.

Select the checkbox to indicate that on
reverse synchronization, methods in the
model that are not included within code
are automatically removed from the
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in code model.

Include Select the checkbox to indicate that on
method reverse engineering code, method bodies
bodies in in the code are included within your
model when | model.

reverse

engineering

After Save, Select the checkbox to indicate that after

re-select saving an attribute or operation, the

edited item properties definition continues to display
the details of the selected feature.

If deselected, indicates that the fields of
the properties definition will clear so that
you can enter another attribute or
operation name and details immediately.

On forward Select the checkbox to indicate that,

synch, during forward synchronization, the

prompt to 'Synchronize Element <package

delete code name>.<element name>' dialog displays,

features not so that you can either ignore, reassign or

in model delete features in the code that are not in
the model.
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Modeling Conventions

The synchronization between UML models and
programming code is achieved using a set of modeling
conventions (mappings) between UML constructs and
programming code syntax. The Software Engineer 1s
advised to become familiar with these conventions in order
to work with the code generation process for the
programming languages they intend to target. There are a
range of constructs used, including elements, features,
connectors, connector ends, stereotypes and Tagged Values.
The newcomer will require a little time to become familiar
with these conventions but after a short time they will be
translating between programming code and UML constructs
without effort.

Supported Languages

Language
Action Script

Ada 2012 (Unified and Ultimate editions)
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C

C#

C++

Delphi

Java

PHP

Python

SystemC (Unified and Ultimate editions)
Verilog (Unified and Ultimate editions)
VHDL (Unified and Ultimate editions)
Visual Basic

Visual Basic .NET

Notes
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Enterprise Architect incorporates a number of visibility
indicators or scope values for its supported languages; these
include, for:

. All languages - Public (+), Protected (#) and Private (-)
. Java - Package (~)

. Delphi - Published (%)

. C# - Internal (~), Protected Internal (")

. ActionScript - Internal (~)

. VB.NET - Friend (~), Protected Friend (")

. PHP - Package (~)

. Python - Package (~)

. C - Package (~)

. C++ - Package (~)
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ActionScript Conventions

Enterprise Architect supports round trip engineering of
ActionScript 2 and 3, where these conventions are used.

Stereotypes

Stereotype Applies To

literal Operation
Corresponds To: A literal method
referred to by a variable.

property get | Operation
Corresponds To: A 'read' property.

property set Operation
Corresponds To: A 'write' property.

Tagged Values

Tag Applies To
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attribute_nam
e

dynamic

final

Intrinsic

namespace

override

prototype

rest
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Operation with stereotype property get or
property set

Corresponds To: The name of the
variable behind this property.

Class or Interface
Corresponds To: The 'dynamic' keyword.

ActionScript 3: Operation
Corresponds To: The 'final' keyword.

ActionScript 2: Class
Corresponds To: The 'intrinsic' keyword.

ActionScript 3: Class, Interface,
Attribute, Operation

Corresponds To: The namespace of the
current element.

ActionScript 3: Operation
Corresponds To: The 'override' keyword.

ActionScript 3: Attribute
Corresponds To: The "prototype’
keyword.

ActionScript 3: Parameter
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Corresponds To: The rest parameter (...)

Common Conventions

. Package qualifiers (ActionScript 2) and Packages
(ActionScript 3) are generated when the current Package
1S not a namespace root

. An unspecified type is modeled as 'var' or an empty "Type'
field

ActionScript 3 Conventions

. The Is Leaf property of a Class corresponds to the sealed
keyword

. If a namespace tag is specified it overrides the Scope that
1s specified
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Ada 2012 Conventions

Enterprise Architect supports round trip engineering of Ada
2012, where these conventions are used.

Stereotypes

Stereotype

adaPackage

adaProcedure

delegate

enumeration

struct
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Applies To

Class

Corresponds To: A Package specification
in Ada 2012 without a tagged record.

Class

Corresponds To: A procedure
specification in Ada 2012.

Operation
Corresponds To: Access to a subprogram.

Inner Class
Corresponds To: An enumerated type.

Inner Class
Corresponds To: A record definition.
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typedef Inner Class

Corresponds To: A type definition,
subtype definition, access type definition,

renaming.
Tagged Values
Tag Applies To
Aspect Inner Class with stereotype typedef
Operation

Corresponds to: Aspect specification
(Precondition and Postcondition of
Subprogram type 'invariant', subtype
'predicate’).

InstantiatedU | Inner Class with stereotype typedef

nitType Corresponds To: The instantiated unit's
type (Package / Procedure / Function).

IsAccess Parameter

Corresponds To: Determination of
whether the parameter 1s an access
variable.
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IsAliased Function parameter

Corresponds to: Aliased function
parameter.

Discriminant = Inner Class with stereotype typedef
Corresponds To: The type's discriminant.

PartType Inner Class with stereotype typedef
Corresponds To: The part type (‘renames'
or 'new').

Type Inner Class with stereotype typedef

Corresponds To: If 'Value' ='SubType',
set 'subtype'

If 'Value' ="'Access', set 'access type'.

Other Conventions

. Appropriate type of source files: Ada specification file,
.ads

. Ada 2012 imports Packages defined as either

<<adaPackage>> Class or Class, based on the settings in
the Ada 2012 options

. A Package in the Ada specification file is imported as a
Class 1f it contains a Tagged Record, the name of which is
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governed by the options 'Use Class Name for Tagged
Record' and 'Alternate Tagged Record Name'; all
attributes defined in that Tagged Record are absorbed as
the Class's attributes

. A procedure / function in an Ada specification file is
considered as the Class's member function if its first
parameter satisfies the conditions specified in the options
'Ref Param Style', 'Ignore Reference parameter name' and
'Ref parameter name'

. The option 'Define Reference for Tagged Record', if
enabled, creates a reference type for the Class, the name
of which is determined by the option 'Reference Type
Name'; for example:

HelloWorld.ads
package HelloWorld 1s
type HelloWorld 1s tagged record
Attl: Natural;
Att3: Integer;
end record;

-- Public Functions

function MyPublicFunction (P: HelloWorld)
return String;

procedure MyPublicFunction (P1: in out
HelloWorld; AFlag: Boolean);

private
-- Private Functions
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function MyPrivateFunction (P: HelloWorld)

return String;

procedure MyPrivateFunction (P1: in out

HelloWorld; AFlag: Boolean);

end HelloWorld;

class Testbench

HelloWerld

+ At1: Natural
+ At3: Integer

+ MyPublicFunction{HelloWorld) : String

+ MyPublicFundction{HellcWorld, Boolean) : void

- MyPrivateFunction{HelleWorld) : String
P PP .

wtypedefs
HelloWaorld::Ref

Notes

. Ada 2012 support is available in the Unified and Ultimate

editions of Enterprise Architect
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C Conventions

Enterprise Architect supports round trip engineering of C,
where these conventions are used:

Stereotype

Stereotype Applies To

enumeration | Inner Class
Corresponds To: An enumerated type.

struct Inner Class
Corresponds To: A 'struct' type.

Attribute A keyword struct in variable definition.
typedef Inner Class
Corresponds To: A 'typedef’ statement,

where the parent is the original type
name.

union Inner Class
Corresponds To: A union type.

Attribute A keyword union in variable definition.
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Tagged Values
Tag Applies To
anonymous Class also containing the Tagged Value
typedef

Corresponds To: The name of this Class
being defined only by the typedef
statement.

bitfield Attribute

Corresponds To: The size, in bits,
allowed for storage of this attribute.

bodyLocation Operation

Corresponds To: The location the method
body is generated to; expected values are
header, classDec or classBody.

typedef Class with stereotype other than 'typedef’
Corresponds To: This Class being

defined in a 'typedef’ statement.

typeSynonym = Class
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S Corresponds To: The 'typedef name
and/or fields of this type.

C Code Generation for UML Model

UML C Code
A Class A pair of C files (.h + .c)
Notes: File name is the same as Class
name
Operation Function declaration 1n .h file and
(public & definition in .c file
pTOteCted) Notes:
Operation Function definition in .c file only
(private) Notes:
Operation Function definition in .c file only
(static) Notes: Static functions will only appear

in the .c file regardless of their scope.

Attribute Variable definition in .h file
(public & Notes:
protected)
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Attribute Variable definition in .c file
(private) Notes:

Inner Class (N/A)

(without Notes: This inner Class would be ignored
stereotype)

Capture #define value to be generated in C
code

For example, #define PI 3.14.

Ste Process
p

1  Add an attribute to the Class, with Name = PI and
Initial Value = 3.14.

2 | In the properties panel of the 'Attributes' page,
update the 'Static' and 'Const' fields.

3 | Onthe 'Tagged Values' tab of the 'Attributes' page,
add a tag called 'define' with the value True.

(c) Sparx Systems 2019 Page 238 of 674



User Guide - Software Models 7 August, 2019

Notes

. Separate conventions apply to Object Oriented
programming in C
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Object Oriented Programming In C

In Enterprise Architect, you apply a number of conventions
for Object-Oriented programming in C.

To configure the system to support Object-Oriented
programming using C, you must set the 'Object Oriented
Support' option to True on the 'C Specifications' page of the
'Preferences' dialog.

Stereotypes

Stereotype Applies To

enumeration = Class
Corresponds To: An enumerated type.

struct Class
Corresponds To: A 'struct' type.

Attribute A keyword struct in variable definition.
typedef Class
Corresponds To: A 'typedef' statement,

where the parent 1s the original type
name.
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union Class
Corresponds To: A union type.
Attribute A keyword union in variable definition.
Tagged Values
Tag Applies To
anonymous Class with stereotype of 'enumeration’,
'struct' or 'union'
Corresponds To: The name of this Class
being defined only by the typedef
statement.
bodyLocation Operation
Corresponds To: The location the method
body is generated to; expected values are
'header’, 'classDec' or 'classBody'.
define Attribute
Corresponds To: '#define' statement.
typedef Class with stereotype of 'enumeration’,

(c) Sparx Systems 2019

'struct' or 'union'
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Corresponds To: This Class being
defined in a 'typedef’ statement.

Object-Oriented C Code Generation for UML
Model

The basic 1dea of implementing a UML Class in C code is to
group the data variable (UML attributes) into a structure
type; this structure is defined in a .h file so that it can be
shared by other Classes and by the client that referred to it.

An operation in a UML Class 1s implemented in C code as a
function; the name of the function must be a fully qualified
name that consists of the operation name, as well as the
Class name to indicate that the operation is for that Class.

A delimiter (specified in the 'Namespace Delimiter' option
on the 'C Specifications' page) 1s used to join the Class name
and function (operation) name.

The function in C code must also have a reference parameter
to the Class object - you can modify the 'Reference as
Operation Parameter', 'Reference Parameter Style' and
'Reference Parameter Name' options on the 'C
Specifications' page to support this reference parameter.

Limitations of Object-Oriented Programming

(c) Sparx Systems 2019 Page 242 of 674



User Guide - Software Models 7 August, 2019

inC

. No scope mapping for an attribute: an attribute in a UML
Class 1s mapped to a structure variable in C code, and its
scope (private, protected or public) is ignored

. Currently an inner Class is ignored: if a UML Class is the
inner Class of another UML Class, it 1s ignored when
generating C code

. Initial value 1s ignored: the 1nitial value of an attribute in a
UML Class is ignored in generated C code
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C# Conventions

Enterprise Architect supports the round trip engineering of
C#, where these conventions are used.

Stereotypes

Stereotype

enumeration

event

extension

indexer

partial
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Applies To

Class
Corresponds To: An enumerated type.

Operation
Corresponds To: An event.

Operation

Corresponds To: A Class extension
method, represented in code by a 'this'
parameter in the signature.

Operation
Corresponds To: A property acting as an

index for this Class.

Operation
Corresponds To: The "partial' keyword on
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property

struct

an operation.

Operation

Corresponds To: A property possibly
containing both read and write code.

Class
Corresponds To: A 'struct' type.

Tagged Values

Tag

argumentNa
me

attribute _nam

C

className
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Applies To

Operation with stereotype extension

Corresponds To: The name given to this
parameter.

Operation with stereotype property or
event

Corresponds To: The name of the
variable behind this property or event.

Operation with stereotype extension
Corresponds To: The Class that this
method is being added to.

Page 245 of 674



User Guide - Software Models 7 August, 2019

const

definition

delegate

enumType

expressionBo
dy

extern

fixed
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Attribute
Corresponds To: The const keyword.

Operation with stereotype partial

Corresponds To: Whether this is the
declaration of the method, or the
definition.

Operation
Corresponds To: The 'delegate' keyword.

Operation with stereotype property

Corresponds To: The datatype that the
property 1s represented as.

Operation, Operation with stereotype
property or indexer

Corresponds To: 'True' if the 'Behavior
Code' is from an expression body
function member.

Operation
Corresponds To: The 'extern' keyword.

Attribute
Corresponds To: The 'fixed' keyword.
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generic

genericConst
raints

Implements

ImplementsE
xplicit

initializer

ncw

override
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Operation

Corresponds To: The generic parameters
for this operation.

Templated Class or Interface, Operation
with tag 'generic'

Corresponds To: The constraints on the
generic parameters of this type or
operation.

Operation

Corresponds To: The name of the method
this implements, including the interface
name.

Operation

Corresponds To: The presence of the
source interface name in this method
declaration.

Operation
Corresponds To: A constructor

initialization list.

Class, Interface, Operation
Corresponds To: The 'new' keyword.

Operation
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params

partial

propertylInitia

lizer

readonly

ref

sealed

static

unsafe
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Corresponds To: The 'override' keyword.

Parameter

Corresponds To: A parameter list using
the 'params' keyword.

Class, Interface
Corresponds To: The "partial' keyword.

Operation with stereotype property
Corresponds To: A property initializer.

Operation, <<struct>>Class
Corresponds To: The 'readonly' keyword.

Operation, <<struct>>Class
Corresponds To: The 'ref keyword.

Operation
Corresponds To: The 'sealed' keyword.

Class
Corresponds To: The 'static' keyword.

Class, Interface, Operation
Corresponds To: The 'unsafe' keyword.
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virtual Operation
Corresponds To: The 'virtual' keyword.

writeonly Operation with stereotype property

Corresponds To: This property only
defining 'write' code.

Other Conventions

. Namespaces are generated for each Package below a
namespace root

. The Const property of an attribute corresponds to the
readonly keyword, while the tag const corresponds to the
const keyword

. The value of inout for the Kind property of a parameter
corresponds to the ref keyword

. The value of out for the Kind property of a parameter
corresponds to the out keyword

. Partial Classes can be modeled as two separate Classes
with the partial tag

. The Is Leaf property of a Class corresponds to the sealed
keyword
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C++ Conventions
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Enterprise Architect supports round trip engineering of C++,
including the Managed C++ and C++/CLI extensions, where
these conventions are used.

Stereotypes

Stereotype

enumeration

friend

property get

property set

struct

typedef
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Applies To

Class
Corresponds To

Operation
Corresponds To

Operation
Corresponds To

Operation
Corresponds To

Class
Corresponds To

Class

: An enumerated type.

: The 'friend' keyword.

: A 'read' property.

. A 'write' property.

: A''struct’ type.
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alias

union

Corresponds To: A 'typedef' statement,
where the parent is the original type
name.

Class

Corresponds to an 'Alias' declaration,
where the parent is the original type
name.

Class
Corresponds To: A union type.

Tagged Values

Tag

afx_msg

anonymous
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Applies To

Operation
Corresponds To: The afx msg keyword.

Class also containing the Tagged Value
typedef

Corresponds To: The name of this Class
being only defined by the typedef
statement.
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attribute_nam
e

bitfield

bodyLocation

callback

explicit

mitializer

inline
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Operation with stereotype property get or
property set

Corresponds To: The name of the
variable behind this property.

Attribute

Corresponds To: The size, in bits,
allowed for storage of this attribute.

Operation

Corresponds To: The location the method
body 1s generated to; expected values are
header, classDec or classBody.

Operation

Corresponds To: A reference to the
CALLBACK macro.

Operation
Corresponds To: The 'explicit' keyword.

Operation

Corresponds To: A constructor
initialization list.

Operation

Corresponds To: The inline keyword and
inline generation of the method body.
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mutable Attribute
Corresponds To: The 'mutable' keyword.

scoped Class with stereotype enumeration

Corresponds To: Either the 'class' or
'struct' keyword.

throws Operation
Corresponds To: The exceptions that are
thrown by this method.

typedef Class with stereotype other than 'typedef’

Corresponds To: This Class being
defined 1n a 'typedef’ statement.

typeSynonym = Class
S Corresponds To: The 'typedef name
and/or fields of this type.

volatile Operation
Corresponds To: The 'volatile' keyword.

Other Conventions
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. Namespaces are generated for each Package below a
namespace root

. By Reference attributes correspond to a pointer to the type
specified

. The Transient property of an attribute corresponds to the
volatile keyword

. The Abstract property of an attribute corresponds to the
virtual keyword

. The Const property of an operation corresponds to the
const keyword, specifying a constant return type

. The Is Query property of an operation corresponds to the

const keyword, specifying the method doesn't modify any
fields

. The Pure property of an operation corresponds to a pure
virtual method using the "= 0" syntax

. The Fixed property of a parameter corresponds to the
const keyword
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Managed C++ Conventions

These conventions are used for managed extensions to C++
prior to C++/CLI. In order to set the system to generate
managed C++ you must modify the C++ version in the C++
Options.

Stereotypes

Stereotype Applies To

property Operation
Corresponds To: The' property’
keyword.

property get | Operation

Corresponds To: The' property'
keyword and a read property.

property set Operation
Corresponds To: The' property’

keyword and a 'write' property.

reference Class
Corresponds To: The' gc' keyword.
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value Class
Corresponds To: The' value' keyword.

Tagged Values

Tag Applies To

managedTyp @ Class with stereotype reference, value or
e enumeration; Interface

Corresponds To: The keyword used in
declaration of this type; expected values
are 'class' or 'struct'.

Other Conventions

. The typedef and anonymous tags from native C++ are not
supported

. The Pure property of an operation corresponds to the
keyword  abstract
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C++/CLI Conventions

These conventions are used for modeling C++/CLI
extensions to C++. In order to set the system to generate
managed C++/CLI you must modify the C++ version in the

C++ Options.

Stereotypes

Stereotype

event

property

reference

value
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Applies To

Operation

Description: Defines an event to provide
access to the event handler for this Class.

Operation, Attribute
Description: This 1s a property possibly
containing both read and write code.

Class

Description: Corresponds to the 'ref class'
or 'ref struct' keyword.

Class

Description: Corresponds to the 'value
class' or 'value struct' keyword.
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Tagged Values

Tag Applies To

attribute_ nam = Operation with stereotype property or
e event

Description: The name of the variable
behind this property or event.

generic Operation

Description: Defines the generic
parameters for this Operation.

genericConst = Templated Class or Interface, Operation
raints with tag generic

Description: Defines the constraints on
the generic parameters for this Operation.

initonly Attribute
Description: Corresponds to the 'initonly’
keyword.

literal Attribute

Description: Corresponds to the literal
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keyword.

managedTyp @ Class with stereotype reference, value or
e enumeration; Interface

Description: Corresponds to either the
'class' or 'struct' keyword.

Other Conventions

. The typedef and anonymous tags are not used
. The property get/property set stereotypes are not used

. The Pure property of an operation corresponds to the
keyword abstract
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Enterprise Architect supports round trip engineering of
Delphi, where these conventions are used:

Stereotypes

Stereotype

constructor

destructor

dispinterface

enumeration

metaclass

object
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Applies To

Operation
Corresponds To

Operation
Corresponds To

Class, Interface
Corresponds To

Class
Corresponds To

Class
Corresponds To

Class
Corresponds To

- A constructor.

. A destructor.

: A dispatch interface.

: An enumerated type.

: A metaclass type.

: An object type.
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operator

property get

property set

struct

Operation
Corresponds To: An operator.

Operation
Corresponds To: A 'read' property.

Operation
Corresponds To: A 'write' property.

Class
Corresponds To: A record type.

Tagged Values

Tag

attribute nam
e

overload
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Applies To

Operation with stereotype property get or
property set

Corresponds To: The name of the
variable behind this property.

Operation
Corresponds To: The 'overload' keyword.
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override Operation
Corresponds To: The 'override' keyword.

packed Class
Corresponds To: The "packed' keyword.

property Class

Corresponds To: A property; see Delphi
Properties for more information.

reintroduce Operation

Corresponds To: The 'reintroduce’
keyword.

Other Conventions

. The Static property of an attribute or operation
corresponds to the 'class' keyword

. The Fixed property of a parameter corresponds to the
'const' keyword

. The value of inout for the Kind property of a parameter
corresponds to the 'Var' keyword

. The value of out for the Kind property of a parameter
corresponds to the 'Ou't keyword
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Java Conventions

Enterprise Architect supports round trip engineering of Java
- including Aspect] extensions - where these conventions
are used.

Stereotypes

Stereotype Applies To

annotation Interface
Corresponds To: An annotation type.

default Operation
Corresponds To: The 'default' keyword.

enum Attributes within a Class stereotyped
enumeration

Corresponds To: An enumerated option,
distinguished from other attributes that
have no stereotype.

enumeration = Class
Corresponds To: An enumerated type.

operator Operation
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Corresponds To: An operator.

property get Operation
Corresponds To: A 'read' property.

property set Operation
Corresponds To: A 'write' property.

static Class or Interface
Corresponds To: The 'static' keyword.

Tagged Values

Tag Applies To

annotations Anything

Corresponds To: The annotations on the
current code feature.

arguments Attribute with stereotype enum

Corresponds To: The arguments that
apply to this enumerated value.

attribute nam = Operation with stereotype property get or
e property set
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Corresponds To: The name of the
variable behind this property.

dynamic Class or Interface
Corresponds To: The 'dynamic' keyword.

generic Operation

Corresponds To: The generic parameters
to this operation.

parameterList Parameter
Corresponds To: A parameter list with

the ... syntax.

throws Operation
Corresponds To: The exceptions that are
thrown by this method.

transient Attribute

Corresponds To: The 'transient' keyword.

Other Conventions

. Package statements are generated when the current
Package 1s not a namespace root
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. The Const property of an attribute or operation
corresponds to the final keyword

. The Transient property of an attribute corresponds to the
volatile keyword

. The Fixed property of a parameter corresponds to the final
keyword
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Aspect) Conventions

These are the conventions used for supporting Aspect]
extensions to Java.

Stereotypes

Stereotype Applies To

advice Operation
Corresponds To: A piece of advice in an
Aspectl] aspect.

aspect Class

Corresponds To: An Aspect] aspect.

pointcut Operation
Corresponds To: A "pointcut' in an
Aspectl] aspect.
Tagged Values
Tag Applies To
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className Attribute or operation within a Class
stereotyped aspect

Corresponds To: The Classes this
Aspectl] intertype member belongs to.

Other Conventions

. The specifications of a pointcut are included in the
'Behavior' field of the method
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PHP Conventions

Enterprise Architect supports the round trip engineering of
PHP 4 and 5, where these conventions are used.

Stereotypes

Stereotype Applies To

trait Class
Corresponds To: A 'trait'.

property get | Operation
Corresponds To: A 'read' property.

property set Operation
Corresponds To: A 'write' property.

Tagged Values

Tag Applies To

attribute_ nam Operation with stereotype property get or
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e property set
Corresponds To: The name of the
variable behind this property.

final Operations in PHP 5
Corresponds To: The 'final' keyword.

Common Conventions

. An unspecified type is modeled as var

. Methods returning a reference are generated by setting the
Return Type to var*

. Reference parameters are generated from parameters with
the parameter Kind set to inout or out

PHP 5 Conventions

. The final Class modifier corresponds to the Is Leaf
property

. The abstract Class modifier corresponds to the Abstract
property

. Parameter type hinting is supported by setting the Type of
a parameter
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. The value of inout or out for the Kind property of a
parameter corresponds to a reference parameter
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Python Conventions

Enterprise Architect supports the round trip engineering of
Python, where these conventions are used.

Tagged Values
Tag Applies To
Decorators Class, Operation

Corresponds To: The decorators applied
to this element 1n the source.

Other Conventions

. Model members with Private Scope correspond to code
members with two leading underscores

. Attributes are only generated when the Initial value is not
empty
. All types are reverse engineered as var
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Enterprise Architect supports round-trip engineering of
SystemC, where these conventions are used.

Stereotypes

Stereotype

delegate

enumeration

friend

property

sc_ctor

sc_module

(c) Sparx Systems 2019

Applies To

Method
Corresponds To

Inner Class
Corresponds To

Method
Corresponds To

Method
Corresponds To

Method
Corresponds To

Class
Corresponds To

. A delegate.

: An enum type.

: A friend method.

: A property definition.

: A SystemC constructor.

: A SystemC module.
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sc_port Attribute
Corresponds To: A port.
sc_signal Attribute
Corresponds To: A signal.
struct Inner Class
Corresponds To: A struct or union.
Tagged Values
Tag Applies To
kind Attribute (Port)
Corresponds To: Port kind (clocked, fifo,
master, slave, resolved, vector).
mode Attribute (Port)
Corresponds To: Port mode (in, out,
inout).
overrides Method

(c) Sparx Systems 2019

Corresponds To: The Inheritance list of a
method declaration.
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throw Method

Corresponds To: The exception
specification of a method.

Other Conventions

. SystemC also inherits most of the stereotypes and Tagged
Values of C++

SystemC Toolbox Pages

To model a SystemC design, drag these icons onto a
diagram from the 'SystemC Constructs' page of the Diagram
Toolbox.

Page Icon

SystemC Module
Action: Defines a SystemC Module.
An sc_module -stereotyped Class

clement.
SystemC Port
Features Action: Defines a SystemC Port.
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An sc_port- stereotyped attribute.

Access

Ribbon Design > Diagram > Toolbox : /£ >
Specify 'SystemC Constructs' in the 'Find
Toolbox Item' dialogs

Keyboard Ctrl+Shift+3 : &2 > Specify 'SystemC

Shortcuts Constructs' in the 'Find Toolbox Item'
dialog
Other You can display or hide the Diagram

Toolbox by clicking on the »/ or «l1cons
at the left-hand end of the Caption Bar at
the top of the Diagram View.
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VB.NET Conventions

Enterprise Architect supports round-trip engineering of
Visual Basic.NET, where these conventions are used.
Earlier versions of Visual Basic are supported as a different

language.

Stereotypes

Stereotype

event

import

module

operator

partial
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Applies To

Operation
Corresponds To: An event declaration.

Operation

Corresponds To: An operation to be
imported from another library.

Class
Corresponds To: A module.

Operation
Corresponds To: An operator overload

definition.

Operation
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property

Corresponds To: The "partial' keyword on
an operation.

Operation

Corresponds To: A property possibly
containing both read and write code.

Tagged Values

Tag

Alias

attribute_nam
e

Charset

delegate
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Applies To

Operation with stereotype import

Corresponds To: The alias for this
imported operation.

Operation with stereotype property

Corresponds To: The name of the
variable behind this property.

Operation with stereotype import
Corresponds To: The character set clause

for this import - one of the values 'Anst’,
'Unicode’ or 'Auto’.

Operation
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enumTag

Handles

Implements

Lib

MustOverrid
C

Narrowing

NotOverridea
ble
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Corresponds To: The 'delegate’ keyword.

Operation with stereotype property

Corresponds To: The datatype that this
property is represented as.

Operation

Corresponds To: The 'handles' clause on
this operation.

Operation

Corresponds To: The 'implements' clause
on this operation.

Operation with stereotype import

Corresponds To: The library this import
comes from.

Operation

Corresponds To: The 'MustOverride'
keyword.

Operation with stereotype operator

Corresponds To: The 'Narrowing'
keyword.

Operation
Corresponds To: The 'NotOverrideable'
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keyword.

Overloads Operation
Corresponds To: The 'overloads'
keyword.

Overrides Operation

Corresponds To: The 'overrides' keyword.

parameterArr = Parameter

ay Corresponds To: A parameter list using
the 'ParamArray' keyword.

partial Class, Interface
Corresponds To: The 'partial' keyword.

readonly Operation with stereotype property
Corresponds To: This property only

defining 'read' code.

shadows Class, Interface, Operation
Corresponds To: The 'Shadows' keyword.

Shared Attribute
Corresponds To: The 'Shared' keyword.

Widening Operation with stereotype operator
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Corresponds To: The "Widening'
keyword.

writeonly Operation with stereotype property

Corresponds To: This property only
defining 'write' code.

Other Conventions

. Namespaces are generated for each Package below a
namespace root

. The Is Leaf property of a Class corresponds to the
NotInheritable keyword

. The Abstract property of a Class corresponds to the
MustInherit keyword

. The Static property of an attribute or operation
corresponds to the Shared keyword

. The Abstract property of an operation corresponds to the
MustOverride keyword

. The value of in for the Kind property of a parameter
corresponds to the ByVal keyword

. The value of 1nout or out for the Kind property of a
parameter corresponds to the ByRef keyword
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Verilog Conventions

Enterprise Architect supports round-trip engineering of
Verilog, where these conventions are used.

Stereotypes

Stereotype Applies To

asynchronous = Method
Corresponds To: A concurrent process.

enumeration | Inner Class
Corresponds To: An enum type.

initializer Method

Corresponds To: An initializer process.

module Class
Corresponds To: A module.

part Attribute
Corresponds To: A component
instantiation.

port Attribute
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Corresponds To: A port.

synchronous = Method
Corresponds To: A sequential process.

Tagged Values
Tag Applies To
kind Attribute (signal)

Corresponds To: The signal kind (such as
register, bus).

mode Attribute (port)
Corresponds To: The port mode (in, out,
mout).

Portmap Attribute (part)

Corresponds To: The generic / port map
of the component instantiated.

sensitivity Method

Corresponds To: The sensitivity list of a
sequential process.
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type Attribute

Corresponds To: The range or type value
of an attribute.

Verilog Toolbox Pages

Access: 'Design > Diagram > Toolbox : 'Hamburger' icon >
HDL | Verilog Constructs'

Drag these icons onto a diagram to model a Verilog design.

Item Action

Module Defines a Verilog Module. A
module-stereotyped Class element.

Enumeration = Defines an Enumerated Type. An
enumeration element.

Port Defines a Verilog Port. A
port-stereotyped attribute.

Part Defines a Verilog component
instantiation. A part-stereotyped attribute.

Attribute Defines an attribute.
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Procedure Defines a Verilog process:

. Concurrent - An
asynchronous-stereotyped method

. Sequential - A
synchronous-stereotyped method

. Initializer - An initializer-stereotyped
method
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VHDL Conventions

Enterprise Architect supports round-trip engineering of
VHDL, where these conventions are used.

Stereotypes

Stereotype Applies To

architecture Class
Corresponds To: An architecture.

asynchronous = Method

Corresponds To: An asynchronous
process.

configuration = Method
Corresponds To: A configuration.

enumeration | Inner Class
Corresponds To: An enumerated type.

entity Interface
Corresponds To: An entity.

part Attribute
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Corresponds To: A component
instantiation.

port Attribute
Corresponds To: A port.

signal Attribute
Corresponds To: A signal declaration.

struct Inner Class
Corresponds To: A record definition.

synchronous = Method
Corresponds To: A synchronous process.

typedef Inner Class
Corresponds To: A type or subtype
definition.
Tagged Values
Tag Applies To
isGeneric Attribute (port)

Corresponds To: The 'port' declaration in
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1sSubType

kind

mode

portmap

sensitivity

type

typeNameSp
ace
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a generic interface.

Inner Class (typedef)
Corresponds To: A subtype definition.

Attribute (signal)

Corresponds To: The signal kind (such as
'register’, 'bus").

Attribute (port)

Corresponds To: The port mode ('in',
'out’, 'inout’, 'buffer’, 'linkage').

Attribute (part)

Corresponds To: The generic / port map
of the component instantiated.

Method (synchronous)

Corresponds To: The 'sensitivity' list of a
synchronous process.

Inner Class (typedef)

Corresponds To: The 'type' indication of a
'type' declaration.

Attribute (part)

Corresponds To: The 'type' namespace of
the instantiated component.
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VHDL Toolbox Pages

Access

To model a VHDL design, drag icons from the VHDL
toolbox pages and drop them on your diagram.

Ribbon Design > Diagram > Toolbox : £ >

Specify '"VHDL Constructs' in the 'Find
Toolbox Item' dialog

Keyboard Ctrl+Shift+3 : 2 > Specify "VHDL

Shortcuts Constructs' in the 'Find Toolbox Item'
dialog
Other You can display or hide the Diagram

Toolbox by clicking on the »l or «licons
at the left-hand end of the Caption Bar at
the top of the Diagram View.
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VHDL Toolbox Page
Item Action
Architecture = Defines an architecture to be associated

Entity

Enumeration

Struct

Typedef

with a VHDL entity.

An architecture-stereotyped Class
clement.

Defines a VHDL entity to contain the
Port definitions.

An entity-stereotyped interface element.

Defines an Enumerated Type.
An Enumeration element.

Defines a VHDL record.
A struct-stereotyped Class element.

Defines a VHDL type or subtype.
A typedef-stereotyped Class element.

VHDL Features Toolbox Page
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Item Action
Part Defines a VHDL component
Instantiation.

A part-stereotyped attribute.

Port Defines a VHDL Port.
A port-stereotyped attribute.

Signal Defines a VHDL signal.
A signal-stereotyped attribute.

Procedure Defines a VHDL process:

. Concurrent - An
asynchronous-stereotyped method

Sequential - A
synchronous-stereotyped method

. Configuration - An
configuration-stereotyped method
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Visual Basic Conventions

Enterprise Architect supports the round trip engineering of
Visual Basic 5 and 6, where these conventions are used.

Visual Basic .NET is supported as a different language.

Stereotypes

Stereotype

global

import

property get

property set

property let

(c) Sparx Systems 2019

Applies To

Attribute
Corresponds To: The 'Global' keyword.

Operation
Corresponds To: An operation to be

imported from another library.

Operation
Corresponds To: A property 'get'.

Operation
Corresponds To: A property 'set'.

Operation
Corresponds To: A property 'let'.
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with events

Attribute

Corresponds To: The "WithEvents'
keyword.

Tagged Values
Tag Applies To
Alias Operation with stereotype import

attribute_nam
e

Lib

New
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Corresponds To: The alias for this
imported operation.

Operation with stereotype property get,
property set or property let

Corresponds To: The name of the
variable behind this property.

Operation with stereotype import

Corresponds To: The library this import
comes from.

Attribute
Corresponds To: The new' keyword.

Page 294 of 674



User Guide - Software Models 7 August, 2019

Other Conventions

. The value of 1n for the Kind property of a parameter
corresponds to the ByVal keyword

. The value of inout or out for the Kind property of a
parameter corresponds to the ByRef keyword
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Language Options

You can set up various options for how Enterprise Architect
handles a particular language when generating and
reverse-engineering code. These options are either specific
to:

. Your user ID, for all models or

. The model in which they are defined, for all users

Access

Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
<language name>

Configure > Model > Options > Source
Code Engineering > <language name>

Keyboard Ctrl+F9 ('Preferences' dialog)
Shortcuts

Languages Supported

Language
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Action Script

Ada 2012 (in the Unified and Ultimate editions of
Enterprise Architect)

ArcGIS

ANSI C

C#

C++

Delphi

Java

PHP

Python

SystemC

Verilog (Unified and Ultimate editions)

VHDL (Unified and Ultimate editions)
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Visual Basic

Visual Basic .NET
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ActionScript Options - User

If you intend to generate ActionScript code from your
model, you can configure the code generation options using
the 'ActionScript Specifications' page of the 'Preferences'
dialog to:

. Specify the default source directory

. Specify the editor for ActionScript code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
ActionScript

Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
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Language support ActionScript code generation.

Select this checkbox to disable
ActionScript code support.

Options for In the 'Default Source Directory' and

the current '"Editor' fields, click on the [-] button and

user browse for the source directory and
external file editor that you will use.

Notes

. These options apply to all models that you access

(c) Sparx Systems 2019 Page 300 of 674



User Guide - Software Models 7 August, 2019

ActionScript Options - Model

If you intend to generate ActionScript code from your
model, you can configure the model-specific code
generation options using the 'ActionScript Specifications'
page of the 'Manage Project Options' dialog to:

. Specify default ActionScript version to generate (AS2.0
or AS3.0)

. Specify default file extensions

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > ActionScript
Options
Option Action

Options for Type in the default ActionScript version
the current and default file extension to apply when

(c) Sparx Systems 2019 Page 301 of 674



User Guide - Software Models 7 August, 2019

model generating ActionScript source code.

Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Ada 2012 Options - User

If you intend to generate Ada 2012 code from your model,
you can configure the code generation options using the
'Ada’ page of the 'Preferences' dialog to:

. Inform the reverse engineering process whether the name
of the Tagged Record is the same as the Package name

. Advise the engine of the alternate Tagged Record name to
locate

. Specify whether the engine should create a reference type
for the Tagged Record (if one 1s not defined)

. Supply the name of the reference type to be created
(default 1s Ref)

. Specify the reference parameter of a Reference / Access
type

. Tell the engine to ignore the name of the reference
parameter

. Indicate the name of the reference parameter to locate

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Ada
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Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
Language support Ada 2012 code generation.
Select this checkbox to disable Ada 2012
code support.
Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
Notes

. Ada 2012 support is available in the Unified and Ultimate
editions of Enterprise Architect
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Ada 2012 Options - Model

If you intend to generate Ada 2012 code from your model,
you can configure the model-specific code generation
options using the 'Ada' page of the 'Manage Project Options'
dialog to:

. Specify the default file extension and

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > Ada
Options
Option Action
Options for Type in the default file extension to apply
the current when generating Ada source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models

. Ada 2012 support is available in the Unified and Ultimate
editions of Enterprise Architect
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ArcGIS Options - User

If you intend to generate ArcGIS code from your model,
you can configure the code generation options using the
'ArcGIS' page of the 'Preferences' dialog to:

. Specify default source directory
. Specify the editor for ArcGIS code

ArcGIS must be enabled in the 'MDG Technologies' dialog
('Specialize > Technologies > Manage') in order for the
'ArcGIS' page to be available.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
ArcGIS

Keyboard Ctrl+F9
Shortcuts

Options

Option Action
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Disable Leave this checkbox unselected to
Language support ArcGIS code generation.

Select this checkbox to disable ArcGIS
code support.

Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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ArcGIS Options - Model

If you intend to generate ArcGIS code from your model,
you can configure the model-specific code generation
options using the 'ArcGIS' page of the 'Manage Project
Options' dialog to:

. Specify default file extensions

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > ArcGIS
Options
Option Action

Options for Type in the default file extension to apply
the current when generating ArcGIS source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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C Options - User

If you intend to generate C code from your model, you can
configure the code generation options using the 'C
Specifications' page of the 'Preferences' dialog.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
C

Keyboard Ctrl+F9

Shortcuts

Options

Option Action
Disable Leave this checkbox unselected to
Language support C code generation.

Select this option to disable C code
support.
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Options for In the value fields, specify the options
the current that apply under your own user ID in all
user models that you access:

. The default attribute type to create
(fixed as int)

. Whether a #define constant is imported
as an attribute in imported C code (if
'Object Oriented programming' 1s set to
True on the 'C Specifications' page of
the 'Manage Project Options' dialog)

. Whether to generate comments for C
methods to the declaration, and to
reverse engineer comments from the
declaration

. Whether to generate comments for C
methods to the implementation, and to
reverse engineer comments from the
implementation

. Whether to update comments in
regenerating code from the model

. Whether to update the implementation
file in re-generating code from the
model

. The default source code directory
location (click on the [ | button)

. The default file extensions to read
when importing a directory of C code
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. The Code Editor to use (click on the [
button)

. The search path for the implementation
file relative to the header file path
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C Options - Model

If you intend to generate C code from your model, you can
configure the model-specific code generation options using
the 'C Specifications' page of the 'Manage Project Options'

dialog to:

. Specify default file extensions (header and source)
. Define support for Object Oriented programming
. Set the StateMachine engineering options

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > C
Options
Option Action

Options for In the value fields, specify these options:
the current

(c) Sparx Systems 2019 Page 314 of 674



User Guide - Software Models 7 August, 2019

model

StateMachine
Engineering

(c) Sparx Systems 2019

. The default header and source file
extensions for the code files

Support for Object Oriented
programming; if this is True, then set:

- The Namespace delimiter
character

- Whether the first parameter of an
operation is a Class reference

- The parameter reference style in
generated C code

- The reference parameter name in
generated code

- The default Constructor name in
generated code

- The default Destructor name in
generated code

In the value fields, use the drop-down
arrows to set the options to True or False;
these options apply to generating code
from StateMachine models in the current
model only:

. 'Use the new StateMachine Template' -
set to True to use the code generation
templates from Enterprise Architect
Release 11 and later, set to False to
apply the EASL Legacy templates

. Generate Trace Code - set to True to
generate Trace code, False to omit it
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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C# Options - User

If you intend to generate C# code from your model, you can
configure the code generation options using the 'C#
Specifications' page of the 'Preferences' dialog

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
C#

Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
Language support C# code generation.
Select this checkbox to disable C# code
support.
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Options for In the value fields, specify the options
the current that apply under your own user ID in all
user models that you access:

. The default attribute type to create

. Whether Namespaces should be
generated when generating C# Classes

. Whether to remove new lines (hard
carriage returns) from the summary tag
when importing XML.NET style
comments

. Whether to generate a Finalizer method
when generating code for a C# Class

. Whether to generate a Dispose method
when generating code for a C# Class

. The default source code directory
location (click on the [-] button)

. The Code Editor to use (click on the [
button)
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C# Options - Model

If you intend to generate C# code from your model, you can
configure the model-specific code generation options using

the 'C# Specifications' page of the 'Manage Project Options'
dialog to:

. Specify the default file extension

. Indicate additional Collection Classes - to define custom
Collection Classes, which can be simple substitutions
(such as CArray<#TYPE#>) or a mix of other strings and
substitutions (such as
Cmap<CString, LPCTSTR, #TYPE#* #TYPE#*>); these
Collection Classes are defined by default:

- List<#TYPE#>;Stack<#TYPE#>;Queue<#TYPE#>;

. Set the StateMachine Engineering options

. Specify the Collection Class definitions for Association
connectors

Access

Ribbon Configure > Model > Options > Source
Code Engineering > C#
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Options

Option Action
Options for Type in the default file extension to apply
the current when generating C# source code, and a
model list of any additional Collection Classes

you want to define.

StateMachine @ In the value fields, use the drop-down

Engineering | arrows to set the options to True or False;
these options apply to generating code
from StateMachine models in the current
model only:

. 'Use the new StateMachine Template' -
set to True to use the code generation
templates from Enterprise Architect
Release 11 and later, set to False to
apply the EASL Legacy templates

. 'Generate Trace Code' - set to True to
generate Trace code, False to omit it

Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.
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Notes

. These options affect all users of the current model;
however, they do not apply to other models
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C++ Options - User

If you intend to generate C++ code from your model, you
can configure the code generation options using the 'C++
Specifications' page of the 'Preferences' dialog.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
C++

Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
Language support C++ code generation.
Select this option to disable C++ code
support.
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Options for In the value fields, specify the options
the current that apply under your own user ID in all
user models that you access:

. The default attribute type to create

. Whether Namespaces should be
generated when generating C++
Classes

. What style to apply when generating
and processing comments for C++

. Whether to generate comments for C++
methods to the declaration, or reverse
engineer comments from the
declaration

. Whether to generate comments for C++
methods to the implementation, or
reverse engineer comments from the
implementation

. Whether to update comments in
re-generating code from the model

. Whether to update the implementation
file in re-generating code from the
model

. The default source code directory
location (click on the [-] button)

. The default file extensions to read
when importing a directory of C++
code
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. The Code Editor to use (click on the [
button)

. The search path for the implementation
file relative to the header file path
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C++ Options - Model

If you intend to generate C++ code from your model, you

can configure the model-specific code generation options

using the 'C++ Specifications' page of the '"Manage Project

Options' dialog to:

. Indicate the version of C++ to generate; this controls the
set of templates used and how properties are created

. Specify the default reference type used when a type is
specified by reference

. Specify the default file extensions
. Specify default Get/Set prefixes

. Specify the Collection Class definitions for Association
connectors

. Define additional Collection Classes - to define custom
Collection Classes, which can be simple substitutions
(such as CArray<#TYPE#>) or a mix of other strings and
substitutions (such as
Cmap<CString, LPCTSTR #TYPE#* #TYPE#*>); these
Collection Classes are defined by default:

CArray<#TYPE#>;CMap<CString, LPCTSTR #TYPE#*,
#TYPE#*>;

. Set the StateMachine Engineering options

Access
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Ribbon Configure > Model > Options > Source
Code Engineering > C++

Options

Option Action

Options for In the value fields, specify the options
the current that affect all users of the current model:

model . The version of C++ you are using
(which determines which templates to
use when generating code)

. The default reference type to use when
creating properties for C++ attributes
by reference

. The default header and source file
extensions for the code files

. The default 'Get' prefix
. The default 'Set' prefix
. The additional Collection Classes

StateMachine In the value fields, use the drop-down
Engineering | arrows to set the options to True or False;
Options these options apply to generating code
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from StateMachine models in the current
model only:

. 'Use the new StateMachine Template' -
set to True to use the code generation
templates from Enterprise Architect
Release 11 and later, set to False to
apply the EASL Legacy templates

. 'Generate Trace Code' - set to True to
generate Trace code, False to omit it

Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Delphi Options - User

If you intend to generate Delphi code from your model, you
can configure the code generation options using the 'Delphi
Specifications' page of the 'Preferences' dialog to:

. Set the default attribute type
. Indicate a default source directory

. Set the default code editor to use to edit Delphi source
code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Delphi
Keyboard Ctrl+F9
Shortcuts
Options
Option Action
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Disable Leave this checkbox unselected to
Language support Delphi code generation.
Select this option to disable Delphi code
support.
Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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Delphi Options - Model

If you intend to generate Delphi code from your model, you
can configure the model-specific code generation options
using the 'Delphi Specifications' page of the '"Manage Project
Options' dialog to:

. Specify default file extensions (header and source)

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > Delphi
Options
Option Action

Options for Type in the default file extension to apply
the current when generating Delphi source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Delphi Properties

Enterprise Architect has comprehensive support for Delphi
properties. These are implemented as Tagged Values, with a
specialized property editor to help create and modify Class
properties. By using the 'Feature Visibility' element context
menu option, you can display the 'tags' compartment that
contains the properties. Imported Delphi Classes with
properties have this feature automatically made visible for
your convenience.

Manually activate the property editor

. In the selected Class set the code generation language to
'Delpht’

. Right-click on the Class and select 'Delphi Properties' to
open the editor

Using the Delphi Properties editor, you can build properties
quickly and simply; from here you can:

. Change the name and scope (only Public and Published
are currently supported)

. Change the property type (the drop-down list includes all
defined Classes in the project)

. Set the Read and Write information (the drop-down lists
have all the attributes and operations from the current
Class; you can also enter free text)

. Set 'Stored' to True or False
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. Set the Implements information
. Set the default value, 1f one exists

Notes

. When you use the 'Create Property' dialog from the
'Attribute’ screen, the system generates a pair of Get and
Set functions together with the required property
definition as Tagged Values; you can manually edit these
Tagged Values if required

. Public properties are displayed with a '+' symbol prefix
and published with a '

. When creating a property in the 'Create Property
Implementation' dialog (accessed through the 'Attributes'
dialog), you can set the scope to 'Published' if the property
type is Delphi

. Only 'Public' and 'Published' are supported

. If you change the name of a property and forward
engineer, a new property is added, but you must manually
delete the old one from the source file
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Java Options - User

If you intend to generate Java code from your model, you
can configure the code generation options using the 'Java
Specifications' page of the 'Preferences' dialog.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Java

Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
Language support Java code generation.
Select this checkbox to disable Java code
support.
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Options for In the value fields, specify the options
the current that apply under your own user ID in all
user models that you access; the:

. Default attribute type to create (select
from the drop-down list)

. Default source code directory location
(click on the [-] button)

. Code Editor to use (click on the [-]
button)
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Java Options - Model

If you intend to generate Java code from your model, you
can configure the model-specific code generation options
using the 'Java Specifications' page of the 'Manage Project
Options' dialog to:

. Specify the default file extension

. Specify a default 'Get' prefix

. Specify a default 'Set' prefix

. Set the StateMachine Engineering options

. Specify the Collection Class definitions for Association
connectors

. Define additional Collection Classes - to define custom
Collection Classes, which can be simple substitutions
(such as CArray<#TYPE#>) or a mix of other strings and
substitutions (such as
Cmap<CString, LPCTSTR #TYPE#* #TYPE#*>); these
Collection Classes are defined by default:

- HashSet<#TYPE#>;Map<String, #TYPE#>;

Access

Ribbon Configure > Model > Options > Source
Code Engineering > Java
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Options

Option Action

Options for In the value fields, specify the options
the current that affect all users of the current model;
model the:

. Default file extension for the code files
. The default Get and Set prefixes

. The default and additional Collection
Classes

StateMachine @ In the value fields, use the drop-down

Engineering | arrows to set the options to True or False;
these options apply to generating code
from StateMachine models in the current
model only:

. 'Use the new StateMachine Template' -
set to True to use the code generation
templates from Enterprise Architect
Release 11 and later, set to False to
apply the EASL Legacy templates

. 'Generate Trace Code' - set to True to
generate Trace code, False to omit it

Collection Click on this button to open the
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Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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PHP Options - User

If you intend to generate PHP code from your model, you
can configure the code generation options using the 'PHP
Specifications' page of the 'Preferences' dialog to:

. Define a semi-colon separated list of extensions to look at
when doing a directory code import for PHP

. Set a default directory for opening and saving PHP source
code

. Specify the default editor to use when editing PHP code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
PHP

Keyboard Ctrl+F9 | Source Code Engineering | PHP
Shortcuts

Options

Option Action
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Disable Leave this checkbox unselected to
Language support PHP code generation.
Select this option to disable PHP code
support.
Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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PHP Options - Model

If you intend to generate PHP code from your model, you
can configure the model-specific code generation options
using the 'PHP Specifications' page of the '"Manage Project
Options' dialog to:

. Specify the default PHP version to generate

. Define the default file extension

. Specify a default 'Get' prefix

. Specify a default 'Set' prefix

Access
Ribbon Configure > Model > Options > Source
Code Engineering > PHP
Options
Option Action

Options for Type in the default PHP version, the
the current default file extension to apply when
generating PHP source code, and the
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model default 'Get' and 'Set' prefixes.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Python Options - User

If you intend to generate Python code from your model, you
can configure the code generation options using the 'Python
Specifications' page of the 'Preferences' dialog to:

. Specify the default source directory to be used

. Specify the default editor used to write and edit Python
code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Python

Keyboard Ctrl+F9

Shortcuts
Options
Option Action
Disable Leave this checkbox unselected to
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Language support Python code generation.
Select this option to disable Python code
support.
Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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Python Options - Model

If you intend to generate Python code from your model, you
can configure the model-specific code generation options
using the 'Python Specifications' page of the 'Manage
Project Options' dialog to:

. Specify the default file extension

Access

Ribbon Configure > Model > Options > Source
Code Engineering > Python

Options

Option Action
Options for Type 1n the default file extension to apply
the current when generating Python source code.
model
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Notes

. These options affect all users of the current model;
however, they do not apply to other models
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SystemC Options - User

If you intend to generate SystemC code from your model,
you can configure the code generation options using the
'SystemC' page of the 'Preferences' dialog to:

. Specify a default source directory
. Specify an editor for changing code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
SystemC

Keyboard Ctrl+F9

Shortcuts

Options

Option Action
Disable Leave this checkbox unselected to
Language support SystemC code generation.
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Select this option to disable SystemC
code support.

Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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SystemC Options - Model

If you intend to generate SystemC code from your model,
you can configure the model-specific code generation
options using the 'SystemC' page of the 'Manage Project
Options' dialog to:

. Specify the default file extension

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > SystemC
Options
Option Action

Options for Type in the default file extension to apply
the current when generating SystemC source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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VB.NET Options - User

If you intend to generate VB.NET code from your model,
you can configure the code generation options using the
'VB.NET Specifications' page of the 'Preferences' dialog to:

. Specify the default attribute type

. Indicate whether to generate namespaces
. Specify a default source directory

. Specify an editor for changing code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
VB.Net

Keyboard Ctrl+F9
Shortcuts

Options
Option Action
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Disable Leave this checkbox unselected to

Language support VB.NET code generation.
Select this option to disable VB.NET
code support.

Options for Specifies the options used for the current
the current user; these options apply to all models
user that are accessed by the user.
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VB.NET Options - Model

If you intend to generate VB.NET code from your model,
you can configure the model-specific code generation
options using the "VB.Net Specifications' page of the
'Manage Project Options' dialog to:

. Specify the default file extension

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > VB.Net
Options
Option Action

Options for Type in the default file extension to apply
the current when generating VB.Net source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Verilog Options - User

If you intend to generate Verilog code from your model, you
can configure the code generation options using the 'Verilog'
page of the 'Preferences' dialog to:

. Specify a default source directory
. Specify an editor for changing code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Verilog

Keyboard Ctrl+F9

Shortcuts

Options

Option Action
Disable Leave this checkbox unselected to
Language support Verilog code generation.
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Select this option to disable Verilog code
support.

Options for Specifies the options used for the current

the current user; these options apply to all models
user that are accessed by the user.
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Verilog Options - Model

If you intend to generate Verilog code from your model, you
can configure the model-specific code generation options
using the 'Verilog' page of the 'Manage Project Options'
dialog to:

. Specify the default file extension

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > Verilog
Options
Option Action

Options for Type in the default file extension to apply
the current when generating Verilog source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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VHDL Options - User

If you intend to generate VHDL code from your model, you
can configure the code generation options using the "VHDL'
page of the 'Preferences' dialog to:

. Specify a default source directory
. Specify an editor for changing code

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
VHDL

Keyboard Ctrl+F9

Shortcuts

Options

Option Action
Disable Leave this checkbox unselected to
Language support VHDL code generation.
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Select this option to disable VHDL code
support.

Options for Specifies the options used for the current

the current user; these options apply to all models
user that are accessed by the user.
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VHDL Options - Model

If you intend to generate VHDL code from your model, you
can configure the model-specific code generation options
using the "VHDL' page of the 'Manage Project Options'
dialog to:

. Specify the default file extension

. Specify the Collection Class definitions for Association
connectors

Access
Ribbon Configure > Model > Options > Source
Code Engineering > VHDL
Options
Option Action

Options for Type in the default file extension to apply
the current when generating VHDL source code.
model
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Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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Visual Basic Options - User

If you intend to generate Visual Basic code from your
model, you can configure the code generation options using
the 'VB Specifications' page of the 'Preferences' dialog to:

. Specify the default attribute type
. Define the default source directory

. Define the file extensions to search for code files to
import
. Define the default editor to use for editing source code

Access

Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
Visual Basic

Keyboard Ctrl+F9
Shortcuts

Options
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Option Action
Disable Leave this checkbox unselected to
Language support Visual Basic code generation.

Select this option to disable Visual Basic
code support.

Options for Specifies the options used for the current
the current use; these options apply to all models that
user are accessed by the user.
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Visual Basic Options - Model

If you intend to generate Visual Basic code from your
model, you can configure the model-specific code
generation options using the "VB Specifications' page of the
'Manage Project Options' dialog to:

. Specify the default Visual Basic version to generate

. Indicate the default file extension when reading/writing
. Indicate the MTS transaction mode for MTS objects

. Specify if a Class uses Multi use (True or False)

. Specify if a Class uses the Persistable property

. Indicate data binding and data source behaviors

. Set the global namespace

. Set the Exposed attribute

. Indicate i1f the Creatable attribute 1s True or False

. Specify the Collection Class definitions for Association
connectors

Access

Ribbon Configure > Model > Options > Source
Code Engineering > Visual Basic
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Options

Option Action

Options for Type 1n the default file extension to apply

the current when generating Visual Basic source

model code, and click on the drop-down arrow
in each of the other fields and select the
appropriate value.

Collection Click on this button to open the

Classes 'Collection Classes for Association Roles'
dialog, through which you specify the
Collection Class definitions for
Association connectors.

Notes

. These options affect all users of the current model;
however, they do not apply to other models
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MDG Technology Language Options

If you have loaded an MDG Technology that specifies a
code module into your Sparx Systems > EA > MDG
Technologies folder, the language is included in the 'Source
Code Engineering' list on the 'Preferences' dialog. The
language is only listed on the 'Preferences' dialog if an
MDG Technology file actually uses it in your model.

Access
Ribbon Start > Desktop > Preferences >
Preferences > Source Code Engineering >
MDG

Keyboard Ctrl+F9

Shortcuts
Options
Field Action
Default Default extension for generated source
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Extension files; shown if the option is in the
technology.

This 1s saved per project.

Import File Default folder to import source files
Extensions from; shown if the technology supports
namespaces.

This 1s saved once for all projects.

Generate Indicates 1f namespaces are generated or
Namespaces | not.

Default The default directory to save generated
Source source files.

Directory This is always shown.

Editor Indicates the editor that 1s used to edit

source files.

Att Type Indicates the default attribute type.

Notes

. These options are set in the technology inside the
<CodeOptions> tag of a code module, as shown:
<CodeOption
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name="DefaultExtension">.rb</CodeOption>
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Reset Options

Enterprise Architect stores some of the options for a Class
when it is first created. Some are global; for example,
$LinkClass is stored when you first create the Class, so in
existing Classes the global change in the 'Preferences' dialog
will not automatically be picked up. You must modify the
options for the existing Class.

Modify options for a single Class

Ste Action
p

1 | Click on the Class to change, and select the 'Develop
> Source Code > Generate > Generate Single
Element' ribbon option.

The 'Generate Code' dialog displays.

2 | Click on the Advanced button.
The 'Object Options' dialog displays.

3 | Click on the 'Attributes/Operations' option.

4 Change the options, and click on the Close button to
apply the changes.
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Modify options for all Classes within a
Package

Ste | Action
p

1 | Click on the Package in the Browser window, and
select the 'Develop > Preferences > Options > Reset
Source Language' ribbon option.

The 'Manage Code Generation' dialog displays.

2 In the 'Where language 1s:' field, click on the
drop-down arrow and select the language that you
want to change from.

3 | Inthe 'Convert to:' field, click on the drop-down
arrow and select the language that you want to
change to.

4 | Select the checkbox against each option to apply to
the changed Class elements in the Package:

. Clear Filenames of the files to generate code to
. Reset Default options on each Class

. Process Child Packages under the selected
Package
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5 | Click on the OK button to apply the changes.
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Set Collection Classes

Using Enterprise Architect, you can define Collection
Classes for generating code from Association connectors
where the target role has a multiplicity setting greater than
1.

Tasks

Task Detail
Defining On the 'Source Code Engineering' section
Collection of the 'Manage Project Options' dialog
Classes (select the 'Configure > Model > Options

> Source Code Engineering' ribbon
option), on each language page click on
the Collection Classes button.

The 'Collection Classes for Association
Roles' dialog displays. On this dialog,
you can define:

. The default Collection Class for 1..*
roles

. The ordered Collection Class to use for
1..* roles

. The qualified Collection Class to use
for 1..* roles
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Defining Class-specific Collection Classes can be
Collection defined by clicking the Collection
Classes fora | Classes button in the Class 'Properties'
specific Class = dialog of the element.

Code When Enterprise Architect generates
Generation code for a connector that has a
Precedence multiplicity role >1:
1. If the Qualifier 1s set, use the qualified
collection:

- for the Class if set

- else use the code language qualified
collection

2. If the 'Order’ option is set, use the
ordered collection:

- for the Class if set

- else use the code language ordered
collection

3. Else use the default collection:
- for the Class if set
- else use the code language default

collection
Using You can include the marker #TYPE# in
Markers the collection name; Enterprise Architect

replaces this with the name of the Class
being collected at source generation time
(for example, Vector<#TYPE#> would
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Additional
Collection
Classes

Member
Type

(c) Sparx Systems 2019

become Vector<foo>).

Conversely, when reverse engineering, an
Association connector 1s also created if a
matching entry (for example, foo if foo is
found in the model) is defined as a
Collection Class.

Additional Collection Classes can be
defined within the model-specific
language options pages for C#, C++ and
Java.

On the 'Role(s)' tab of the Association
'Properties' dialog (accessible from the
right-click context menu of any

Association) there 1s a 'Member Type'

field for each of the Source and Target
Roles.

If you set this, the value you enter
overrides all the listed options.
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Example Use of Collection Classes

Consider this source code:

class Classl

{

public:
Class1();
virtual ~Class1();
CMap<CString, LPCTSTR,Class3*,Class3*> att;
Vector<Class2> *attl;
TemplatedClass<class1,class2> *att2;
CList<Class4> *att3;

¥

class Class2

{

public:
Class2();
virtual ~Class2();

¥

class Class3

{

public:
Class3();
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virtual ~Class3();
1§
class Class4
{
public:
Class4();
virtual ~Class4();
I
template<class TParaml1, class TParam2>
class TemplatedClass
{
public:
TemplatedClass() {

b
virtual ~TemplatedClass() {

}
55

If this code is imported into the system with default import
options, this diagram is generated:
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TParam1 : class
TParam2 : class

Classd

TemplatedClass Class3 Class2
Class2{) + Class2{)
+ TemplstedClas() I7 )
+ ~TempiatedCissz(| ~Gizzs3) + ~Clsz=d)
+E1.T.E,|'II +E|11.li‘l o= +attd o
= TParam1->class1 | TRaram2->dass2 =
Class

att :CMap=CS5tring, LFCTSTR, Class2" Clas3™>
att1 Vedor<Class2="
att? TemplatedClass<class 1, class2="
att? (CList<Classd="

+

Cla=1{)
+ ~Cigssi()

+ Class4))
+ ~Clazad()

7 August, 2019

If, however, you enter the value 'CList<#Type#>' in the
'Additional Collection Classes' field in the model-specific
language options page (C#, Java, C++), an Association

connector 1s also created to Class 4:
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TParam1 : class
TParam2 : class
TemplatedClass Class3 Class2 Classd
+ Classa3f) +  Class2() + Classd4)
+ T tedCl u U 'y
+ =;:m,p;?afedcf.:glr + ~Classl + ~Clssd) R
"'ﬂn-:—'fll +E|‘L't,"l o= +En-t1fI 0~ +att3,l’l 0.

= TParam1->class1 .| TParam2->dass2 =

Class1

att TMap=CString, LFCTSTR,Class3= Clas=3*>
att1 Vedor<ClassZ==

att2 TemplatedClass<dass1,clas2==

att? ClList=Classd>

PR

+

Class1{)
+ ~Clazei()
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Local Paths

When a team of developers are working on the same
Enterprise Architect model, each developer might store their
version of the source code in their local file system, but not
always at the same location as their fellow developers. To
manage this scenario in Enterprise Architect, you can define
local paths for each user, on the 'Local Paths' dialog.

You can use local paths in generating code and reverse
engineering, and in Version Control, developing XML
schemas and generating document and web reports.

Local paths might take a little time to set up, but if you want
to work collaboratively on source and model concurrently,
the effort 1s well worth while.

For example, if:

. Developer A stores her .java files in a C:\Java\Source
directory, while developer B stores his in D:\Source, and

. Both developers want to generate and reverse engineer
into the same Enterprise Architect model located on a
shared (or replicated) network drive

Developer A might define a local path of:

JAVA SOURCE = "C:\Java\Source"

All Classes generated and stored in the Enterprise Architect
project are stored as:

%JAVA_ SOURCE%\<xxx.java>
Developer B defines a local path as:
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JAVA SOURCE ="D:\Source"

Now, Enterprise Architect stores all java files in these
directories as:

%JAVA SOURCE%\<filename>

On each developer's machine, the filename is expanded to
the correct local version.

Access

Ribbon Develop > Preferences > Options >
Configure Local Paths
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Local Paths Dialog

Using the 'Local Paths' dialog, you can set up local paths for
a single user on a particular machine. For a description of
the use of local paths, see the Local Paths topic.

Access
Ribbon Develop > Preferences > Options >
Configure Local Paths
Options
Option Action
Path Type in or browser for the path of the
local directory in the file system (for
example, d:\java\source).
ID Type 1n the shared ID that is substituted
for the Local Path (for example,
JAVA_ SRC).
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Type Click on the drop-down arrow and select
the type of path to apply to (for example,
Java).

Relative Lists the paths currently defined for the

Paths model, defaulting to most recent at the
top.

If you want to change the sequence of
paths 1n the list, click on a path and use
the [4][# buttons to move the path up or
down one position in the list

Apply Path Click on a path in the 'Relative Paths' list
and click on this button to update any
existing full path names in the model to
the shared relative path name. For
example:

d:\java\source\main.java might
become %JAVA SRC%\main.java

Expand Path = Click on a path in the 'Relative Paths' list
and click on this button to remove the
relative path and substitute the full path
name (the opposite effect of the Apply
Path button).

New Click on this button to clear the data
fields so that you can define another local
path.
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Save When you have defined a local path, click
on this button to save it and add it to the
'Relative Paths' list.

Delete Click on a path in the 'Relative Paths' list
and click on this button to remove the
path from the list altogether.

Close Click on this button to close the dialog,
saving any changes to the list.

Notes

. You can also set up a hyperlink (for an Enterprise
Architect command) on a diagram to access the 'Local
Paths' dialog, to switch, update or expand your current
local path

. If the act of expanding or applying a path for a linked file
will create a duplicate record, the process will skip that
record and display a message at the end of the process

(c) Sparx Systems 2019 Page 384 of 674



User Guide - Software Models 7 August, 2019

Language Macros

When reverse engineering a language such as C++, you
might find preprocessor directives scattered throughout the
code. This can make code management easier, but can
hamper parsing of the underlying C++ language.

To help remedy this, you can include any number of macro
definitions, which are ignored during the parsing phase of
the reverse engineering. It 1s still preferable, if you have the
facility, to preprocess the code using the appropriate
compiler first; this way, complex macro definitions and
defines are expanded out and can be readily parsed. If you
don't have this facility, then this option provides a
convenient substitute.

Access

Ribbon Configure > Reference Data > Settings >
Preprocessor Macros or

Develop > Preferences > Options >
Define Preprocessor Macros

Define a macro
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Ste Action
p

1 | Select the 'Preprocessor Macros' menu option.
The 'Language Macros' dialog displays.

2 Click on the Add New button.
3 | Enter details for your macro.

4 | Click on the OK button.

Macros Embedded Within Declarations

Macros are sometimes used within the declaration of
Classes and operations, as in these examples:

class declspec Foo

d

int __ declspec Bar(int p);

1§
If declspec 1s defined as a C++ macro, as outlined, the
imported Class and operation contain a Tagged Value called

DeclMacrol with value  declspec (subsequent macros
would be defined as DeclMacro2, DeclMacro3 and so on).

During forward engineering, these Tagged Values are used
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to regenerate the macros in code.

Define Complex Macros

It 1s sometimes useful to define rules for complex macros
that can span multiple lines; Enterprise Architect ignores the
entire code section defined by the rule.

Such macros can be defined in Enterprise Architect as in
these two examples; both types can be combined in one
definition.

Block Macros

BEGIN INTERFACE PART *
END INTERFACE PART

The * symbol represents the body of the macro - this enables
skipping from one macro to another; the spaces surrounding
the ” symbol are required.

Function Macros

RTTI EMULATION()

Enterprise Architect skips over the token including
everything inside the parentheses.

Notes
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. You can transport these language macro (or preprocessor
macro) definitions between models, using the 'Configure
> Model > Transfer > Export Reference Data' and 'Tmport
Reference Data' options; the macros are exported as a
Macro List
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ICONIX

The ICONIX process is a proprietary software development
methodology based on UML. The process 1s Use Case
driven and uses UML based diagrams to define four
milestones. The main feature of the process 1s a concept
called robustness modeling, based on the early work of Ivar
Jacobson, which helps bridge the gap between analysis and
design.

This text is derived from the ICONIX entry in the online
Wikipedia:

"The ICONIX Process is a minimalist, streamlined approach
to Use Case driven UML modeling that uses a core subset of
UML diagrams and techniques to provide thorough
coverage of object-oriented analysis and design. Its main
activity 1s robustness analysis, a method for bridging the gap
between analysis and design. Robustness analysis reduces
the ambiguity in use case descriptions, by ensuring that they
are written in the context of an accompanying domain
model. This process makes the use cases much easier to
design, test and estimate.'

The ICONIX Process was developed by Doug Rosenberg;
for more information on ICONIX, refer to ICONIX
Software Engineering Inc.

Aspects
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Aspect Detail

ICONIX in Enterprise Architect enables you to

Enterprise develop models under ICONIX quickly

Architect and simply, through use of an MDG
Technology integrated with the
Enterprise Architect installer.

The ICONIX facilities are provided in the
form of:

. A set of ICONIX pages in the Toolbox

. ICONIX element and relationship
entries in the "Toolbox Shortcut' menu
and Quick Linker

To further help you develop and manage
a project under ICONIX, Enterprise
Architect also provides a white paper on
the ICONIX Roadmap.

In addition, Enterprise Architect has an
alternative visual layout specific to

ICONIX.
ICONIX Within the Toolbox, Enterprise Architect
Toolbox provides ICONIX versions of the pages
Pages for UML Analysis, Use Case, Class,

Interaction (Sequence), Activity and
Custom diagrams (which often form the
basis for Robustness diagrams).

Compared to the standard Toolbox pages,
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these have slightly different element and

relationship sets; you can access them by

either:

. Specifying the ICONIX Diagram Type
in the 'Dind Toolbox Item' dialog for a
specific Toolbox page

. Selecting the 'ICONIX' option in the
drop-down field of the Default Tools
toolbar, which adds all six pages to the
Toolbox; the first page and the
'Common' page are expanded, and the
others are closed up
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ICONIX The ICONIX layout re-organizes the
Layout Enterprise Architect work area, opening
the:

. Toolbox on the right hand side of the

screen (follow the earlier instructions
to display the 'TCONIX' pages)
. Browser window in the top left of the
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screen, and

. Notes and Properties windows nested
on the bottom left of the screen

To apply this layout, select the 'Basic -
Reversed' option in the drop-down list in
the Workspace Layout toolbar.
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Developing Programming Languages

You can make use of a range of established programming
languages in Enterprise Architect, but if these are not
suitable to your needs you can develop your own. You
would then apply it to your models through an MDG
Technology that you might develop just for this purpose, or
for broader purposes. After developing the language, you
could also write MDA Transformation templates to convert
a Platform Independent Model or a model in another
language into a model for your new language, or vice-versa.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Keyboard Ctrl+Shift+P
Shortcuts

Develop a Programming Language

Ste | Description
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1 | Inthe Code Template Editor, click on the New
Language button and, on the 'Programming
Languages Datatypes' dialog, click on the Add
Product button.

Enter your new programming language name and
define the datatypes for it. You cannot access the
new language in the Code Template Editor until at
least one datatype has been added to the language.

2 | After you have defined all the datatypes you need,
click on the Close button, select the language in the
'Language’ field of the Code Template Editor, and
start to edit or create the code templates for the new
language.

The code templates define how the system should
perform:

. Forward code engineering of your models in the
new language

. Behavioral Code generation (if this is appropriate)

3 | If you prefer, you can also define source code
options for your new language. These are additional
settings for the language that are not provided by the
data types or code templates, and that help define
how the system handles that language when
generating and reverse-engineering code.

The code options are made available to your models
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only through an MDG Technology.

4 Defining a grammar for your language is an optional
step that provides two primary benefits:

. Reverse engineering of existing code into your
model

Synchronization during code generation so that
changes made to the file since it was last generated
are not lost.

To access the grammar editor select the 'Develop >
Preferences > Grammars' ribbon option.

5 | If you intend MDA transformations to be made to (or
from) your new programming language, you can also
edit and create transformation templates for it. The
process of creating transformation templates is very
similar to that for creating code templates.

6  Having created the datatypes, code templates, code
options, grammar and transformation templates for
your new language, you can incorporate and
distribute them in an MDG Technology.
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Code Template Framework

When you use Enterprise Architect to generate code from a
model, or transform the model, the system refers to the Code
Template Framework (CTF) for the parameters that define
how it should:

. Forward engineer a UML model

. Generate Behavioral Code

. Perform a Model Driven Architecture (MDA)
Transformation

. Generate DDL in database modeling

A range of standard templates 1s available for the direct
generation of code and for transformation; if you do not
want to use the standard CTF configurations, you can
customize them to meet your needs.

CTF Templates

Template Detail

Type
Code When you forward engineer a Class
Templates model, the code templates define how the

skeletal code is to be generated for a
given programming language. The
templates for a language are
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Model
Transformati
on Templates

Behavioral
Code
Generation
Templates

DDL
Templates
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automatically associated with the
language.

The templates are written as plain text
with a syntax that shares some aspects of
both mark-up languages and scripting
languages.

Model Transformation Templates provide
a fully configurable method of defining
how Model Driven Architecture (MDA)
Transformations convert model elements
and model fragments from one domain to
another.

This process is two-tiered. It creates an
intermediary language (which can be
viewed for debugging) which is then
processed to create the objects.

Enterprise Architect supports
user-definable code generation of the
UML Behavioral models.

This applies the standard Code Template
Framework but includes specific
Enterprise Architect Simulation Library
(EASL) code generation macros.

DDL Templates are very similar to Code
generation templates, but they have been
extended to support DDL generation with
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their own set of base templates, macros,
function macros and template options.
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Code Template Customization

Enterprise Architect helps you to generate source code from
UML models for a wide range of programming languages.
Standard templates (mappings) are provided out-of-the-box
but you can customize the way that code is generated by
using the powerful and flexible Code Template Framework
(CTF). This sophisticated framework allows you to
customize every detail of the way code is generated,
including the facility to create new templates for languages
not supported in the base product. For example, JavaScript
1s not one of the supported languages but a series of
templates can be written quickly to generate JavaScript from
UML models. In these cases existing templates act as a
useful starting point and reference for new languages.

The code template framework also provides the mechanism
for generation of behavioral models and 1s used for the
transformation templates.

Features

Feature Detail
Default Default Code Templates are built into
Templates Enterprise Architect for forward

engineering supported languages.
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Code A Code Template Editor is provided for
Template creating and maintaining user-defined
Editor Code Templates.

Customizing | Descriptions of the template syntax and
Code the macros and functions you can use to
Templates control the effects of the templates.

Synchronize = A subset of the default Code Templates
Code to synchronize code.
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Code and Transform Templates

Code templates and transform (Model Transformation)
templates define how the system should generate or
transform code in one or other of the programming
languages that Enterprise Architect supports. Each language
has a wide range of base templates, each of which defines
how a particular code structure is generated. You can use
these base templates as they are, or you can customize and
add to the templates to better support your use of the
standard languages, or of other languages that you might
define to the system. You review, update and create
templates through the Code Template editor or
Transformation Template editor.

The order in which the base templates are listed in the two
editors relates to the hierarchical order of the objects and
their parts that are to be processed. Calls are made from
certain base templates to others, and you can add further
calls to both base templates and to your own custom
templates. By default, the File template 1s the starting point
of a code generation process through the templates; a File
consists of Classes that can contain Attributes and
Operations.

Access

Develop > Preferences > Options > Edit
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Ribbon Code Templates

Design > Tools > Transform > Transform
Templates

Keyboard Ctrl+Shift+P (Code Generation
Shortcuts Templates)

Ctrl+Alt+H (MDA Transformation
Templates)

Application of Templates

Action Detail

Calling Within any template, you can call other

Templates templates using % TemplateName%. The
enclosing percent (%) signs indicate a
macro.

Y ou would use this for a single call to the
ClassBody template, %ClassBody%, as
shown:

% list = "TemplateName"
(@separator="\n" @indent=" " %
The %list macro performs an iterative
pass on all the objects in the scope of the
current template and calls the
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TemplateName for each of them:

% list = "ClassBody" @separator=
"\n" @indent=" " %

After generation or transformation, each
macro is substituted to produce the
generated output; for a language such as
C++, the result of processing this
template might be:

/ sk

* This is an example Class note
generated using code templates

* (@author Sparx Systems
*/

class ClassA: public ClassB
{

;
Execution of = Each template might act only on a
Code particular element type; for example, the

Templates ClassNotes template only acts on UML
Class and Interface elements.

The element from which code is currently
being generated 1s said to be in scope; if
the element in scope is stereotyped, the
system searches for a template that has
been defined for that stercotype. If a
specialized template is found, it is
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executed; otherwise the default
implementation of the base template is
used.

Templates are processed sequentially,
line by line, replacing each macro with its
underlying text value from the model.

Transfer If you edit a base Code Generation or

Templates Transformation template, or create a

Between customized template, you can copy them

Projects from one project to another as Reference
Data.
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Base Templates

The Code Template Framework consists of a number of
base templates. Each base template transforms particular
aspects of the UML to corresponding parts of
object-oriented languages.

The base templates form a hierarchy, which varies slightly
across different programming languages. In a typical
template hierarchy relevant to a language like C# or Java
(which do not have header files) the templates can be
modeled as Classes, but usually are just plain text. This
hierarchy would be slightly more complicated for languages
such as C++ and Delphi, which have separate
implementation templates.

Each of the base templates must be specialized to be of use
in code engineering; in particular, each template is
specialized for the supported languages (or '‘products'). For
example, there is a ClassBody template defined for C++,
another for C#, another for Java, and so on; by specializing
the templates, you can tailor the code generated for the
corresponding UML entity.

Once the base templates are specialized for a given
language, they can be further specialized based on:

. A Class's stereotype, or

. A feature's stereotype (where the feature can be an
operation or attribute)

This type of specialization enables, for example, a C#
operation that is stereotyped as «property» to have a
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different Operation Body template from an ordinary
operation; the Operation Body template can then be
specialized further, based on the Class stereotype.

Base templates used in the CTF

Template Description

Attribute A top-level template to generate member
variables from UML attributes.

Attribute Used by the Attribute template to
Declaration generate a member variable declaration.

Attribute Used by the Attribute template to
Notes generate member variable notes.
Class A top-level template for generating

Classes from UML Classes.

Class Base Used by the Class template to generate a
base Class name in the inheritance list of
a derived Class, where the base Class
doesn't exist in the model.

Class Body Used by the Class template to generate
the body of a Class.
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File
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Linked
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Linked
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Linked
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Used by the Class template to generate
the declaration of a Class.

Used by the Class template to generate an
interface name in the inheritance list of a
derived Class, where the interface doesn't
exist in the model.

Used by the Class template to generate
the Class notes.

A top-level template for generating the
source file.

For languages such as C++, this
corresponds to the header file.

Used in the File template to generate
external dependencies.

A top-level template for generating
attributes derived from UML
Associations.

Used by the Linked Attribute template to

generate the attribute notes.

Used by the Linked Attribute template to
generate the attribute declaration.
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Declaration

Linked Class
Base

Linked Class
Interface

Namespace

Namespace
Body

Namespace
Declaration

Operation

(c) Sparx Systems 2019

Used by the Class template to generate a
base Class name 1n the inheritance list of
a derived Class, for a Class element in the

model that is a parent of the current
Class.

Used by the Class template to generate an
Interface name in the inheritance list of a
derived Class, for an Interface element in

the model that is a parent of the current
Class.

A top-level template for generating
namespaces from UML Packages
(although not all languages have
namespaces, this template can be used to
generate an equivalent construct, such as
Packages in Java).

Used by the Namespace template to
generate the body of a namespace.

Used by the Namespace template to
generate the namespace declaration.

A top-level template for generating
operations from a UML Class's
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operations.
Operation Used by the Operation template to
Body generate the body of a UML operation.
Operation Used by the Operation template to

Declaration generate the operation declaration.

Operation Used by the Operation template to
Notes generate documentation for an operation.
Parameter Used by the Operation Declaration

template to generate parameters.

Templates for generating code for languages
with separate interface and implementation
sections

Template Description

Class Impl A top-level template for generating the
implementation of a Class.

Class Body Used by the Class Impl template to
Impl generate the implementation of Class
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File Impl
File Notes
Impl

Import
Section Impl

Operation
Impl
Operation

Body Impl

Operation
Declaration
Impl

Operation
Notes Impl
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members.

A top-level template for generating the
implementation file.

Used by the File Impl template to
generate notes in the source file.

Used by the File Impl template to
generate external dependencies.

A top-level template for generating
operations from a UML Class's
operations.

Used by the Operation template to
generate the body of a UML operation.

Used by the Operation template to
generate the operation declaration.

Used by the Operation template to
generate documentation for an operation.
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Export Code Generation and
Transformation Templates

It 1s possible to export Code Generation and Transformation
templates from your model to a .xml file. You can then
import that file - and hence the templates - into other
models, as reference data. You can export customized
templates, which includes those that you or other users have
created and updated, and base (standard) templates that have
been tailored. You do not need to export base templates that
have not been changed, as these are available in every
installation of Enterprise Architect.

Access

Ribbon Configure > Model > Transfer > Export
Reference Data

Export a Code Generation template or
Transformation template

Ste Action
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1 | On the 'Export Reference Data' dialog, in the 'Name'
list, select the templates to export.

The list includes any standard Code Generation or
Transformation templates that have been changed,
and any customized templates that you have created
or changed.

You can select one or more templates to be exported
to a single XML file, by pressing Ctrl or Shift as you
click on the template names.

2 Click on the Export button.

3 | When prompted to do so, enter a valid file name
with a .xml extension.

4 | Click on the Save button and on the OK button.

This exports the template(s) to the file; you can use
any text or XML viewer to examine the file.
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Import Code Generation and
Transformation Templates

If you have exported Code Generation and/or
Transformation templates from an Enterprise Architect
model, you can import them into other Enterprise Architect
models as reference data.

Access

Ribbon Configure > Model > Transfer > Import
Reference Data

Import Code Generation and/or
Transformation Templates

Ste Action
P

1 | On the 'Tmport Reference Data' dialog, click on the
Select File button and browse to the .xml file
containing the required Code Generation or
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Transformation templates.

2 | Select the name of one or more template datasets and
click on the Import button.
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Synchronize Code

Enterprise Architect uses code templates during the forward
synchronization of these programming languages:

. ActionScript
. C

. CH+H+

. C#

. Delphi

. Java

. PHP

. Python

. VB

. VB.Net

Three types of change can occur in the source when it is
synchronized with the UML model:

. Existing sections are synchronized: for example, the
return type in an operation declaration is updated

. New sections are added to existing features: for example,
Notes are added to a Class declaration where there were
previously none

. New features and elements are added: for example, a new
operation is added to a Class

Each of these changes has a different effect on the CTF and
must be handled differently by Enterprise Architect, as
described in these topics:
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. Synchronize Existing Sections
. Add New Sections to Existing Features
. Add New Features and Elements

Code sections that can be synchronized

Only a subset of the CTF base templates is used during
synchronization. This subset corresponds to the distinct
sections that Enterprise Architect recognizes in the source
code.

Code Code Section
Template

Class Notes Comments preceding the Class

declaration.
Class Up to and including the Class parents.
Declaration
Attribute Comments preceding an Attribute
Notes declaration.
Attribute Up to and including the terminating

Declaration character.

Operation Comments preceding an operation
Notes declaration.
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Operation As for Operation Notes.
Notes Impl
Operation Up to and including the terminating

Declaration character.

Operation Up to and including the terminating
Declaration character.

Impl

Operation Everything between and including the
Body braces.

Operation As for Operation Body.
Body Impl
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Synchronize Existing Sections

When an existing section in the source code differs from the
result generated by the corresponding template, that section
1s replaced.

Consider, for example, this C++ Class declaration:
(asm) class A: public B

Now assume that you add an inheritance relationship from
Class A to Class C; the entire Class declaration would be
replaced with something resembling this:

(asm) class A: public B, public C
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Add New Sections

These sections can be added to existing features in the
source code, as new sections:

. Class Notes

. Attribute Notes

. Operation Notes

. Operation Notes Impl
. Operation Body

. Operation Body Impl

Assume that, in this example, Class A had no note when you
originally generated the code:

(asm) class A: public B, public C

If you now specify a note in the model for Class A,
Enterprise Architect attempts to add the new note from the
model during synchronization, by executing the Class Notes
template.

To make room for the new section to be inserted, you can
specify how much white space to append to the section via
synchronization macros.
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Add New Features and Elements

These features and elements can be added to the source code
during synchronization:

. Attributes
. Inner Classes
. Operations

They are added by executing the relevant templates for each
new element or feature in the model.

Enterprise Architect attempts to preserve the appropriate
indenting of new features in the code, by finding the indents
specified in list macros of the Class; for languages that make
use of namespaces, the 'synchNamespaceBodyIndent' macro
is available.

Classes defined within a (non-global) namespace are
indented according to the value set for this macro, during
synchronization.

The value 1s 1gnored:

. For Classes defined within a Package set up as a root
namespace, or

. If the 'Generate Namespaces' option is set to False in the
appropriate language page (C#, C++ or VB.Net) on the
'Preferences' dialog ('Start > Desktop > Preferences >
Preferences > Source Code Engineering > <language>')
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The Code Template Editor

The Code Template Editor provides the facilities of the
Common Code Editor, including Intelli-sense for the various
macros. For more information on Intelli-sense and the
Common Code Editor, see the Editing Source Code topic.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Keyboard Ctrl+Shift+P

Shortcuts
Options
Option Action
Language Select the programming language.
New Display the 'Programming Languages
Language Datatypes' dialog, which enables you to
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Template

Templates

Stereotype
Overrides

Add New
Custom
Template

Add New
Stereotyped
Override
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include programming languages other
than those supported for Enterprise
Architect, for which to create or edit code
templates.

Display the contents of the active
template, and open the editor for
modifying templates.

List the base code templates; the active
template 1s highlighted.

The 'Modified' field indicates whether
you have changed the default template for
the current language.

List the stereotyped templates, for the
active base template.

The 'Modified' field indicates whether
you have modified a default stereotyped
template.

Invoke a dialog for creating a custom
stereotyped template.

Invoke a dialog for adding a stereotyped
template, for the currently selected base
template.
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Get Default Update the editor display with the default
Template version of the active template.

Save Overwrite the active templates with the
contents of the editor.

Delete If you have overridden the active
template, the override 1s deleted and
replaced by the corresponding default
code template.

Notes

. User-modified and user-defined Code Templates can be
imported and exported as reference data (see the Sharing
Reference Data topic); the templates defined for each
language are indicated in the 'Export Reference Data'
dialog by the language name with the suffix
_Code Templates - 1f no templates exist for a language,
there is no entry for the language in the dialog
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Code Template Syntax

Code Templates are written using Enterprise Architect's
Code Template Editor. The Code Template Editor supports
syntax highlighting of the Code Template Framework
language.

Syntax Elements

Elements Detail
Basic Templates can contain:
Constructs . Literal Text

. Variables

. Macros
. Calls to other templates

Comments If you want to add comments to the
templates, use the command:

$COMMENT="text"

where "text" 1s the text of the comment;
this must be enclosed in quotes.

The command is case-sensitive, and must
be typed in upper case.
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Literal Text

All text within a given template that is not part of a macro or
a variable definition/reference, is considered literal text.
With the exception of blank lines, which are ignored, literal
text 1s directly substituted from the template into the
generated code.

Consider this excerpt from the Java Class Declaration
template:

$bases = "Base"
class % className % $bases

On the final line, the word 'class ', including the subsequent
space, would be treated as literal text and thus for a Class
named 'foo' would return the output:

class fooBase

A blank line following the variable $bases would have no
effect on the output.

Inserting System Characters:

The %, $, " and \ characters have special meaning in the
template syntax and cannot always be used as literal text. If
these characters must be generated from within the
templates, they can be safely reproduced using these direct
substitution macros:

Macro Action
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%d1% Produce a literal $ character.

%opc% Produce a literal % character.

%qt% Produce a literal " character.

%51% Produce a literal \ character
Notes

String conjunction operators (“+”, “+="") are not required
but can be used
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Variables

Template variables provide a convenient way of storing and
retrieving data within a template. This section explains how
variables are defined and referenced.

Variable Definitions

Variable definitions take the basic form:
$<name> = <value>

where <name> can be any alpha-numeric sequence and
<value> 1s derived from a macro or another variable.

A simple example definition would be:
$foo = %className%o
Variables can be defined using values from:
. Substitution, function or list macros
. String literals, enclosed within double quotation marks
. Variable references

Definition Rules

These rules apply to variable definitions:

. Variables have global scope within the template in which
they are defined and are not accessible to other templates
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. Each variable must be defined at the start of a line,
without any intervening white space

. Variables are denoted by prefixing the name with §, as in
$foo

. Variables do not have to be declared, prior to being
defined

. Variables must be defined using either the assignment
operator (=), or the addition-assignment operator (+=)

. Multiple terms can be combined in a single definition
using the addition operator (+)

Examples

Using a substitution macro:
$foo = %opTag:"bar"%
Using a literal string:

$foo = "bar"
Using another variable:
$foo = $bar

Using a list macro:

$ops = %list="Operation" @separator="\n\n"
@indent="\t"%

Using the addition-assignment operator (+=):

$body += %list="Operation" @separator="\n\n"
@indent="\t"%
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That definition is equivalent to:

$body = $body + %list="Operation" @separator="\n\n"
@indent="\t"%

Using multiple terms:

$templateArgs = %list="ClassParameter" (@separator=",
H%

$template ="template<" + $templateArgs + ">"

Variable References

Variable values can be retrieved by using a reference of the
form:

$<name>
where <name> can be a previously defined variable.
Variable references can be used:

. As part of a macro, such as the argument to a function
macro

. As aterm in a variable definition

. As a direct substitution of the variable value into the
output

It 1s legal to reference a variable before it is defined. In this
case, the variable 1s assumed to contain an empty string
value: ""
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Variable References - Example 1

Using variables as part of a macro. This 1s an excerpt from
the default C++ ClassNotes template.

$wrapLen = %genOptWrapComment%

$style = %genOptCPPCommentStyle%  (Define
variables to store the style and wrap length options)

%if $style == "XML.NET"% (Reference to $style as
part of a condition)

%XML COMMENT($wrapLen)%
%else%

%CSTYLE COMMENT($wrapLen)%  (Reference to
$wrapLen as an argument to function macro)

%endIf%

Variable References - Example 2

Using variable references as part of a variable definition.
$foo = "foo" (Define our variables)

$bar = "bar"

$foobar = $foo + $bar ($foobar now contains the value
foobar)

Variable References - Example 3
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Substituting variable values into the output.

$bases=%classInherits% (Store the result of the
ClassInherits template in $bases)

Class %className%S$bases (Now output the value of
$bases after the Class name)
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Macros

Macros provide access to element fields within the UML
model and are also used to structure the generated output.
All macros are enclosed within percent (%) signs in the
form of:

%<macroname>%

In general, macros (including the % delimiters) are
substituted for literal text in the output. For example,
consider this item from the Class Declaration template:

... class %className% ...

The field substitution macro, %className%, would result in
the current Class name being substituted in the output. So if
the Class being generated was named Foo, the output would

be:
... class Foo ...
The CTF contains a number of types of macros:
. Template Substitution Macros
. Field Substitution Macros
. Substitution Examples
. Attribute Field Substitution Macros
. Class Field Substitution Macros
. Code Generation Option Field Substitution Macros

. Connector Field Substitution Macros

. Constraint Field Substitution Macros
. Effort Field Substitution Macros
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. File Field Substitution Macros

. File Import Field Substitution Macros
. Link Field Substitution Macros

. Linked File Field Substitution Macros
. Metric Field Substitution Macros

. Operation Field Substitution Macros

. Package Field Substitution Macros

. Parameter Field Substitution Macros
. Problem Field Substitution Macros
. Requirement Field Substitution Macros

. Resource Field Substitution Macros
. Risk Field Substitution Macros
. Scenario Field Substitution Macros

. Tagged Value Substitution Macros

. Template Parameter Substitution Macros
. Test Field Substitution Macros
. Function Macros

. Control Macros
. List Macro
. Branching Macros

. Synchronization Macros

. The Processing Instruction (PI) Macro
. EASL Code Generation Macros
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Template Substitution Macros

Template substitution macros correspond to Base templates,
and result in the execution of the named template. By
convention, template macros are named according to Pascal
casing.

Structure: %<TemplateName>%

where <TemplateName> can be one of the templates listed
in this topic.

When a template is referenced from within another
template, it is generated with respect to the elements
currently in scope. The specific template 1s selected based
on the stereotypes of the elements in scope.

As noted previously, there 1s an implicit hierarchy among
the various templates. Some care should be taken in order to
preserve a sensible hierarchy of template references. For
example, it does not make sense to use the %ClassInherits%
macro within any of the attribute or operation templates.
Conversely, the Operation and Attribute templates are
designed for use within the ClassBody template.

Template substitution macros in the CTF

. Attribute

. AttributeDeclaration

. AttributeDeclarationImpl
. AttributeNotes
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. Class

. ClassBase

. ClassBody

. ClassBodyImpl

. ClassDeclaration

. ClassDeclarationImpl
. ClassImpl

. ClassInherits

. ClassInterface

. ClassNotes

. ClassParameter

. File

. FileImpl

. ImportSection

. ImportSectionImpl

. InnerClass

. InnerClassImpl

. LinkedAttribute

. LinkedAttributeDeclaration
. LinkedAttributeNotes
. LinkedClassBase

. LinkedClassInterface
. Namespace

. NamespaceBody

. NamespaceDeclaration
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. Namespacelmpl

. Operation

. OperationBody

. OperationBodyImpl

. OperationDeclaration

. OperationDeclarationImpl
. OperationImpl

. OperationNotes

. Parameter
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Field Substitution Macros

The field substitution macros provide access to data in your
model. In particular, they are used to access data fields
from:

. Packages

. Classes

. Attributes

. Operations, and
. Parameters

Field substitution macros are named according to Camel
casing. By convention, the macro 1s prefixed with an
abbreviated form of the corresponding model element. For
example, attribute-related macros begin with att, as in the
%attName% macro, to access the name of the attribute in
scope.

Macros that represent checkboxes return a value of T if the
box is selected. Otherwise the value is empty.

This table lists a small number of project field substitution
macros. Type-specific macros are listed in the subtopics of
this Field Substitution Macros section.

Project Macros

Macro Name | Description
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eaDateTime The current time with format:
DD-MMM-YYYY HH:MM:SS AM/PM.

eaGUID A unique GUID for this generation.

ecaVersion Program Version (located in the 'About
Enterprise Architect' dialog by selecting
'Start > Help > Help > About EA').
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Substitution Examples

Field substitution macros can be used in one of two ways:
. Direct Substitution or
. Conditional Substitution

Direct Substitution

This form directly substitutes the corresponding value of the
element in scope into the output.

Structure: %<macroName>%
Where <macroName> can be any of the macros listed in the

Field Substitution Macros tables.
Examples

. %className%
. %0pName%
. %attName%

Conditional Substitution
This form of the macro enables alternative substitutions to
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be made depending on the macro's value.

Structure: %<macroName> (== "<text>") ? <subTrue> (:
<subFalse>) %

Where:

. () denotes that values between the parentheses are
optional

. <text> is a string representing a possible value for the
macro

. <subTrue> and <subFalse> can be a combination of
quoted strings and the keyword value; where the value is
used, it is replaced with the macro's value 1n the output

Examples

. %classAbstract=="T" ? "pure" :""%
. %opStereotype=="operator" ? "operator" :""%
. %paramDefault I="" 7" =" value : "%

These three examples output nothing if the condition fails.
In this case the False condition can be omitted, resulting in
this usage:

. %classAbstract=="T" ? "pure"%
. Y%opStereotype=="operator" ? "operator"%
. %paramDefault !="" ? " = "value%

The third example of both blocks shows a comparison
checking for a non-empty value or existence. This test can
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also be omitted.
. %paramDefault ? " =" value : "%
. %paramDefault ? " =" value%

All of these examples containing paramDefault are
equivalent. If the parameter in scope had a default value of
10, the output from each of them would normally be:

=10

Notes

. In a conditional substitution macro, any white space
following <macroName> is ignored; if white space is
required in the output, it should be included within the
quoted substitution strings
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Attribute Field Substitution Macros

This table lists each of the attribute field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Attribute Macros

Macro Name | Description

attAlias 'Attributes' dialog: Alias.

attAllowDupl @ 'Attributes Detail' dialog: 'Allow
1cates Duplicates' checkbox.

attClassifierG = The unique GUID for the classifier of the
UID current attribute.

attCollection @ 'Attributes Detail' dialog: 'Attribute is a
Collection' checkbox.

attConst 'Attributes' dialog: 'Const' checkbox.

attContainerT @ 'Attributes Detail' dialog: Container Type.
ype
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attContainme
nt

attDerived

attGUID

attInitial

attIsEnumLit
eral

attIsID
attLength

attLowerBou
nd

attName
attNotes

attOrderedM
ultiplicity

(c) Sparx Systems 2019
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'Attributes’ dialog: Containment.

'Attributes' dialog: 'Derived' checkbox.

The unique GUID for the current
attribute.

'Attributes' dialog: Initial.

'Attributes’ dialog: 'Is Literal' checkbox.

'Attributes Detail' dialog: '1sID' checkbox.
'Column’' dialog: Length.

'Attributes Detail' dialog: Lower Bound.

'Attributes' dialog: Name.
'Attributes' dialog: Notes.

'Attributes Detail' dialog: 'Ordered
Multiplicity' checkbox.
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attProperty

attQualType

attScope
attStatic
attStereotype
attType

attUpperBou
nd

attVolatile

(c) Sparx Systems 2019

'Attributes' dialog: 'Property’ checkbox.

The attribute type qualified by the
namespace path (if generating
namespaces) and the classifier path (dot
delimited). If the attribute classifier has
not been set, is equivalent to the attType
macro.

'Attributes' dialog: Scope.
'Attributes' dialog: 'Static' checkbox.
'Attributes' dialog: Stereotype.
'Attributes' dialog: Type.

'Attributes Detail' dialog: Upper Bound.

'Attributes Detail' dialog: "Transient’
checkbox.
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Class Field Substitution Macros

This table provides a list of methods for accessing each
available Class property in the Code Generation and
Transformation templates.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Class Macros

Macro Name | Description

elemType The element type: Interface or Class.

classAbstract = Class 'Properties' dialog: 'Abstract'
checkbox ('Details' tab).

classAlias Class 'Properties' dialog: 'Alias' field.

classArgume | Class 'Detail' dialog: C++ Templates:
nts Arguments.

classAuthor  Class 'Properties' dialog: 'Author’ field.

classBaseNa | 'Type Hierarchy' dialog: Class Name (for
me use where no connector exists between
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child and base Classes).

classBaseSco = The scope of the inheritance as reverse
pe engineered. (For use where no connector
exists between child and base Classes.)

classBaseVirt = The virtual property of the inheritance as

ual reverse engineered. (For use where no
connector exists between child and base
Classes.)

classComple | Class 'Properties' dialog: 'Complexity’
Xity field.

classCreated | The date and time the Class was created.
classGUID The unique GUID for the current Class.

classHasCons = Looks at the list of methods in the current

tructor object and, depending on the conventions
of the current language, returns T if one 1s
a default constructor. Typically used with
the genOptGenConstructor macro.

classHasCop | Looks at the list of methods in the current

yConstructor = object and, depending on the conventions
of the current language, returns T if one 1s
a copy constructor. Typically used with
the genOptGenCopyConstructor macro.
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classHasDest = Looks at the list of methods in the current

ructor object and, depending on the conventions
of the current language, returns T 1f one is
a destructor. Typically used with the
genOptGenDestructor macro.

classHasPare | True, if the Class in scope has one or
nt more base Classes.

classHasStere = True, if the Class in scope has a

otype stereotype that matches a stereotype
name (which you can optionally specify
as fully qualified). It therefore checks all
stereotypes that a Class has and returns
"T" 1f any of them 1s the specified
stereotype or a specialization of it. For
example:

. %classHasStereotype:"block"% will
return 'T' for any block-stereotyped
Class from any SysML version,
including associationBlock

. %classHasStereotype:"SysML1.4::bloc
k"% will specifically match the SysML
1.4 versions

Compare this with classStereotype, later.

classImports | 'Code Gen' dialog: Imports.
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classIsActive

classIsAssoci
ationClass

classIsInstant
1ated

classIsLeaf

classIsRoot

classIsSpecifi
cation

classKeywor
ds

classLanguag
e

classMacros

classModifie
d
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Class 'Advanced' dialog: 'Is Active'
checkbox.

True, if the Association 1s an
AssociationClass connector.

True, 1f the Class 1s an instantiated
template Class.

Class 'Advanced' dialog: 'Is Leaf’
checkbox.

Class 'Advanced' dialog: 'Is Root'
checkbox.

'

Class 'Advanced' dialog: 'Is Specification
checkbox.

Class 'Properties' dialog: 'Keywords'
field.

Class 'Properties' dialog: 'Language' field.

A space separated list of macros defined
for the Class.

The date and time the Class was last
modified.
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classMultipli
city

className
classNotes

classParamD
efault

classParamN
ame

classParamT
ype

classPersisten
ce

classPhase

classQualNa
me

classScope

classStereoty
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Class 'Advanced' dialog: Multiplicity.

Class 'Properties' dialog: 'Name' field.
Class 'Properties' dialog: 'Note' field.

Class 'Detail' dialog.

Class 'Detail' dialog.

Class 'Detail' dialog.

Class 'Properties' dialog: 'Persistence’
field ('Details' tab)

Class 'Properties' dialog: 'Phase’ field.

The Class name prefixed by its outer
Classes. Class names are separated by
double colons (::).

Class "Properties' dialog: 'Scope' field.

Class 'Properties' dialog: 'Stereotype'
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pe field. Retrieves the name of the first
stereotype applied to the Class. When
used 1n a comparison, it checks whether
that first stereotype exactly matches a
string.
For example:
%classStereotype=="enumeration" ?
"enum" : "class"%

Compare this with classHasStereotype,
carlier.

classStatus Class 'Properties' dialog: 'Status' field.

classVersion | Class 'Properties' dialog: 'Version' field.
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Code Generation Option Field
Substitution Macros

Code generation option field substitution macros operate on
the source code generation options defined in the 'Source
Code Engineering' pages of either the:

. 'Preferences' dialog ('Start > Desktop > Preferences >
Preferences > Source Code Engineering') for user-specific
options, or

. 'Manage Project Options' dialog ('Configure > Model >
Options') for model-specific options

For more information on the division of the options, see the
Source Code Engineering Options topic.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" 1f the box is selected. Otherwise the value 1s empty. This
table lists each of the code generation option field
substitution macros.

Code Generation Option Macros

Macro Name Description
genOptActio | ActionScript Specifications page: Default

nScriptVersio | Version.
n
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genOptCDefa
ultAttributeT

ype

genOptCGen
MethodNotes
InBody

genOptCGen
MethodNotes
InHeader

genOptCSyn
chNotes

genOptCSyn
chCFile

genOptCDefa
ultSourceDir
ectory

genOptCNam
espaceDelimi
ter

genOptCOpe
rationRefPara
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C Specifications page: Default Attribute
Type.

C Specifications page: Method Notes In
Implementation.

C Specifications page: Method Notes In
Header.

C Specifications page: Synchronize Notes
in Generation.

C Specifications page: Synchronise
Implementation file in Generation.

C Specifications page: Default Source
Directory.

C Specifications page: Namespace
Delimiter.

C Specifications page: Reference as
Operation Parameter.
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m

genOptCOpe
rationRefPara
mStyle

genOptCOpe
rationRefPara
mName

genOptCCon
structorName

genOptCDest
ructorName

genOptCPPC
ommentStyle

genOptCPPD
efaultAttribut
eType

genOptCPPD
efaultReferen
ceType

genOptCPPD
efaultSource
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C Specifications page: Reference
Parameter Style.

C Specifications page: Reference
Parameter Name.

C Specifications page: Default
Constructor Name.

C Specifications page: Default Destructor
Name.

C—++ Specifications page: Comment
Style.

C++ Specifications page: Default

Attribute Type.

C++ Specifications page: Default
Reference Type.

C++ Specifications page: Default Source
Directory.
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Directory
genOptCPPG | C++ Specifications page: 'Method Notes
enMethodNot = In Header' checkbox.
esInHeader
genOptCPPG | C++ Specifications page: Method Notes
enMethodNot = In Body checkbox.
esInBody
genOptCPPG | C++ Specifications page: Get Prefix.
etPrefix
genOptCPPH = C++ Specifications page: Header
caderExtensi =~ Extension.
on
genOptCPPS | C++ Specifications page: Set Prefix.
etPrefix
genOptCPPS | C++ Specifications page: Source
ourceExtensi = Extension.
on
genOptCPPS | C++ Specifications page: Synchronize
ynchNotes Notes.
genOptCPPS | C++ Specifications page: Synchronize
ynchCPPFile = CPP File.
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genOptCSDe
faultAttribute

Type

genOptCSSo
urceExtensio
n

genOptCSGe
nDispose

genOptCSGe
nFinalizer

genOptCSGe
nNamespace

genOptCSDe
faultSourceD
irectory

genOptDefau
ItAssocAttNa
me

genOptDefau
1tConstructor
Scope
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C# Specifications page
Type.

C# Specifications page
extension.

C# Specifications page
Dispose.

C# Specifications page
Finalizer.

C# Specifications page
Namespace.

C# Specifications page
Directory.

7 August, 2019

: Default Attribute

- Default file

- Generate

: (Generate

: (Generate

: Default Source

Source Code Engineering page: Default
name for associated attribute.

Object Lifetimes page:
Constructor Visibility.

Default
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genOptDefau =~ Object Lifetimes page: Default Copy
1tCopyConstr = Constructor Visibility.
uctorScope

genOptDefau = Code Editors page: Default Database.
1tDatabase

genOptDefau = Object Lifetimes page: Default
I1tDestructorS = Destructor Constructor Visibility.
cope

genOptGenC | 'Source Code Engineering' page:
apitalisedPro  'Capitalize Attribute Names for
perties Properties' checkbox.

genOptGenC | 'Source Code Engineering' page:
omments 'Comments - Generate' checkbox.

genOptGenC | Object Lifetimes page: 'Generate
onstructor Constructor' checkbox.

genOptGenC | Object Lifetimes page: 'Constructor
onstructorInli = Inline' checkbox.
ne

genOptGenC | Object Lifetimes page: 'Generate Copy
opyConstruct = Constructor' checkbox.
or
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genOptGenC
opyConstruct
orlnline

genOptGenD
estructor

genOptGenD
estructorInlin
e

genOptGenD
estructorVirt
ual

genOptGenl
mplementedI
nterfaceOps

genOptGenPr
efixBoolProp
erties

genOptGenR
oleNames

genOptGenU
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Object Lifetimes page:

Inline' checkbox.

Object Lifetimes page:

Destructor' checkbox.

Object Lifetimes page:

checkbox.

Object Lifetimes page:

Destructor' checkbox.

7 August, 2019

'Copy Constructor

'Generate

'Destructor Inline'

'"Virtual

'Code Generation' page: 'Generate
methods for implemented interfaces'

checkbox.

'Source Code Engineering' page: 'Use 'Is'
for Boolean property Get()' checkbox.

'Source Code Engineering' page:
'Autogenerate role names when creating

code' checkbox.

'Source Code Engineering' page: 'Do not
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nspecAssocD  generate members where Association
ir direction 1s unspecified' checkbox.

genOptJavaD | Java Specifications page: Default
efaultAttribut = attribute type.
eType

genOptJavaG | Java Specifications page: Get Prefix.
etPrefix

genOptJavaD | Java Specifications page: Default Source
efaultSource = Directory.
Directory

genOptJavaS | Java Specifications page: Set Prefix.
etPrefix

genOptJavaS | Java Specifications page: Source code
ourceExtensi | extension.
on

genOptPHPD = PHP Specifications page: Default Source
efaultSource = Directory.
Directory

genOptPHPG | PHP Specifications page: Get Prefix.
etPrefix

genOptPHPS | PHP Specifications page: Set Prefix.
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etPrefix

genOptPHPS | PHP Specifications page: Default file
ourceExtensi | extension.
on

genOptPHPV | PHP Specifications page: PHP Version.
ersion

genOptPrope | 'Source Code Engineering' page: Remove
rtyPrefix prefixes when generating Get/Set
properties.

genOptVBM | VB Specifications page: 'Multiuse'
ultiUse checkbox.

genOptVBPe = VB Specifications page: 'Persistable’
rsistable checkbox.

genOptVBDa @ VB Specifications page: 'Data binding
taBindingBeh behavior' checkbox.
avior

genOptVBDa @ VB Specifications page: 'Data source
taSourceBeha behavior' checkbox.
vior

genOptVBGI | VB Specifications page: 'Global
obal namespace' checkbox.
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genOptVBCr
eatable

genOptVBEX
posed

genOptVBM
TS

genOptVBNe
tGenNamesp
ace

genOptVBVe
rsion

genOptWrap
Comment
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VB Specifications page: 'Creatable’
checkbox.

VB Specifications page: 'Exposed'
checkbox.

VB Specifications page: MTS
Transaction Mode.

VB.Net Specifications page: Generate
Namespace.

VB Specifications page: Default Version.

'Source Code Engineering' page: Wrap
length for comment lines.
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Connector Field Substitution Macros

This table lists each of the connector field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Connector Macros

Macro Name | Description

connectorAli | Connector 'Properties' dialog: 'Alias'
as field.

connectorAss The GUID of the connector's Association

ociationClass @ Class element.
ElemGUID

connectorAss The name of the connector's Association
ociationClass | Class element.
ElemName

connectorDes = Connector 'Properties' dialog, "Target
tAccess Role' tab: Access.

connectorDes = Connector 'Properties' dialog, 'Target
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tAggregation = Role' tab: Aggregation.

connectorDes = Connector 'Properties' dialog, 'Target
tAlias Role' tab: Alias.

connectorDes = Connector 'Properties' dialog, 'Target
tAllowDuplic = Role' tab: 'Allow Duplicates' checkbox.
ates

connectorDes = Connector 'Properties' dialog, 'Target
tChangeable = Role' tab: Changeable.

connectorDes = Connector 'Properties' dialog, 'Target
tConstraint Role' tab: Constraint(s).

connectorDes = Connector 'Properties' dialog, 'Target
tContainment Role' tab: Containment.

connectorDes = Connector 'Properties' dialog, "Target
tDerived Role' tab: 'Derived' checkbox.

connectorDes = Connector 'Properties' dialog, 'Target
tDerivedUnio @ Role' tab: 'DerivedUnion' checkbox.
n

connectorDes = A set of macros that access a property of

tElem™ the element at the target end of a
connector. The * (asterisk) 1s a wildcard
that corresponds to any Class substitution
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macro in the Class macro list. For
example:

. connectorDestElemAlias (classAlias)

. connectorDestElemAuthor
(classAuthor)

connectorDes = The element type of the connector

tElemType destination element. (Separate from the
connectorDestElem™ macros because
there is no classType substitution macro.)

connectorDes = A set of macros that access a property of

tFeature™ the feature at the target end of a
connector. The * (asterisk) 1s a wildcard
that corresponds to any attribute or
operation substitution macro in the
Attribute macro or Operation macro list,
depending on the
connectorDestFeatureType.

For example:

. connectorDestFeatureReturnClassifier
GUID - an operation's return classifier
GUID

. connectorDestFeatureContainment - an
attribute's containment

connectorDes = The type of the connector destination
tFeatureType feature.
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connectorDes
tMemberTyp
e

connectorDes
tMultiplicity

connectorDes
tNavigability

connectorDes
tNotes

connectorDes
tOrdered

connectorDes
tOwned

connectorDes
tQualifier

connectorDes
tRole

connectorDes
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. connectorDestFeatureType="Attribute"

or "Operation"

Connector 'Properties' dialog, 'Target
Role' tab: Member Type.

Connector 'Properties' dialog, "Target
Role' tab: Multiplicity.

Connector 'Properties' dialog, "Target
Role' tab: Navigability.

Connector 'Properties' dialog, 'Target
Role' tab: Role Notes.

Connector 'Properties' dialog, "Target
Role' tab: 'Ordered' checkbox.

Connector 'Properties' dialog, "Target
Role' tab: 'Owned' checkbox.

Connector 'Properties' dialog, "Target
Role' tab: Qualifier(s).

Connector 'Properties' dialog, 'Target
Role' tab: Role.

Connector 'Properties' dialog, "Target
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tScope Role' tab: Target Scope.

connectorDes = Connector 'Properties' dialog, 'Target
tStereotype Role' tab: Stereotype.

connectorDir = Connector Properties: Direction.
ection

connectorEff = '"Transition Constraints' dialog: 'Effect’
ect field.

connectorGu  'Object Flow' and '"Transition Constraints'
ard dialogs: 'Guard' field.

connectorGU | The unique GUID for the current
ID connector.

connectorIsA | True, if the connector 1s an
ssociationCla = AssociationClass connector.
SS

connectorNa = Connector Properties: Name.
me

connectorNot = Connector Properties: Notes.
es

connectorSou = Connector 'Properties' dialog, 'Source
rceAccess Role' tab: Access.
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connectorSou
rceAggregati
on

connectorSou
rceAlias

connectorSou
rceAllowDup
licates

connectorSou
rceChangeabl
e

connectorSou
rceConstraint

connectorSou
rceContainm
ent

connectorSou
rceDerived

connectorSou
rceDerivedU
nion
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Connector 'Properties' dialog, 'Source
Role' tab: Aggregation.

Connector 'Properties' dialog, 'Source
Role' tab: Alias.

Connector 'Properties' dialog, 'Source
Role' tab: Allow Duplicates checkbox.

Connector 'Properties' dialog, 'Source
Role' tab: Changeable.

Connector 'Properties' dialog, 'Source
Role' tab: Constraint(s).

Connector 'Properties' dialog, 'Source
Role' tab: Containment.

Connector 'Properties' dialog, 'Source
Role' tab: 'Derived' checkbox.

Connector 'Properties' dialog, 'Source
Role' tab: 'DerivedUnion' checkbox.
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connectorSou = A set of macros that access a property of

rceElem™ the element at the source end of a
connector. The * (asterisk) is a wildcard
that corresponds to any Class substitution
macro in the Class macro list. For
example:

. connectorSourceElemAlias (classAlias)

. connectorSourceElemAuthor
(classAuthor)

connectorSou = The element type of the connector source

rceElemType element. (Separate from the
connectorSourceElem™ macros because
there 1s no classType substitution macro.)

connectorSou = A set of macros that access a property of

rceFeature* the feature at the source end of a
connector. The * (asterisk) is a wildcard
that corresponds to any attribute or
operation substitution macro in the
Attribute macro or Operation macro list,
depending on the
connectorSourceFeatureType. For
example:

. connectorSourceFeatureCode -
Operation's Code

. connectorSourceFeaturelnitial -
Attribute's Initial
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connectorSou = The type of the connector source feature.

rcekFeatureTy | . connectorSourceFeatureType="Attribut
pe e" or "Operation"

connectorSou = Connector 'Properties' dialog, 'Source
rceMemberT @ Role' tab: Member Type.

ype

connectorSou = Connector 'Properties' dialog, 'Source
rceMultiplicit = Role' tab: Multiplicity.

y

connectorSou = Connector 'Properties' dialog, 'Source
rceNavigabili  Role' tab: Navigability.

ty

connectorSou = Connector 'Properties' dialog, 'Source
rceNotes Role' tab: Role Notes.

connectorSou = Connector 'Properties' dialog, 'Source
rceOrdered Role' tab: 'Ordered' checkbox.
connectorSou = Connector 'Properties' dialog, 'Source
rceOwned Role' tab: 'Owned' checkbox.
connectorSou = Connector 'Properties' dialog, 'Source
rceQualifier | Role' tab: Qualifier(s).

(c) Sparx Systems 2019
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connectorSou = Connector 'Properties' dialog, 'Source
rceRole Role' tab: Role.

connectorSou = Connector 'Properties' dialog, 'Source
rceScope Role' tab: Target Scope.

connectorSou = Connector 'Properties' dialog, 'Source
rceStereotype = Role' tab: Stereotype.

connectorSter = Connector 'Properties' dialog: 'Stereotype’
eotype field.

connectorTri | '"Transition Constraints' dialog: 'Trigger’
gger field.

connectorTyp = The connector type; f or example,
e Association or Generalization.

connectorWe | 'Object Flow Constraints' dialog: 'Weight'
ight field.
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Constraint Field Substitution Macros

This table lists each of the 'Constraint' field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Constraint Macros

Macro Name | Description

constraintNa | 'Class' dialog, 'Constraints' tab: Name.
me

constraintNot | 'Class' dialog, 'Constraints' tab: Notes.
es

constraintStat = 'Class' dialog, 'Constraints' tab: Status.
us

constraintTyp | 'Class' dialog, 'Constraints' tab: Type.
e

constraintWe | 'Class' dialog, 'Constraints' tab: ordering
ight (hand up/down) keys.
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Effort Field Substitution Macros

This table lists each of the 'Effort' field substitution macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Effort Macros

Macro Name Description

effortName Effort window: Effort.
effortNotes Effort window: Notes (unlabelled).
effortTime Effort window: Time.

effortType Effort window: Type.
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File Field Substitution Macros

This table lists each of the file field substitution macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

File Macros

Macro Name Description

fileExtension | The file type extension of the file being
generated.

fileName The name of the file being generated.

fileNamelmp @ The filename of the implementation file
1 for this generation, if applicable.

fileHeaders 'Code Gen' dialog: Headers.

fileImports 'Code Gen' dialog: Imports. For supported
languages this also includes dependencies
derived from these types of relationship:

. Aggregation
. Association
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. Attribute classifier

. Method return type

. Method parameter classifier
. Generalization

. Realization (to interface)

. Template Binding (C++)

. Dependency

filePath The full path of the file being generated.

filePathimpl | The full path of the implementation file
for this generation, if applicable.
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File Import Field Substitution Macros

This table lists each of the file import field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of T
if the box 1s selected. Otherwise the value is empty.

File Import Macros

Macro Name | Description

importClassN | The name of the Class being imported.
ame

importFileNa = The filename of the Class being
me imported.

importFilePat = The full path of the Class being imported.
h

importFromA | T if the Class has an Aggregation
ggregation connector to a Class in this file, F
otherwise.

importFromA | T if the Class has an Association
ssociation connector to a Class in this file, F
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importFromA
tt

importFromD
ependency

importFromG
eneralization

importFrom
Meth

importFromP
aram

importFromP
roperty Type

importFromR
ealization

importFromT
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otherwise.

T 1f an attribute of a Class in the current
file 1s of the type of this Class, F
otherwise.

T 1f the Class has a Dependency
connector to a Class 1n this file, F
otherwise.

T 1f the Class has a Generalization
connector to a Class in this file, F
otherwise.

T 1f a method return type of a Class in the
current file is the type of this Class, F
otherwise.

T if a method parameter of a Class in the
current file is of the type of this Class;
otherwise F.

T 1f the Class has a property (Part/Port)
typing to another Class, F otherwise.

T if the Class has a Realization connector
to a Class 1n this file, F otherwise.

T 1f the Class has a TemplateBinding
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emplateBindi = connector to a Class in this file, F
ng otherwise.

importInFile | T if the Class is in the current file, F
otherwise.

importPackag The Package path with a'.' separator of
c¢Path the Class being imported.

ImportRelati = The relative file path of the Class being
veFilePath imported from the file path of the file
being generated.
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Link Field Substitution Macros

If you want to provide access to data concerning connectors
in the model, particularly Associations and Generalizations,
you can use the 'Link field substitution' macros. The macro
names are in Camel casing. Macros that represent
checkboxes return a value of 'T" if the box 1s selected;
otherwise the value is empty.

Link Macros

Macro Name | Description/Result

linkAttAcces @ Association 'Properties' dialog, Target
S Role: 'Access' field.

linkAttAggre = Association 'Properties' dialog, Source or
gation Target Role: Aggregation.

linkAttCollec = The collection appropriate for the linked
tionClass attribute in scope.

linkAttContail = Association 'Properties' dialog, Target
nment Role: Containment.

linkAttName | 'Association Properties' dialog: Target.
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linkAttNotes

linkAttOwne
dByAssociati
on

linkAttOwne
dByClass

linkAttQualN
ame

linkAttRole

linkAttRole A
lias

linkAttStereo
type

linkAttTarget
Scope

linkCard
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Association 'Properties' dialog, Target
Role: Role Notes.

True, 1f the 'Owned' checkbox on the
'Role(s)' page of the Association
'Properties' dialog 1s not selected.

True, 1f the 'Owned' checkbox on the
'Role(s)' page of the Association
'Properties' dialog is selected.

The Association target qualified by the
namespace path (if generating
namespaces) and the classifier path (dot
delimited).

Association 'Properties' dialog, Target
Role: Role.

'Association Properties Target Role'
dialog: Alias

Association 'Properties' dialog, Target
Role: Stereotype.

Association 'Properties' dialog, Target
Role: Target Scope.

Link 'Properties' dialog, Target Role:
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Multiplicity.

linkGUID The unique GUID for the current
connector.

linkIsAssocia | True, if the Association is an
tionClass AssociationClass connector.

linkIsBound | Returns T if any TemplateBindings are
specified on the connector.

linkParamSu | Returns a comma-separated list of the
bs arguments specified.

linkParentNa = Generalization 'Properties' dialog: 'Target'
me field.

linkParentQu = The Generalization target qualified by the
alName namespace path (if generating

namespaces) and the classifier path (dot
delimited).

linkStereotyp = The stereotype of the current connector.
e

linkVirtualln = Generalization 'Properties' dialog: "Virtual
heritance Inheritance' field.
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Linked File Field Substitution Macros

This table lists each of the 'Linked File' field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Linked File Macros

Macro Name | Description

linkedFileLas @ Class 'Properties' dialog: 'Files' tab, 'Last
tWrite Write' field.

linkedFileNot = Class 'Properties' dialog: 'Files' tab,
es 'Notes' field.

linkedFilePat = Class 'Properties' dialog: 'Files' tab, 'File
h Path' field.

linkedFileSiz | Class 'Properties' dialog: 'Files' tab, 'Size'
e field.

linkedFileTy | Class 'Properties' dialog: 'Files' tab, "Type'
pe field.
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Metric Field Substitution Macros

This table lists each of the Metric field substitution macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Metric Macros

Macro Name Description

metricName = Metrics screen: 'Metric' field.
metricNotes | Metrics screen: (Notes) field.
metricType Metrics screen: '"Type' field.

metricWeight = Metrics screen: "Weight' field.
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Operation Field Substitution Macros

The 'Operation field substitution' macros provide access to
data concerning operations in the model. The macro names
are in Camel casing. Macros that represent checkboxes
return a value of 'T" if the box is selected; otherwise the
value is empty.

Operation field substitution macros

Macro Name | Description/Result

opAbstract 'Operation’ dialog: 'Virtual' checkbox.

opAlias 'Operation' dialog: Alias.

opBehavior 'Operation Behavior' dialog: Behavior.

opCode 'Operation Behavior' dialog: Behavior
Code.

opConcurren | 'Operation' dialog: Concurrency.
Cy

opConst 'Operation' dialog: 'Const' checkbox.

opGUID The unique GUID for the current

(c) Sparx Systems 2019 Page 487 of 674



User Guide - Software Models

opHasSelfRe
fParam

opImplMacro
S

oplsQuery

opMacros

opName
opNotes
opPure

opReturnArra
y

opReturnClas
sifierGUID
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operation.

Scans the list of parameters in the current
Operation, returning "T" if one type is the
Class reference (this could be ClassA* or
ClassA&, depending on the value of the
genOptCOperationRefParamStyle code
generation option field substitution
macro).

A space-separated list of macros defined
in the implementation of this operation.

'Operation’ dialog: 'IsQuery' checkbox.

A space-separated list of macros defined
in the declaration for this operation.

'Operation' dialog: Name.
'Operation' dialog: Notes.
'Operation' dialog: 'Pure' checkbox.

'Operation' dialog: 'Return Array'
checkbox.

The unique GUID for the classifier of the
current operation.
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opReturnQua = The operation return type qualified by the

IType namespace path (if generating
namespaces) and the classifier path (dot
delimited). If the return type classifier has
not been set, it is equivalent to the
opReturnType macro.

opReturnTyp | 'Operation' dialog: Return Type.
e

opScope 'Operation' dialog: Scope.
opStatic 'Operation' dialog: 'Static' checkbox.
opStereotype | 'Operation' dialog: Stereotype.

opSynchroniz = 'Operation' dialog: 'Synchronized'
ed checkbox.
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Package Field Substitution Macros

This table lists the Package Field Substitution macros.

Field Substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Package Macros

Macro Name Description

packageAbstr Package dialog: Abstract.
act

packageAlias | Package dialog: Alias.

packageAuth | Package dialog: Author.
or

packageCom  Package dialog: Complexity.
plexity

packageGUI  The unique GUID for the current
D Package.

packageKey  Package dialog: Keywords.
words
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packageLang @ Package dialog: Language.
uage

packageNam @ Package dialog: Name.
e

packagePath | The string representing the hierarchy of
Packages, for the Class in scope. Each
Package name 1s separated by a dot (.).

packagePhas  Package dialog: Phase.
e

packageScop @ Package dialog: Scope.
e

packageStatu = Package dialog: Status.
S

packageStere = Package dialog: Stereotype.
otype

packageVersi Package dialog: Version.
on
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Parameter Field Substitution Macros

This table lists each of the Parameter field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Parameter Macros

Macro Name | Description

paramClassifi | The unique GUID for the classifier of the
erGUID current parameter.

paramDefault = Operation 'Parameters' dialog: 'Default’
field.

paramFixed | Operation 'Parameters' dialog: 'Fixed'
checkbox.

paramGUID | The unique GUID for the current
parameter.

paramlIsEnu | True, if the parameter uses the enum
m keyword (C++).

(c) Sparx Systems 2019 Page 492 of 674



User Guide - Software Models 7 August, 2019

paramKind Operation 'Parameters' dialog: 'Kind'
field.

'

paramName | Operation 'Parameters' dialog: "Name
field.

paramNotes | Operation 'Parameters' dialog: 'Notes'
field.

paramQualTy = The parameter type qualified by the

pe namespace path (if generating
namespaces) and the classifier path (dot
delimited). If the parameter classifier has
not been set, 1s equivalent to the
paramType macro.

paramType Operation 'Parameters' dialog: "Type'
field.
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Problem Field Substitution Macros

This table lists each of the Problem field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Problem Macros

Macro Name | Description

problemCom | 'Maintenance' dialog, 'Element Issues'
pletedBy tab: Completed by.

problemCom | 'Maintenance' dialog, 'Element Issues'
pletedDate tab: Completed.

problemHisto | 'Maintenance' dialog, 'Element Issues'
ry tab: History.

problemNam | 'Maintenance' dialog, 'Element Issues'
e tab: Name.

problemNote | 'Maintenance' dialog, 'Element Issues'
S tab: Description.
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problemPrior | 'Maintenance' dialog, 'Element Issues'
ity tab: Priority.

problemRaise | 'Maintenance' dialog, 'Element Issues'
dBy tab: Raised by.

problemRaise | 'Maintenance' dialog, 'Element Issues'
dDate tab: Raised.

problemStatu = 'Maintenance' dialog, 'Element Issues'
S tab: Status.

problemVersi | 'Maintenance' dialog, 'Element Issues'
on tab: Version.
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Requirement Field Substitution
Macros

This table lists each of the Requirement field substitution
macros with a description of the result.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" 1if the box is selected. Otherwise the value 1s empty.

Requirement Macros

Macro Name | Description

requirementD = 'Properties' dialog: 'Require' tab:
ifficulty Difficulty.

requirementl. | 'Properties' dialog: 'Require’ tab: Last
astUpdated Update.

requirementN = 'Properties' dialog: 'Require' tab: Short
ame Description.

requirementN = 'Properties' dialog: 'Require’ tab: Notes.
otes

requirementP | 'Properties' dialog: 'Require' tab: Priority.
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riority

requirementS | 'Properties' dialog: 'Require’ tab: Status.
tatus

requirementT = 'Properties' dialog: 'Require’ tab: Type.
ype
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Resource Field Substitution Macros

This table lists each of the Resource field substitution
macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Resource Macros

Macro Name | Description

resourceAllo | Resource Allocation window: Allocated
catedTime Time.

resourceEnd | Resource Allocation window: End Date.
Date

resourceExpe  Resource Allocation window: Expected
ctedTime Time.

resourceExpe = Resource Allocation window: Time
ndedTime Expended.

resourceHisto = Resource Allocation window: History.
1y
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resourceNam
e

resourceNote
S

resourcePerc

entComplete
d

resourceRole

resourceStart
Date
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Resource Allocation window

7 August, 2019

: Resource.

Resource Allocation window:

Description.

Resource Allocation window:

Completed(%).

Resource Allocation window

Resource Allocation window

- Role.

- Start Date.
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Risk Field Substitution Macros

This table lists each of the Risk field substitution macros.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Risk Macros

Macro Name Description

riskName Risks window: Risk.
riskNotes Risks window: (Notes).
riskType Risks window: Type.

riskWeight Risks window: Weight.
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Scenario Field Substitution Macros

This table lists each of the Scenario field substitution
macros with a description of the result.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Scenario Macros

Macro Name | Description
scenarioGUI = The unique ID for a scenario. Identifies
D the scenario unambiguously within a

model.

scenarioNam  'Properties' dialog, 'Scenario' tab:
e Scenario.

scenarioNote = 'Properties' dialog, 'Scenario' tab: (Notes).
S

scenarioType = 'Properties' dialog, 'Scenario' tab: Type.
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Tagged Value Substitution Macros

Tagged Value macros are a special form of field substitution
macros, which provide access to element tags and the
corresponding Tagged Values. They can be used in one of
two ways:

. Direct Substitution
. Conditional Substitution

Direct Substitution

This form of the macro directly substitutes the value of the
named tag into the output.

Structure: %e<macroName>:"<tagName>"%
<macroName> can be one of:
. attTag

. classTag

. connectorDestElemTag

. connectorDestTag

. connectorSourceElemTag
. connectorSourceTag

. connectorTag

. linkAttTag

. linkTag

. opTag
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. packageTag
. paramTag

This corresponds to the tags for attributes, Classes,
operations, Packages, parameters, connectors with both
ends, elements at both ends of connectors and connectors
including the attribute end.

<tagNName> 1s a string representing the specific tag name.

Example

%opTag:"attribute"%

Conditional Substitution

This form of the macro mimics the conditional substitution
defined for field substitution macros.

Structure: %o<macroName>:"<tagName>" (== "<test>") ?
<subTrue> (: <subFalse>) %

Note:
. <macroName> and <tagName> are as defined here
. (<text>) denotes that <text> is optional

. <test> is a string representing a possible value for the
macro

. <subTrue> and <subFalse> can be a combination of
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quoted strings and the keyword value; where the value is
used, it gets replaced with the macro's value in the output

Examples

%opTag:"oplnline" ? "inline" : ""%
%opTag:"opInline" ? "inline"%
%classTag:"unsafe" == "true" ? "unsafe" : ""%
%classTag:"unsafe" == "true" ? "unsafe"%

Tagged Value macros use the same naming convention as
field substitution macros.
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Template Parameter Substitution
Macros

If you want to provide access in a transformation template to
data concerning the transformation of a Template Binding
connector's binding parameter substitution in the model, you
can use the Template Parameter substitution macros. The
macro names are in Camel casing. Macros that represent
checkboxes return a value of '"T" if the box is selected;
otherwise the value 1s empty.

Template Parameter substitution macros

Macro Name Description

parameterSub  'Template Binding Properties' dialog,

stitutionForm | 'Binding Parameter' tab, 'Parameter

al Substitution(s)' panel: Formal Template
Parameter name.

parameterSub "Template Binding Properties' dialog,

stitutionActu = 'Binding Parameter' tab, 'Parameter

al Substitution(s)' panel: Actual parameter
name/expression.

parameterSub = 'Template Binding Properties' dialog,
stitutionActu | 'Binding Parameter' tab, 'Parameter
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alClassifier Substitution(s)' panel: Actual parameter
classifier.
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Test Field Substitution Macros

This table lists each of the Test field substitution macros
with a description of the result.

Field substitution macros are named according to Camel
casing. Macros that represent checkboxes return a value of
"T" if the box is selected. Otherwise the value 1s empty.

Test Macros

Macro Name | Description

testAcceptan | Testing window: Acceptance Criteria.
ceCriteria

testCheckedB = Testing window: Checked By.
y

testDateRun | Testing window: Last Run.

testClass Testing window: Test Class (the type of
test defined: Unit, Integration, System,
Acceptance, Inspection, Scenario)

testInput Testing window: Input.

testName Testing window: Test.
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testNotes Testing window: Description.
testResults Testing window: Results.

testRunBy Testing window: Run By. (Values are
derived from the Project Author
definitions in the 'People’ dialog -
'Configure > Reference Data > Model
Types > People > Project Authors'.)

testStatus Testing window: Status.

testType Testing window: Type.
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Function Macros

Function macros are a convenient way of manipulating and
formatting various element data items. Each function macro
returns a result string. There are two primary ways to use the
results of function macros:

. Direct substitution of the returned string into the output,
such as: %TO LOWER(attName)%

. Storing the returned string as part of a variable definition
such as: $name = %TO LOWER(attName)%

Function macros can take parameters, which can be passed
to the macros as:

. String literals, enclosed within double quotation marks

. Direct substitution macros without the enclosing percent
signs

. Variable references

. Numeric literals

Multiple parameters are passed using a comma-separated
list.

Function macros are named according to the All-Caps style,
as in:
%CONVERT SCOPE(opScope)%

The available function macros are described here.
Parameters are denoted by square brackets, as in:

FUNCTION NAME([param]).
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CONVERT_SCOPE([umIiScopel])

For use with supported languages, to convert [umlScope] to
the appropriate scope keyword for the language being
generated. This table shows the conversion of [umlScope]
with respect to the given language.

Language

C++

C#

Delphi

Java

(c) Sparx Systems 2019

Conversions

Package ==> public
Public ==> public
Private ==> private
Protected ==> protected

Package ==> internal
Public ==> public
Private ==> private
Protected ==> protected

Package ==> protected
Public ==> public
Private ==> private
Protected ==> protected

Package ==> {blank}
Public ==> public
Private ==> private
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Protected ==> protected

PHP Package ==> public
Public ==> public
Private ==> private
Protected ==> protected

VB Package ==> Protected
Public ==> Public
Private ==> Private
Protected ==> Protected

VB .Net Package ==> Friend
Public ==> Public
Private ==> Private
Protected ==> Protected

COLLECTION_CLASS([language])

Gives the appropriate collection Class for the language
specified for the current linked attribute.

CSTYLE_COMMENT([wrap_length])
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Converts the notes for the element currently in scope to
plain C-style comments, using /* and */.

DELPHI_PROPERTIES([scope], [separator],
[indent])

Generates a Delphi property.

DELPHI_COMMENT([wrap_length])

Converts the notes for the element currently in scope to
Delphi comments.

EXEC_ADD _IN(, [function_name],, ...,)

Invokes an Enterprise Architect Add-In function, which can
return a result string.

[addin name] and [function name] specify the names of the
Add-In and function to be invoked.

Parameters to the Add-In function can be specified via
parameters [prm_1] to [prm_n].
$result = %EXEC ADD IN("MyAddin",
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"ProcessOperation", classGUID, opGUID)%

Any function that is to be called by the EXEC ADD IN
macro must have two parameters: an EA.Repository object,
and a Variant array that contains any additional parameters
from the EXEC ADD IN call. Return type should be
Variant.

Public Function ProcessOperation(Repository As
EA.Repository, args As Variant) As Variant

FIND([src], [subString])

Position of the first instance of [subString] in [src]; -1 if
none.

GET_ALIGNMENT()

Returns a string where all of the text on the current line of
output i1s converted into spaces and tabs.

JAVADOC_COMMENT([wrap_length])

Converts the notes for the element currently in scope to
javadoc -style comments.
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LEFT([src], [count])

The first [count] characters of [src].

LENGTH([src])

Length of [src]. Returns a string.

MATH_ADD(x,y) MATH_MULT(x,y) and
MATH_SUB(x,y)

In a code template or DDL template, these three macros
perform, respectively, the mathematical functions of:

. Addition (x+y)
. Multiplication (x*y) and
. Subtraction (x-y)

The arguments x and y can be integers or variables, or a
combination of the two. Consider these examples, as used in
a 'Class' template for C++ code generation:

. $a=%MATH ADD(3,4)%

. $b=%MATH SUB(10,3)%

. $c=%MATH MULT(2,3)%
. $d=%MATH ADD($a,$b)%
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. $¢ =%MATH _SUB($b,$¢)%

. $f=%MATH MULT($a,$b)%

. $g=%MATH MULT($a,10)%

. $h=%MATH MULT(10,$b)%

These compute, in the same sequence, to:

.a=3+t4=9%a
. b=10-3=%b
. c=2%*3=8%c
. d=at+b=%d
. e=b-c=$%e¢
. f=a*b=9%f

. g=a*10=39g

. h=10*b=3%h

When the code is generated, the .h file (for C++) contains
these corresponding strings:

. a=3+4=7
. b=10-3=7
. Cc=2%3=6
. d=a+b=14
. e=b-c=1
. f=a*b=49

. g=a*10=70
. h=10*b=70
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MID([src], [start]) MID([src], [start], [count])

Substring of [src] starting at [start] and including [count]
characters. Where [count] is omitted the rest of the string 1s
included.

Pl([option], [value], {[option], [value]})

Sets the PI for the current template to [value]. Valid values
for [value] are:

. H\nﬂ
. "\t "

66 ¢¢

(1324

<option> controls when the new PI takes effect. Valid
values for <option> are:

. I, Immediate: the new PI is generated before the next
non-empty template line

. N, Next: the new PI is generated after the next non-empty
template line

Multiple pairs of options are allowed in one call. An
example of the situation where this would used is where one
keyword 1s always on a new line, as illustrated here:

%PI=" "%
%classAbstract ? "abstract"%
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%if classTag:"macro" !=""%
%PIC"T", "\n", "N", " ")%
%classTag:"macro"%
%endIf%

class

%className%

For more details, see The Processing Instruction (Pl)
Macro.

PROCESS END OBIJECT([template_name])

Enables the Classes that are one Class further away from the
base Class, to be transformed into objects (such as

attributes, operations, Packages, parameters and columns) of
the base Class. [template name] refers to the working
template that temporarily stores the data.

REMOVE_DUPLICATES([source], [separator])

Where [source] is a [separator] separated list; this removes
any duplicate or empty strings.

REPLACE([string], [old], [new])
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Replaces all occurrences of [old] with [new] in the given
string <string>.

RESOLVE_OP_NAME()

Resolves clashes 1in interface names where two method-from
interfaces have the same name.

RESOLVE_QUALIFIED_TYPE()
RESOLVE_QUALIFIED_TYPE([separator])
RESOLVE_QUALIFIED TYPE([separator],
[default])

Generates a qualified type for the current attribute, linked
attribute, linked parent, operation, or parameter. Enables the
specification of a separator other than. and a default value
for when some value 1s required.

RIGHT([src], [count])

The last [count] characters of [src].
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TO_LOWER([string])

Converts [string] to lower case.

TO_UPPER([string])

Converts [string] to upper case.

TRIM([string]) TRIM([string], [trimChars])

Removes trailing and leading white spaces from [string]. If
[trimChars] 1s specified, all leading and trailing characters in
the set of <trimChars> are removed.

TRIM_LEFT([string]) TRIM_LEFT([string],
[trimChars])

Removes the specified leading characters from <string>.

TRIM_RIGHT([string]) TRIM_RIGHT([string],
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[trimChars])

Removes the specified trailing characters from <string>.

VB_COMMENT([wrap_length])

Converts the notes for the element currently in scope to
Visual Basic style comments.

WRAP_COMMENT([comment],
[wrap_length], [indent], [start_string])

Wraps the text [comment] at width [wrap length] putting
[indent] and [start string] at the beginning of each line.

$behavior = %WRAP COMMENT (opBehavior, "40", "
", "//H)%
<wrap length> must still be passed as a string, even though
WRAP COMMENT treats this parameter as an integer.

WRAP_LINES([text], [wrap_length],
[start_string] {, [end_string] })

Wraps [text] as designated to be [wrap length], adding
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[start string] to the beginning of every line and [end _string]
to the end of the line 1f it 1s specified.

XML_COMMENT([wrap_length])

Converts the notes for the element currently in scope to
XML-style comments.

(c) Sparx Systems 2019 Page 521 of 674



User Guide - Software Models 7 August, 2019

Control Macros

Control macros are used to control the processing and
formatting of the templates. The basic types of control
macro include:

. The list macro, for generating multiple element features,
such as attributes and operations

. The branching macros, which form 1f-then-else constructs
to conditionally execute parts of a template

. The PI macro for formatting new lines in the output,
which takes effect from the next non-empty line

. A PI function macro that enables setting PI to a variable
and adds the ability to set the PI that 1s generated before
the next line

. The synchronization macros

In general, control macros are named according to Camel
casing.
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List Macro

If you need to loop or iterate through a set of Objects that
are contained within or are under the current object, you can
do so using the %list macro. This macro performs an
iterative pass on all the objects in the scope of the current
template, and calls another template to process each one.

The basic structure is:

Ylist=<TemplateName> (@separator=<string>
(@indent=<string> (<conditions>) %

where <string> is a double-quoted literal string and
<TemplateName> can be one of these template names:

. Attribute

. AttributeImpl
. Class

. ClassBase

. ClassImpl

. ClassInitializer
. ClassInterface
. Constraint

. Custom Template (custom templates enable you to define
your own templates)

. Effort
. InnerClass
. InnerClassImpl
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. LinkedFile
. Metric

. Namespace
. Operation

. OperationIlmpl
. Parameter

. Problem

. Requirement
. Resource

. Risk

. Scenario

. Test

<conditions> 1s optional and looks the same as the
conditions for 'if' and 'elself' statements.

Example

In a Class transform, the Class might contain multiple
attributes; this example calls the Attribute transform and
outputs the result of processing the transform for each
attribute of the Class in scope. The resultant list separates its
items with a single new line and indents them two spaces
respectively. If the Class in scope had any stereotyped
attributes, they would be generated using the appropriately
specialized template.

%list="Attribute" @separator="\n" @indent=" "%
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The separator attribute, denoted by (@separator, specifies the
space that should be used between the list items, excluding
the last item 1n the list.

The indent attribute, denoted by @indent, specifies the
space by which each line in the generated output should be
indented.

Special Cases

There are some special cases to consider when using the
%list macro:

. If the Attribute template is used as an argument to the
%Iist macro, this also generates attributes derived from
Associations by executing the appropriate
LinkedAttribute template

. If the ClassBase template is used as an argument to the
%Iist macro, this also generates Class bases derived from
links in the model by executing the appropriate
LinkedClassBase template

. If the ClassInterface template is used as an argument to
the %list macro, this also generates Class bases derived
from links in the model by executing the appropriate
LinkedClassInterface template

. If InnerClass or InnerClassImpl is used as an argument to
the %list macro, these Classes are generated using the
Class and ClassImpl templates respectively; these
arguments direct that the templates should be processed
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based on the inner Classes of the Class in scope
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Branching Macros

Branching macros provide if-then-else constructs. The CTF
supports a limited form of branching through these macros:

. if

. elself

. else

. endIf

. endTemplate (which exits the current template)

The basic structure of the if and elself macros is:
%if <test> <operator> <test>%

where <operator> can be one of:

=

. < (mathematics comparison, less than)

. > (mathematics comparison, greater than)

. <= (mathematics comparison, less than or equal to)

. >= (mathematics comparison, greater than or equal to)

and <test> can be one of:

. a string literal, enclosed within double quotation marks

. adirect substitution macro, without the enclosing percent
signs

. avariable reference

Note that if you are using one of the mathematics
comparison operators, <test> must be a decimal number in
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string format.

Branches can be nested, and multiple conditions can be
specified using one of:

. and, or
. Or

When specifying multiple conditions, 'and' and 'or' have the
same order of precedence, and conditions are processed left
to right.

If conditional statements on strings are case sensitive, 'a
String' does not equal 'A STRING'. Hence in some
situations it 1s better to set the variable

$str=TO LOWER(variable) or TO UPPER(variable) and
then compare to a specific case.

Macros are not supported in the conditional statements. It 1s
best to assign the results of a macro (string) to a variable,
and then use the variable in the comparison.

$fldType = % TO_LOWER ($parameter])%o

SCOMMENT = "Use the first 4 characters for Date and
Time field types"

$f1dTyped = % LEFT ($fldType, 4)%
%if $fldTyped == "date"%

Datetime

%endif%

This takes a parameter of value “Datetime”, “DATETIME”
or “Date”, and returns “Datetime”.

The endif or endTemplate macros must be used to signify
the end of a branch. In addition, the endTemplate macro
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causes the template to return immediately, if the
corresponding branch is being executed.

Example 1

%if elemType == "Interface"%

%else%

%OperationBody%

%endIf%

In this case:

. If the elemType is "Interface" a semi-colon is returned

. Ifthe elemType is not "Interface", a template called
Operation Body i1s called

Example 2

$bases="ClassBase"

$interfaces=""%

%if $bases !="" and $interfaces !=""%
: $bases, Sinterfaces

%elself $bases !=""%

: $bases

%elself $Sinterfaces !=""%
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: $interfaces
%endIf%
In this case the text returned 1s ':ClassBase'.

Conditions using Boolean Value

When setting up branching using conditions that involve a
system checkbox (boolean fields), such as Attribute.Static
(attStatic) the conditional statement would be written as:

%if attStatic == "T"%
For example:

% 1f attCollection == "T" or attOrderedMultiplicity ==
"TH %

% endTemplate %

(c) Sparx Systems 2019 Page 530 of 674



User Guide - Software Models 7 August, 2019

Synchronization Macros

The synchronization macros are used to provide formatting
hints to Enterprise Architect when inserting new sections
into the source code, during forward synchronization. The
values for synchronization macros must be set in the File
templates.

The structure for setting synchronization macros is:
%<name>=<value>%

where <name> can be one of the macros listed here and
<value> i1s a literal string enclosed by double quotes.

Synchronization Macros

Macro Name Description

synchNewCl @ Space to append to a new Class note.
assNotesSpac = Default value: \n.
e

synchNewAtt Space to append to a new attribute note.
ributeNotesS = Default value: \n.
pace

synchNewOp = Space to append to a new operation note.
erationNotes = Default value: \n.
Space
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synchNewQOp | Space to append to a new operation body.
erationBodyS = Default value: \n.
pace

synchNames @ Indent applied to Classes within

paceBodyInd non-global namespaces. Default value: \t.
ent

(c) Sparx Systems 2019 Page 532 of 674



User Guide - Software Models 7 August, 2019

The Processing Instruction (Pl) Macro

The PI (Processing Instruction) macro provides a means of
defining the separator text to be inserted between the code

pieces (which represent entities) that are generated using a

template.

The structure for setting the Processing Instruction is:
Y% PI=<value>%

In this structure, <value> is a literal string enclosed by
double quotes, with these options:

. "\n" - New line (the default)

"nn _ Space
. "\t" - Tab
. "mn _ Null

By default, the PI is set to generate a new line (\n) for each
non-empty substitution, which behavior can be changed by
resetting the PI macro. For instance, a Class’s Attribute
declaration in simple VB code would be generated to a
single line statement (with no new lines). These properties
are derived from the Class-Attribute properties in the model
to generate, for example:

Private Const PrintFormat As String = "Portrait"

The template for generating this starts with the PI being set
to a space rather than a new line:

%PI=""%
% CONVERT SCOPE (attScope)%
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% endIf %

% 1f attConst =—="T" %
Const

% endIf %

On transforming this, attscope returns the VB keyword
'Private' and attConst returns 'Const' on the same line spaced
by a single space (fitting the earlier VB Class.Attribute
definition example).

Alternatively, when generating a Class you might want the
Class declaration, the notes and Class body all separated by
double lines. In this case the %PI 1s set to '/n/n' to return
double line spacing:

% PI="\n\n" %
% ClassDeclaration %
% ClassNotes %
% ClassBody %

Pl Characteristics

. Blank lines have no effect on the output

. Any line that has a macro that produces an empty result
does not result in a PI separator (space/new line)

. The last entry does not return a PI; for example,
%Classbody% does not have a double line added after the
body
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Code Generation Macros for
Executable StateMachines

The templates listed here are available through the Code
Template Editor (the Develop > Preferences > Options >
Edit Code Templates' ribbon option); select
'STM_C++_Structured' in the 'Language’ field.

The templates are structured as shown here:

StmContextStateMachineEnum
StmStateMachineEnum

StmContextStateEnum
StmAIllStateEnum

StmContextTransitionEnum
StmTransitionEnum

StmContextEntryEnum
StmAIllEntryEnum

StmContextStateMachineStringToEnum
StmStateMachineStringToEnum
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StmContextStateEnumToString
StmStateEnumToString

StmContextTransitionEnumToString
StmTransitionEnumToString

StmContextStateNameToGuid
StmStateNameToGuid

StmContextTransitionNameToGuid
StmTransitionNameToGuid

StmContextDefinition
StmStateMachineEnum
StmAllStateEnum
StmTransitionEnum
StmAIllEntryEnum
StmAllRegionVariablelnitialize
StmStateWithDeferredEvent

StmDeferredEvent
StmTransitionProcMapping
StmTransitionProc

StmTransitionExit

StmTransitionEntry

StmTargetOutgoingTransition
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StmTargetParentSubmachineState
StmStateProcMapping
StmStateProc
StmStateEntry
StmOutgoingTransition
StmConnectionPointReferenceEntry
StmParameterizedInitial
StmSubMachinelnitial
StmRegionlnitial
StmRegionDeactive
StmStateExitProc
StmStateTransition
StmStateEvent
StmStateTriggered Transition
StmStateCompletionTransition
StmStateIncomingTransition
StmStateOutgoingTransition
StmSubmachineStateExitEvent
StmVertexOutgoingTransition
StmConnectionPointReferenceExitEvent
StmStateExitEvent
StmVertexOutgoingTransition
StmAllRegionVariable
StmStateMachineStringToEnum
StmStateMachineRun
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StmStatelnitialData
StmStateMachineEntry
StmOutgoingTransition
StmStateMachineRunlInitial
StmStateMachinelnitial
StmStateMachineRuns

StmContextManager

StmSimulationManager
StmContextInstanceDeclaration
StmContextInstance

StmContextVariableRunstate
StmContextInstance Association
StmContextInstanceClear

StmEventProxy
StmSignalEnum
StmContextJoinEventEnum
StmJoinEventEnum
StmEventEnum
StmSignalDefinition
StmSignal Attribute Assignment
StmSignal Attribute
StmSignallnitialize
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StmEventStringToEnum
StmEventEnumToString
StmEventNameToGuid
StmConsoleManager
StmContextInstanceDeclaration
StmContextInstance
StmContextVariableRunstate
StmContextlnstance Association
StmContextlnstanceClear
StmStateMachineStrongToEnum
StmlInitialForTransition
StmVertextOutgoingTransition
StmSendEvent
StmBroadcastEvent

StmContextres

Signal & Event

(c) Sparx Systems 2019
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Macro name

stmEventEnu
m

StmEventGui
d

stmEventNa
me

stmEventVari
able

stmlsSignalE
vent

stmSignalEn
um

stmSignalFirs
tEvent

stmSignalGui
d

stmSignalNa

(c) Sparx Systems 2019
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Description

The name of the Event with the prefix
'ENUM ', all upper case.

The GUID of the Event.

The name of the Event with spaces and
asterixes removed.

The name of the Event with the prefix
'm_'1n lower case.

Is 'T" if the element is a SignalEvent.

The name of the Signal with the prefix
'ENUM ', all upper case.

The name of the Event with the prefix
'ENUM ', all upper case.

The GUID of the Signal.

The name of the Signal with spaces and

Page 541 of 674



User Guide - Software Models 7 August, 2019

me asterixes removed.

stmSignalVar = The name of the Signal with the prefix
1able 'm_'1n lower case.

stmTriggerN | Transition Properties: The name of the
ame Trigger.

stmTriggerSp = Transition Properties: The specification
ecification of the Trigger.

stmTriggerTy Transition Properties: The type of the
pe Trigger.

Context

Macro name | Description

stmContextN | The name of the Class with spaces and
ame asterixes removed.

stmContextQ = The qualified name of the Class for
ualName which code is being generated.

stmContextV
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ariableName

stmContextF1 = The output file name for the Class for
leName which code is being generated.

Writing Object Runstate to StateMachine
Initialization

Macro name | Description

stmContextV
ariableRunsta
teName

stmContextV
ariableRunsta
teValue

stmContextH @ Is 'T'if the current context has one or
asStatemachi | more StateMachines.
ne

stmHasHistor = Is "T" if the StateMachine has a History
yPattern Pattern.
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stmStatemac
hineName

stmStatemac
hineEnum

stmStatemac
hineGuid

(c) Sparx Systems 2019
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stmHasTermi @ Is 'T' if the StateMachine has a Terminate
natePattern Pattern.
stmHasDefer @ Is 'T' if the StateMachine has a Deferred
redEventPatt = Event Pattern.
ern
stmHasSubm @ Is 'T" if the StateMachine has a
achinePattern | Submachine Pattern.
stmHasOrtho @ Is 'T' if the StateMachine has an
gonalPattern = Orthogonal Pattern.

StateMachine

Macro name | Description

The name of the StateMachine with
asterixes and spaces removed.

The name of the StateMachine plus
'ENUM ' plus the name of the
StateMachine in upper case.

The GUID of the StateMachine element.
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stmStateCou
nt

stmSubmachi
nelnitial Coun
t

stmStatemac
hineHasSub
machineState

stmStatemac
hinelnitialCo
unt

Region

Macro name
stmRegionEn

um

stmRegionF
QName

(c) Sparx Systems 2019

The number of State elements in the
StateMachine.

The number of Initial elements in the Sub
Machine State element.

Is '"T' if the StateMachine has at least one
SubMachine State.

The number of Initial elements in the
StateMachine.

Description
The name of the State Region plus

'ENUM ' plus the name of the State
Region in upper case.

The fully qualified name of the State
Region.
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stmRegionNa = The name of the State Region with spaces
me and asterixes removed.

stmRegionVa The name of the State Region with the
riable prefix 'm_'in lower case.

stmRegionF  The fully qualified name of the State
QVariable Region with the prefix 'm ' in lower case.

stmRegionGu The GUID of the Region.
id

stmRegionlni
tial

stmRegionls | Is "T" if the Region is owned by a

OwnedBySta = StateMachine.
teMachine

Transition

Macro name | Description

stmTransition =The name of the Transition with the
Enum prefix 'ENUM ', plus the name of the
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stmTransition
Guid

stmTransition
Name

stmTransition
SourceGuid

stmTransition
TargetGuid

stmTransition
Variable

stmTransition
SourceVariab
le

stmTransition
TargetVariab
le

stmTransition
FQVariable

stmSourceVe
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Transition in upper case.

The GUID of the Transition.

The name of the Transition with spaces
and asterixes removed.

The GUID of the Source element in the
Transition.

The GUID of the Target element in the
Transition.

The name of the Transition with the
prefix 'm_'in lower case.

The name of the Transition's source

Page 547 of 674



User Guide - Software Models

rtexEnum

stmTargetVer
texEnum

stmSourcelsl
nitial

stmSourcelsS
tate

stmSourcelsE
ntryPoint

stmSourcelsE
x1tPoint

stmSourcelsF
ork

stmSourcels]
oin

stmTargetlsF
nalState

stmTargetIsE
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vertex plus' ENUM' plus the name of the
Transition's source vertex in upper case.

The name of the Transition's target vertex
plus' ENUM' plus the name of the
Transition's target vertex in upper case.

Is 'T" if the Transition's source is an
Initial.

Is '"T" if the Transition's source is a State.

Is 'T" if the Transition's source is an Entry
Point.

Is 'T" if the Transition's source is an Exit
Point.

Is '"T" if the Transition's source is a Fork.

Is 'T" if the Transition's source is a Join
element.

Is 'T" if the Transition's target is a Final
State element.

Is 'T" if the Transition's target 1s an Exit
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x1tPoint

stmTargetlsS
tate

stmTargetlsC
hoice

stmTargetls]
unction

stmTargetlsE
ntryPoint

stmTargetlsC

onnectionPoi
ntReference

stmTargetIsF
ork

stmTargetls]
oin

stmTransition
Effect

stmTransition
Guard

(c) Sparx Systems 2019

Point element.

Is 'T" if the Transition's target is a State
element.

Is 'T" if the Transition's target is a Choice
clement.

Is 'T" if the Transition's target 1s a
Junction element.

Is 'T" if the Transition's target is an Entry
Point element.

Is 'T" if the Transition's target is a
Connection Point Reference element.

Is 'T" if the Transition's target is a Fork
element.

Is 'T" if the Transition's target is a Join
element.

The Effect of the Transition.

The Guard of the Transition.
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stmTransition
Kind

stmTargetInit
1alTransition

stmTargetlsS
ubmachineSt
ate

stmSourceSta
teEnum

stmTargetSta
teEnum

stmTargetVer
texFQName

stmTargetlsD
eepHistory

stmTargetlsS
hallowHistor

y

stmTargetlsT
erminate
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The type or kind of the Transition.

Is 'T" if the Transition's target is a
Submachine State.

The name of the Transition's source state
with the prefix ' ENUM' in upper case.

The name of the Transition's target state,
with the prefix ' ENUM' in upper case.

The fully qualified name of the
Transition's target vertex.

Is 'T" if the Transition's target 1s a Deep
History State.

Is 'T" 1f the Transition's target is a
Shallow History State.

Is 'T" if the Transition's target is a
Terminate element.
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stmParentlsSt
ateMachine

stmSourcePar
entStateEnu
m

stmTargetPar
entStateEnu
m

stmTargetSu
bmachineEnu
m

stmTargetRe
gionlndex

stmlIsSelfTra
nsition

stmHistoryO
wningRegion
Initial Transiti
on

stmDefaultHi

(c) Sparx Systems 2019

7 August, 2019

Is 'T" if the vertex is an Entry Point or
Exit Point, or if the container is a
StateMachine.

Is '"T' if the Transition's source i1s the same
as its target.
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storyTransiti
on

Vertex and State

Macro name | Description

stmVertexNa The name of the Vertex.
me

stmStateNam @ The name of the State.
e

stmVertexGu The GUID of the Vertex.
1d

stmVertexFQ ' The fully qualified name of the Vertex.
Name

stmStateFQN | The fully qualified name of the State.
ame

stmVertexTy @ The type of the vertex; one of 'State’',
pe 'FinalState', 'Pseudostate’,
'ConnectionPointReference' or ' ' (empty).
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stmPseudosta
teKind

stmPseudosta
teName

stmPseudosta
teVariable

stmPseudosta
teStateMachi
neName

stmPseudosta
teStateMachi
neVariable

stmVertexVa
riable

stmVertexEn

um

stmStateEnu
m
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The kind of the Pseudostate; one of
'initial', 'deepHistory', 'shallowHistory',
Join', 'fork’, 'junction’, 'choice’,
'entryPoint’, 'exitPoint' or 'terminate’.

The name of the Pseudostate.

The name of the Pseudostate with the
prefix 'm_'in lower case.

The name of the Pseudostate
StateMachine.

The name of the Pseudostate
StateMachine with the prefix 'm
lower case.

!

m

The name of the Vertex with the prefix
'm_'1n lower case.

The name of the Vertex plus' ENUM'
plus the name of the Vertex in upper
case.

The name of the State plus' ENUM' plus

the name of the State in upper case.
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stmConnectio = The name of the Connection Point
nPointRefere @ Reference.

nceStateNam

C

stmConnectio The name of the Connection Point
nPointRefere | Reference with the prefix 'm_'in lower
nceStateVari | case.

able

stmConnectio
nPointRefere
nceEntryCou
nt

stmParameter
1zedInitialCo
unt

stmlInitialCou
ntForTransiti
on

stmStateVari = The name of the State with the prefix 'm '
able in lower case.

stmStateEntr = The behavior defined for an 'entry' Action
yBehavior operation for a State (the text on the
'Behavior' tab for the 'entry' Action
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operation on the Features window for the
clement).

stmStateEntr = The initial code defined for an 'entry’

yCode Action operation for a State (the text for
the 'entry' Action operation on the
Behavior's 'Code' tab).

stmStateDoB = The behavior defined for a 'do' Action

chavior operation for a State (the text on the
'Behavior' tab for the 'do' Action
operation on the Features window for the
clement).

stmStateDoC = The initial code defined for a 'do’ Action
ode operation for a State (the text for the 'do'
Action operation on the Behavior's 'Code

tab).

!

stmStateExit = The behavior defined for an 'exit' Action

Behavior operation for a State (the text on the
'Behavior' tab for the 'exit' Action
operation on the Features window for the
clement).

stmStateExit = The initial code defined for an 'exit’

Code Action operation for a State (the text for
the 'exit' Action operation on the
Behavior's 'Code' tab).
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stmStateSub
machineNam
C

stmStateSub

machineVari
able

stmStatelsFin
al

stmStatelsSu
bmachineStat
e

stmSubMachi
neEnum

stmStateHas

ChildrenToJo
n

stmStatelsTra
nsitionTarget

stmThisIsSou
rce

(c) Sparx Systems 2019

The name of the Submachine.

The name of the Submachine with the
prefix 'm_'in lower case.

Is '"T' if the State is a FinalState.

Is 'T" if the State is a Submachine State
('Properties' page | Advanced |
'iIsSubmachineState' property).

The name of the Submachine followed by
' ENUM' plus the name of Submachine
1In upper case.
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stmThisIsSou
rceState

stmStatePare @ Is 'T' if the State's container is a
ntlsSubmachi = StateMachine.
ne

stmStateCont
ainerMatchTr
ansitionConta
Iner

stmVertexRe
gionIndex

stmStateRegi = The number of regions in the State.
onCount

stmStatelnitia The number of Initial elements in the
1Count StateMachine.

stmVertexCo
ntainerVariab
le

stmVertexPar
entEnum

c) Sparx Systems age o
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stmStateHas
UnGuardedC

ompletionTra
nsition
stmStateEven

tHasUnGuard
edTransition

stmlnitialTra
nsition

Instance Association

Macro name | Description

stmSourcelns
tanceName

stmTargetlnst
anceName

stmSourceRo
leName

stmTargetRol
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eName
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EASL Code Generation Macros

Enterprise Architect provides a number of Enterprise
Architect Simulation Library (EASL) code generation
macros to generate code from behavioral models. These are:

. EASL INIT
. EASL GET
. EASLList and
. EASL END

EASL_INIT

The EASL INIT macro is used to initialize an EASL
behavior model. The behavior model code generation 1s
dependent on this model.

Aspect Description
Syntax %EASL INIT(<<GUID>>)%
where:

. <<GUID>> is the GUID of the Object
(usually a Class element) that is the
owner of the behavior model

EASL_GET
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The EASL GET macro is used to retrieve a property or a
collection of an EASL object. The EASL objects and the
properties and collections for each object are 1dentified in
the EASL Collections and EASL Properties topics.

Aspect Description

Syntax $result = %EASL GET(<<Property>>,
<<Owner ID>>, <<Name>>)%
where:

. <<Property>> is one of "Property",
"Collection", "At", "Count", or
"IndexOf"

. <<OwnerID>> is the ID of the owner
object for which the property/collection
1s to be retrieved

. <<Name>> 1s the name of the property
or Collection being accessed

. $result is the returned value; this is
if not a valid property

If <<Property>> is:

. "At", then <<OwnerID>> is the ID of a
collection and <<Name>> 1s the index
into the collection for which the item 1is
to be retrieved

. "Count", then <<Owner ID>> is the ID

of a collection and <<Name>> is not
used; it will retrieve the item number in

(155

(c) Sparx Systems 2019 Page 561 of 674



User Guide - Software Models 7 August, 2019

the collection

. "IndexOf", then <<Owner ID>> is the
ID of a collection and <<Name>> 1s
the ID of the item 1n the collection; it
will retrieve the index (string format)
of the item within the collection

Example $sPropName = %EASL GET("Property",
$context, "Name")%

EASLList

The EASLList macro 1s used to render each object in an
EASL collection using the appropriate template.

Aspect Description

Syntax $result =
%EASLList=<<TemplateName>>
(@separator=<<Separator>>

(@indent=<<indent>>
@owner=<<OwnedID>>

@collection=<<CollectionName>>
@option1=<<OPTION1>>

@option2=<<OPTION2>>.........
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Example

(c) Sparx Systems 2019

@optionN=<<OPTIONN>>%
where:

. <<TemplateName>> is the name of
any behavioral model template or
custom template

. <<Separator>> is a list separator (such
as “\n”)

. <<indent>> is any indentation to be
applied to the result

. <<OwnedID>> i1s the ID of the object
that contains the required collection

. <<CollectionName>> 1s the name of
the required collection

. <<OPTION1>...<<OPTION99>> are
miscellaneous options that might be
passed on the template; each option is
given as an additional input parameter
to the template

(1324

$result is the resultant value; this is
if not a valid collection

$sStates = %EASLList="State"
(@separator="\n" @indent="\t"

@owner=$StateMachineGUID
@collection="States"
@option=%$sOption%
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EASL_END

The EASL END macro is used to release the EASL
behavior model.

Aspect Description

Syntax %EASL END%

Behavioral Model Templates

. Action

. Action Assignment
. Action Break

. Action Call

. Action Create

. Action Destroy

. Action If

. Action Loop

. Action Opaque

. Action Parallel

. Action RaiseEvent
. Action RaiseException
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. Action Switch

. Behavior

. Behavior Body

. Behavior Declaration
. Behavior Parameter
. Call Argument

. Decision Action

. Decision Condition
. Decision Logic

. Decision Table

. Guard

. Property Declaration
. Property Notes

. Property Object

. State

. State CallBack

. State Enumerate

. State EnumeratedName
. StateMachine

. StateMachine HistoryVar
. Transition

. Transition Effect

. Trigger
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EASL Collections

This topic lists the EASL collections for each of the EASL
objects, as retrieved by the EASL Code Generation Macros
code generation macro.

Action
Collection Description
Name
Arguments The Action's arguments.

SubActions The sub-actions of the Action.

Behavior

Collection Description

Name
Actions The Behavior's Actions.
Nodes The Behavior's nodes.
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Parameters The Behavior's parameters.
Variables The Behavior's variables.
Classifier
Collection Description
Name

AllStateMach @ All StateMachines for the Classifier.
1nes

AsynchPrope = The asynchronous properties of the
rties Classifier.

AsynchTrigg  The asynchronous triggers of the

ers Classifier.
Behaviors The behaviors of the Classifier.
Properties The properties of the Classifier.

TimedPropert The timed properties of the Classifier.
1es

TimedTrigge
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1S The timed triggers of the Classifier.
Triggers All triggers of the Classifier.
Construct
Collection Description
Name

AllChildren The Construct's children.

ClientDepend = The client dependencies on the Construct.
encies

StereoTypes | The stereotypes of the Construct.

SupplierDepe | The supplier dependencies on the

ndencies Construct.
Node
Collection Description
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Name

IncomingEdg = The Node's incoming edges.
es

OutgoingEdg = The Node's outgoing edges.
es

SubNodes The sub-nodes of the Node.

State

Collection Description
Name

DoBehaviors @ The State's Do behaviors.

EntryBehavio The State's Entry behaviors.
1S

ExitBehavior @ The State's Exit behaviors.
S
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StateMachine
Collection Description
Name

AllFinalState = The StateMachine's final States.
S

AllStates All States within the StateMachine,
including those within Submachine
States.

DerivedTrans The StateMachine's derived Transitions

1tions with the associated valid effect.
States The States within the StateMachine.
Transitions The transitions within the StateMachine.
Vertices The StateMachine's vertices.
Transition
Collection Description
Name
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Effects
Guards

Triggers

Trigger

Collection
Name

TriggeredTra
nsitions

Vertex

Collection
Name

DerivedOutg
oingTransitio
ns

(c) Sparx Systems 2019

The Transition's effects.
The Transition's guards.

The Transition's triggers.

Description

The triggered transitions associated with
the Trigger.

Description

The Vertex's derived outgoing transitions
after traversing the pseudo-nodes.
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IncomingTra = The Vertex's incoming transitions.
nsitions

OutgoingTra = The Vertex's outgoing transitions.
nsitions
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EASL Properties

This topic lists the EASL properties for each of the EASL
objects, as retrieved by the EASL Code Generation Macros
code generation macro.

Action
Property Description
Name
Behavior The Action's associated behavior (Call
Behavior Action or Call Operation
Action).
Body The Action's body.
Context The Action's context.
Guard The Action's guard.
IsFinal A check on whether the action is a final
Action.
IsGuarded A check on whether the action 1s a
guarded Action.
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IsInitial A check on whether the action is an
initial Action.

Kind The Action's kind.
Next The Action's next action.
Node The Action's associated node in the
graph.
Argument
Property Description
Name
Parameter The ID of the Argument's associated
parameter.
Value The default value of the argument.
Behavior
Property
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Name Description

InitialAction @ The Behavior's initial action.
isReadOnly | The isReadOnly of the Behavior.

isSingleExec = The isSingleExecution of the Behavior.
ution

Kind The kind of Behavior.
ReturnType | The return type of the Behavior.

Specification | The specification of the Behavior.

CallEvent
Property Description
Name
Operation The operation of the CallEvent.
ChangeEvent

c) Sparx Systems age o
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Property Description
Name

ChangeExpre @ The change expression of the

ssion ChangeEvent.
Classifier
Property Description
Name

HasBehavior @ A check on whether the Classifier has

S behavioral models (Activity and
Interaction).
Language The Classifier's language.

StateMachine @The StateMachine of the Classifier.

Condition
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Property Description

Name
Expression The Condition's expression.
Lower The Condition's lower value.
Upper The Condition's upper value.

Construct

Property Description

Name

GetTaggedV | The Property's Tagged Value.
alue

IsStereotype | A check on whether a particular
Applied stereotype is applied to the Property.

Notes Notes on the Property.

UMLType The UML type of the Property.

Visibility The visibility of the Property.
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Edge
Property Description
Name
From The ID of the node from which the Edge
arises.
To The ID of the node at which the Edge 1s
targeted.
EventObject
Property Description
Name

EventKind The event kind of the Event Object.

Instance
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Property
Name

Classifier

Value

Parameter

Property
Name

Direction

Type

Value

Primitive

Property

(c) Sparx Systems 2019

Description

The classifier of the Instance.

The value of the Instance.

Description

The direction of the Parameter.
The type of the Parameter.

The value of the parameter.

Description
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Name

FQName The FQ name of the Primitive.
ID The ID of the Primitive.
Name The name of the Primitive.

ObjectType The object type of the Primitive.

Parent The IDParent of the Primitive.
PropertyObject

Property Description

Name

BoundSize The bound size of the PropertyObject (if
it 1s a collection).

ClassifierSter = The stereotype of the PropertyObject's
coType classifier.

IsAsynchPro | A check on whether the PropertyObject is
p an asynchronous property.
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IsCollection | A check on whether the PropertyObject is
a collection.

IsOrdered A check on whether the PropertyObject is
ordered (if it 1s a collection).

IsTimedProp = A check on whether the PropertyObject is
a timed property.

Kind The PropertyObject's kind.

LowerValue | The PropertyObject's lower value (if it 1s
a collection).

Type The PropertyObject's type.

UpperValue | The PropertyObject's upper value (if it is
a collection).

Value The PropertyObject's value.
SignalEvent

Property Description

Name
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Signal The signal of the SignalEvent.
State

Property Description

Name

HasSubMach @ A check on whether the State is a
1ne Submachine state.

IsFinalState A check on whether the State 1s a final
state.

SubMachine | Get the ID of the Submachine contained
by the State (if applicable).

StateMachine
Property Description
Name

HasSubMach @ A check on whether the StateMachine has
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1neState
InitialState

SubMachine
State

TimeEvent

Property
Name

When

Transition

Property
Name

HasEffect
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a Submachine state.
The StateMachine's initial state.

The StateMachine's Submachine State.

Description

The 'when' property of the TimeEvent.

Description

A check on whether the transition has a
valid effect.

A check on whether the transition is a
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IsDerived derived transition.

IsTranscend A check on whether the transition
transcends from one StateMachine
(Submachine State) to another.

IsTriggered A check on whether the transition is

triggered.
Source The Transition's source.
Target The Transition's target.
Trigger
Property Description
Name

AsynchDesti | The asynchronous destination state of the
nationState Trigger (if it is an asynchronous trigger).

DependentPr = The ID of the property associated with
operty the Trigger.

Event The Trigger's event.
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Name The Trigger's name.
Type The Trigger's type.
Vertex
Property Description
Name
IsHistory A check on whether the vertex is a

history state.

IsPseudoStat = A check on whether the vertex is a
e pseudo state.

PseudoState = The Vertex's pseudo-state kind.
Kind
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Call Templates From Templates

Using function calls with parameters, you can call templates
from other templates, whether standard templates or
user-defined templates created within your project. Also,
called templates can return a value, and can be called
recursively.

Examples

A call statement returning a parameter to a variable:
$sSource = %StateEnumeratedName($Source)%

A call statement to a template that has parameters:
%RuleTask($GUID, $index)%

Using the $parameter statement in the called template:
$GUID = $parameterl
$index = $parameter2

Templates support recursive calls, such as this recursive call
on the template RuleTask:

$GUID = $parameterl

$index = $parameter2

% PI=""%

$nul = "Initialize condition and action object"

$count = %BR_GET("RuletCount™)%
% 1f $count =="" or $count == Sindex %
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%ComputeRulet($GUID)%

\n

% endTemplate %

%Rulet($index)%

\n

$index = %oMATH_ ADD($index, "1")%
%RuleTask($GUID, $index)%
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The Code Template Editor in MDG
Development

These topics describe how you use the Code Template
Editor window to create custom templates:

. Create Custom Templates

. Customize Base Templates

. Add New Stercotyped Templates

The Code Template Editor provides the facilities of the
Common Code Editor, including Intelli-sense for the code
generation template macros. For more information on
Intelli-sense and the Common Code Editor, see the Editing
Source Code topic.

(c) Sparx Systems 2019 Page 588 of 674


http://www.sparxsystems.com/enterprise_architect_user_guide/15.0/model_domains/customtemplates.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.0/model_domains/creatingtemplatesforcustom.html
http://www.sparxsystems.com/enterprise_architect_user_guide/15.0/model_domains/addingnewstereotypedtemplat.html

User Guide - Software Models 7 August, 2019

Create Custom Templates

Enterprise Architect provides a wide range of templates that
define how code elements are generated. If these are not
sufficient for your purposes - for example, if you want to
generate code 1n a language not currently supported by
Enterprise Architect - you can create completely new
custom templates. You can also add stereotype overrides to
your custom templates; for example, you might list all of
your parameters and their notes in your method notes.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Design > Tools > Transform > Transform
Templates

Keyboard Ctrl+Shift+P (code generation
Shortcuts templates)

Ctrl+Alt+H (MDA transformation
templates)

Create custom templates using the Code
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Templates Editor

Ste Description

P

1

In the 'Language' field, click on the drop-down arrow
and select the appropriate programming language.

Click on the Add New Custom Template button.
The 'Create New Custom Template' dialog displays.

In the "Template Type' field, click on the drop-down
arrow and select the appropriate modeling object.

The '<None>' option requires special treatment; it
enables the definition of a function macro that
doesn't actually apply to any of the types, but must
be called as a function to define variables
$parameterl, $parameter2 and so on for each value
passed 1n.

In the "Template Name' field, type an appropriate
name.

Click on the OK button.

On the 'Code Templates Editor' tab, the new
template 1s included in the "Templates' list, with the
value 'Yes' in the 'Modified' field.

The template 1s called <Template
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Type> <Template Name>.

Note the double underscore character between the
template type and template name.

6 | Select the template from the Templates list and edit
the contents in the Template field to meet your
requirements.

7 | Click on the Save button.

This stores the new template, which 1s now available
from the list of templates for use. You can also add a
stereotype override to the template, if necessary.

Notes

. For a custom language, you must define the File template
so that it can call the Import Section, Namespace and
Class templates, and any other templates that you decide
are applicable
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Customize Base Templates

Enterprise Architect provides a wide range of templates that
define how code elements are generated. If you want to
change the way a code element is generated, you can
customize the appropriate templates. Your changes might be
to the effect of the template itself, or to its calls to other
templates. You can also add stereotype overrides to your
customized templates; for example, you might list all of
your parameters and their notes in your method notes.

When you customize a system-provided (base) template,
you effectively create a copy of the template that 1s used in
preference to the original. All subsequent changes are to that
copy, and the original base template is hidden. If you
subsequently delete the copy it can no longer override the
original, which is then brought into use again.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Keyboard Ctrl+Shift+P
Shortcuts
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Customize a base template

Ste | Description
P

1 | On the Code Template Editor, in the 'Language’
field, click on the drop-down arrow and select the
programming language for which you want to
customize the base templates.

2 In the Templates list, click on the base template to
edit.

3 | Update the template.
4 | Click on the Save button to store your changes.

5 | Repeat steps 2 to 4 for each of the relevant base
templates you want to customize.

6 | If you prefer, add one or more stereotype overrides
to any of the templates.
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Add New Stereotyped Templates

Sometimes it 1s useful to define a specific code generation
template for use with elements of a given stereotype. This
enables different code to be generated for elements,
depending on their stereotype. Enterprise Architect provides
some default templates, which have been specialized for
commonly used stereotypes in supported languages. For
example, the 'Operation Body' template for C# has been
specialized for the property stereotype, so that it
automatically generates its constituent 'get' and 'set'
methods. You can override the default stereotyped templates
as described in the Override Default Templates topic.
Additionally, you can define templates for your own
stereotypes, as described here.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Keyboard Ctrl+Shift+P
Shortcuts
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Add a new stereotyped template using the
Code Template Editor

Ste | Description

P

1

Select the appropriate language, from the Language
list.

Select one of the base templates, from the Templates
list.

Click on the 'Add New Stereotyped Override' button.
The 'New Template Override' dialog displays.

Select the required Feature and/or Class stereotype.
Click on the OK button.

The new stereotyped template override displays in
Stereotype Overrides list, marked as modified.

Make the required modifications in the Code
Templates Editor.

Click on the Save button to store the new
stereotyped template in the project file.

Enterprise Architect can now use the stereotyped
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template, when generating code for elements of that
stereotype.

Notes

. Class and feature stereotypes can be combined to provide
a further level of specialization for features; for example,
if properties should be generated differently when the
Class has a stereotype MyStereotype, then both property
and MyStereotype should be specified in the New
Template Override dialog
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Override Default Templates

Enterprise Architect has a set of built-in or default code
generation templates. The Code Templates Editor enables
you to modify these default templates, hence customizing
the way in which Enterprise Architect generates code. You
can choose to modify any or all of the base templates to
achieve your required coding style.

Any templates that you have overridden are stored in the
project file. When generating code, Enterprise Architect first
checks whether a template has been modified and if so, uses
that template. Otherwise the appropriate default template is
used.

Access

Ribbon Develop > Preferences > Options > Edit
Code Templates

Keyboard Ctrl+Shift+P
Shortcuts

Reference

(c) Sparx Systems 2019 Page 597 of 674



User Guide - Software Models 7 August, 2019

Override a default code generation template using the Code
Templates Editor.

When generating code, Enterprise Architect now uses the
overriding template instead of the default template.

Field/Button Description

Language

Templates

Stereotype
Overrides

<QOther
fields>

Save

(c) Sparx Systems 2019

Select the appropriate language from the
list.

Select one of the base templates from the
list.

If the base template has stereotyped
overrides, you can select one of these
from the list.

Make any other modifications required.

Click on this button to store the modified
version of the template to the project file.
The template 1s marked as modified.
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Grammar Framework

Enterprise Architect provides reverse engineering support
for a number of popular programming languages. However,
if the language you are using is not supported, you can write
your own grammar for it, using the in-built Grammar Editor.
You can then incorporate the grammar into an MDG
Technology to provide both reverse engineering and code
synchronization support for your target language.

The framework for writing a grammar and importing it into
Enterprise Architect 1s the direct complement to the Code
Template Framework. While code templates are for
converting a model to a textual form, grammars are required
to convert text to a model. Both are required to synchronize
changes into your source files.

An example language source file and an example Grammar
for that language are provided in the Code Samples
directory, which you can access from your installation
directory (the default location 1s C:\Program Files\Sparx
Systems\EA). Two other grammar files are also provided,
illustrating specific aspects of developing Grammars.

Components

Component | Description

Grammar Grammars define how a text is to be
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Syntax broken up into a structure, which is
necessary when you are converting code
into a UML representation. At the
simplest level, a grammar 1s instructions
for breaking up an input to form a
structure.

Enterprise Architect uses a variation of
Backus—Naur Form (nBNF) to include
processing instructions, the execution of
which returns structured information
from the parsed results in the form of an
Abstract Syntax Tree (AST), which is
used to generate a UML representation.

Grammar The Grammar Editor is an in-built editor
Editor that you can use to open, edit, validate
and save grammar files.

Grammar You can debug the grammar files you
Debugging create using two facilities:

. The Parser, which generates the AST
for the Grammar

. The Profiler, which also parses the
Grammar and generates the AST but
which exposes the Profiling pathway to
show exactly what happened at each
step of the process
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Grammar Syntax

Grammars define how a text is to be broken up into a
structure, which 1s exactly what is needed when you are
converting code into a UML representation. At the simplest
level, a grammar 1s just instructions for breaking up an input
to form a structure. Enterprise Architect uses a variation of
Backus—Naur Form (BNF) to express a grammar in a way
that allows it to convert the text to a UML representation.
What the grammar from Enterprise Architect offers over a
pure BNF is the addition of processing instructions, which
allow structured information to be returned from the parsed
results in the form of an Abstract Syntax Tree (AST). At the
completion of the AST, Enterprise Architect will process it
to produce a UML model.

Syntax
Syntax Detail
Comments Comments have the same form as in

many programming languages.

// You can comment to the end of a line
by adding two /s.

/* You can comment multiple lines by
adding a / followed by a *.
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The comment is ended when you add a *
followed by a /. */

Instructions Instructions specify the key details of
how the grammar works. They are
generally included at the top of the
grammar, and resemble function calls in
most programming languages.

Rules Rules make up the body of a grammar. A
rule can have one or more definitions
separated by pipe delimiters ().

For a rule to pass, any single complete
definition must pass. Rules are terminated
with the semi-colon character (;).

Definitions A definition 1s one of the paths a rule can
take. Each definition 1s made up of one or
more terms.

Definition A definition list corresponds to one or

Lists more sets of terms. These will be

evaluated in order until one succeeds. If
none succeed then the containing rule
fails. Each pair of definitions 1s separated
by a | character.

This is a simple rule with three
definitions:

<greeting> ::= "hello" | "h1" | ["good"]
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"morning";

Terms A term can be a reference to a rule, a
specific value, a range of values, a
sub-rule or a command.

Commands Like instructions, commands resemble
function calls. They serve two main
purposes:

. To process tokens in a specific way or
. To provide a result to the caller
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Grammar Instructions

Instructions specify the key details of how the grammar
works. They are generally included at the top of the
grammar, and resemble function calls in most programming

languages.

Instructions

Instruction

caseSensitive

0

caselnsensiti

ve()

delimiters(De
limiterRule:
Expression)
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Description

One of these two instructions is expected
to specify if token matching needs to be
case sensitive or not. For example,
languages in the BASIC family are case
insensitive while languages in the C
family are case sensitive.

The delimiters instruction tells the lexical
analyzer which rule to use for delimiter
discovery. Delimiters are used during
keyword analysis, and can be defined as
the characters that can be used
immediately before or after language
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keywords.

lex(TokenRul ' The lex instruction tells the lexical
e: analyzer the name of the root rule to use
Expression)  for its analysis.

parse(RootRu | The parse instruction tells the parser the
le: name of the root rule to use for its
Expression) | processing. The optional second
parse(RootRu = argument specifies a skip (or escape)

le: rule, which is generally used to handle
Expression, comments.

SkipRule:

Expression)
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Grammar Rules

Rules are run to break up text into structure. A rule is made
up of one or more definitions, each of which is made up of
one or more terms.

Types of Rule

Rule Description

Named rules = A name, followed by a definition list. For
example:
<rule> ::= <term1> <term2> | "-"
<term]1>;

Inline Rules | Inside a definition, a rule defined within
parentheses. These act in exactly the
same way as if they were a named rule
being called by a term. For example:

<rule> ::= (<inline>);

Optional Inside a definition, a rule defined within
Rules square brackets. This rule succeeds even
if the contents fail. For example:

<rule> ::= [<inline>];

Repeating Inside a definition, a term followed by a
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Rules plus sign. This rule matches the inner rule
once or more than once. For example:

<rule> ::= <inline>+;
rule ::= (<term1> <term2>)+;

Optional Inside a definition, a rule followed by a

Repeating star. This rule matches the inner rule zero

Rules or more times, meaning it succeeds even
if the inner rule never succeeds. For
example:

<rule> ::= <inline>*;
rule ::= (<term1> <term2>)*;
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Grammar Terms

Terms identify where tokens are consumed.

Types of Term
Type Description
Concrete Quoted strings.
terms For example, "class"
Unicode A lexer-only term, having the prefix of
characters U+0x followed by a hexadecimal
number.

For example: U+0x1234

Ranges A lexer-only term, matching any
character between the two characters
specified.

nsn n_n

For example, "a".."z" or
U+0x1234..U+2345

References The name of another rule, in angled
brackets. The token will match if that rule
succeeds.

For example, <anotherRule>
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Commands A call to a specific command.
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Grammar Commands

Commands, like Instructions, resemble function calls. They
serve two main purposes:

. To process tokens in a specific way or
. To provide a result to the caller

Commands

Command Description

attribute(Na  Creates an attribute on the current AST

me: String, node. The attribute will be created with

Value: the Name specified in the grammar

Expression) | source, and will be given the value of all
tokens consumed as a part of executing
the Value expression.

This command produces the AST node
attributes that Enterprise Architect
operates on in code engineering.

attributeEx(N = Creates an attribute on the current AST
ame: String) | node without consuming any tokens. The
attributeEx(N | attribute will be created with the same
ame: String,  nhame as is specified in the grammar
Value: source, and with either an empty value or
String) the value specified by the optional Value
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node(Name:
String,
Target:
Expression)

token(Target:

Expression)

keywords()

skip(Target:
Expression)

skip(Target:
Expression,
Escape:

Expression)
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argument.

This command produces the AST node
attributes that Enterprise Architect
operates on in code engineering.

Creates an AST node under the current
AST node (the nodes that Enterprise
Architect operates on in code
engineering). The node will be created
with the Name specified in the grammar
source.

Creates a token during lexical analysis for
processing during parsing. The value of
the token will be the value of all
characters consumed as a result of
executing the Target expression.

Matches any literal string used as a
grammar term; that is, if you enter an
explicit string that you are searching for,
it becomes a key word.

Consumes input data (characters when
lexing, and tokens when parsing) until the
'"Target' expression 1s matched. The
optional 'Escape’ expression can be used
to handle instances such as escaped
quotes within strings.
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skipBalanced = Consumes input data (characters or

(Origin: tokens) until the 'Target' expression is
Expression, matched and the nesting level reaches
Target: zero. If the 'Origin' expression 1s matched

Expression) | during this process, the nesting level is
skipBalanced = 1ncreased. If the "Target' expression is

(Origin: matched, the nesting level is decreased.
Expression, When the nesting level reaches zero, the
Target: command exits with success. An optional
Expression, 'Escape’ expression can be provided.
Escape:

Expression)

skipEOF() Consumes all remaining data (characters

or tokens) until the end of the file.

fail() Causes the parser to fail the current rule,
including any remaining definitions.

warning() Inserts a warning into the resulting AST.

except(Target Consumes input data that matches the

: Expression, = Target expression, but fail on data that

Exception: matches the Exception expression. This

Expression) | operates somewhat similar to, but exactly
the opposite of, the skip command.

preProcess(T = Evaluates an expression and uses that
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arget: pre-processed data in multiple

Expression) | definitions. This is most useful within
expression parsing, where the same left
hand side expression will be evaluated
against a number of operators. This
command reduces the work the parser
must do to make this happen.

(c) Sparx Systems 2019 Page 614 of 674



User Guide - Software Models 7 August, 2019

AST Nodes

In defining a grammar, you would use AST nodes and AST
node attributes that can be recognized in code engineering in
Enterprise Architect, in the AST results that are returned by
the attribute, attributeEx and node commands. The nodes
and attributes are identified in these tables. Any others will
be ignored in code engineering.

FILE Node

The FILE node represents a file. It 1sn't mapped to anything,
but contains all the required information.

Multiplicity /  Description
Nodes

0.*% / See PACKAGE Node.
PACKAGE

0.% / See CLASS Node.
CLASS

0.% /
IMPORT

0.% / Field labels as part of a skip rule will be
COMMENT  at the root level; the code generator looks
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for comments of this sort by position
relative to the node.

0.1/ This gives the position where new
INSERT PO  Classes, Packages and method
SITION implementations can be inserted into the

file. If 1t is not found, the code generator
will automatically insert new items
immediately after the last one is found in
code.

PACKAGE node

The PACKAGE node corresponds to a namespace or
equivalent in the file. When importing with 'package per
namespace', Enterprise Architect will create a Package
directly under the import for this and place all Classes
within 1it. When not importing namespaces, Enterprise
Architect will look for Classes under this point, but it will
do nothing with this node.

Additionally, if you are generating with namespaces enabled
(see the Code Options topics for generic languages) a
generated Class will not match a Class in code unless they
are under the same Package structure.

Contained in nodes: FILE
Multiplicity / | Description
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Nodes

1 / NAME See NAME Node.

0.% / See CLASS Node.

CLASS

0.% /

PACKAGE

0.1/ Gives the position where the Package
OPEN POSI | body opens. This can also be used as an
TION insert position.

0.1/ Gives the position where new Classes and
INSERT PO | Packages can be inserted into the file. If it
SITION is not found, the code generator will

automatically insert new items
immediately after the last one 1s found in
code.

0.1/ Prevents indenting when inserting into
SUPPRESS  this Package.

CLASS/INTERFACE Node
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The CLASS (or INTERFACE) node is the most important in
code generation. It is brought in as Class (or Interface)
Objects.

See Class DECLARATION and Class BODY.
Contained in Nodes: FILE, PACKAGE, Class BODY

CLASS Declaration

Contained in Nodes: CLASS/INTERFACE

Multiplicity / | Description
Nodes

1 / NAME See NAME Node.

0..% / See PARENT Node.
PARENT

0..* / TAG See TAG Node.

0..1 / See DESCRIPTION Node.
DESCRIPTI

ON

1 / NAME The name of the Class. If there 1s a node
NAME, that will overwrite this attribute.

0.1/ The UML Scope of the Class - Public,
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SCOPE

0.1/
ABSTRACT

0.1/
VERSION

0.1/
STEREOTY
PE

0.1/
ISLEAF

0.1/
MULTIPLIC
ITY

0.1/
LANGUAGE

0.1 / NOTE

0.1/
ALIAS

0.% /
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Private, Protected or Package.

If present, indicates that this is an abstract
Class.

The version of the Class.

The stereotype that Enterprise Architect
should assign to the Class. This does not
support multiple stereotypes.

Generally, you do not need to set this.
Generally not used as it is addressed by

the comments above the Class.

Adds a numbered Tagged Value that
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MACRO Enterprise Architect can use to round trip
macros.

Class BODY Node

Contained in Nodes: CLASS/INTERFACE

Multiplicity /  Description
Nodes

0.% / See METHOD Node.
METHOD

0.% / See ATTRIBUTE Node.
ATTRIBUTE

0.% / See FIELD Node.
FIELD

0.*% / See CLASS Node.
CLASS

0.% / See SCOPE Node.
SCOPE

0.% /
PROPERTY
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0.* / TAG | See TAG Node.

0.% / See PARENT Node.
PARENT
0.1/ Gives the position where the Class body

OPEN_POSI | opens. This can also be used as an insert
TION position.

0.1/ Gives the position where new Class
INSERT PO | members can be inserted into the file. If it
SITION is not found, the code generator will

automatically insert new items
immediately after the last one 1s found in
code.

SCOPE Node

This 1s an optional feature for languages resembling C++
that have Blocks that specify the scope of elements. The
language needs to have a name specified that is used for the
scope of all elements in the Block. In all other respects it
behaves identically to the Class BODY node.

Contained in Nodes: Class BODY
Multiplicity /  Description
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Nodes

1 / NAME Used as the scope for all methods and
attributes contained within the scope.

METHOD Node

Contained 1n Nodes: Class BODY, SCOPE

Multiplicity / | Description
Nodes

1 / Method See Method DECLARATION Node.

DECLARAT
ION

Method DECLARATION Node

Contained in Nodes: METHOD

Multiplicity / | Description
Nodes

0.1 / TYPE | See TYPE Node.
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0.% / See PARAMETER Node.
PARAMETE
R

0.* / TAG | See TAG NODE.

0.1/ See DESCRIPTION Node.
DESCRIPTI
ON

0.1/ Supports Delphi's parameter list style of
MULTI declaration. This is the equivalent of
PARAMETE @ FIELD.

R

1 / NAME
0.1 / TYPE

0.1/
SCOPE

0.1/
ABSTRACT

0.1/
STEREOTY
PE
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0.1/
STATIC

0..1 / CONST
or
CONSTANT

0..1 / PURE

0.1 /
ISQUERY

0.1/
ARRAY

0.1/
SYNCHRON
IZED

0.% /
MACRO

7 August, 2019

0.1/ Specifies special behavior for C#.

CSHARPIM
PLEMENTS

0.1/ Provides support for Aspect J, using

BEHAVIOR @ behavior.
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0.1/ Provides support for Aspect J, using

SHOWBEH  behavior, and shows the

AVIOR reverse-engineered behavior on the
diagram.

ATTRIBUTE Node

Contained in Nodes: Class BODY, SCOPE

Multiplicity / | Description
Nodes

1 / TYPE See TYPE Node.
0.% / TAG | See TAG Node.

0.1/ See DESCRIPTION Node.
DESCRIPTI
ON

1 / NAME
0.1 / TYPE

0.1/
SCOPE
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0.1/
DEFAULT

0..1 /
CONTAINE
R or ARRAY

0.1/
CONTAINM
ENT

0.1/
STEREOTY
PE

0.1/
STATIC

0..1 /
CONST or
CONSTANT

0.1/
ORDERED

0.1/
LOWBOUN
D
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Reference or value.
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0.1/
HIGHBOUN
D

0.1/
TRANSIENT

or
VOLATILE

FIELD Node

A field corresponds to multiple attribute declarations in one.
Anything not defined in the Declarators but defined in the
field itself will be set for each declarator. Everything
supported in an attribute is supported in the field. If no
declarators are found then this works in the same way as an
attribute.

Contained in Nodes: Class BODY, SCOPE

Multiplicity /  Description
Nodes

0.% / See ATTRIBUTE Node.
DECLARAT
OR
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PARAMETER Node

Contained 1n Nodes: Method DECLARATION,
TEMPLATE

Multiplicity / | Description
Nodes

1 / TYPE See TYPE Node.
0..* / TAG See TAG Node.

0.1/ See DESCRIPTION Node.
DESCRIPTI
ON

0.1/
NAME

0.1 / TYPE

0..1 / KIND @ Expected to be 1n, inout, out or return.

0.1/
DEFAULT

0.1/
FIXED
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0.1/
ARRAY

NAME Node

Contained in Nodes: PACKAGE, Class DECLARATION

Multiplicity /  Description
Nodes

1 / NAME

0.% /
QUALIFIER

0.% / An alternative to using NAME and
NAMEPART | QUALIFIER. A string of values, all

except the last one taken as qualifiers.
The last one 1s taken as the Name.

TYPE Node
Contained 1n Nodes: Method DECLARATION,
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ATTRIBUTE, PARAMETER

Multiplicity /  Description
Nodes

0.1/ The entire text of the template 1s the
TEMPLATE | name of the type.

Only used if NAME is undefined.
See TEMPLATE Node.

1 / NAME

0.% /
QUALIFIER

0.% / An alternative to using NAME and

NAMEPART @ QUALIFIER. A string of values, all
except the last one taken as qualifiers.
The last one 1s taken as the Name.

TEMPLATE Node

Contained 1n Nodes: TYPE

Multiplicity /  Description
Nodes
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0..% / See PARAMETER Node.
PARAMETE

R

1 / NAME
PARENT Node

Contained 1in Nodes: Class DECLARATION

Multiplicity / | Description
Nodes

0..1 / TYPE | Has the value Parent, Implements or

VirtualP.
1 / NAME
0.% /
QUALIFIER
0.% / An alternative to using NAME and

NAMEPART @ QUALIFIER. A string of values, all
except the last one taken as qualifiers.
The last one 1s taken as the Name.

0.1/
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INSTANTIA
TION

TAG Node

Contained in Nodes: Class DECLARATION, Method
DECLARATION, ATTRIBUTE, PARAMETER

Multiplicity /  Description
Nodes

1 / NAME

0.% /
VALUE

0.1/
MEMO

0.1/
NOMEMO

0.1/
GROUP
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DESCRIPTION Node

Contained 1n Nodes: Class DECLARATION, Method
DECLARATION, ATTRIBUTE, PARAMETER

Multiplicity / | Description
Nodes

0.% /
VALUE
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Editing Grammars

If you need to write and edit a grammar for code imported in
a new programming language, you can do so using the
built-in Grammar Editor.

Access

Ribbon Develop > Preferences > Grammars

Create and Edit Grammar

Field/Button | Action

Open Display a browser through which you can
Grammar locate and open the file containing the
grammar you want to edit.

Recent Recently used grammars can be quickly
accessed using this combo box.

Save Save the current file.
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Save As

Validate
Grammar

Help

Saves a copy of the current file

The grammar validation will run a series
of tests on the current grammar to ensure
its validity. Errors and warnings will be
displayed informing you of both errors
that will make the grammar unusable, and
conditions where you might get
unexpected results.

Display this Help topic.

Context Menu Options

Field/Button | Action

Open File

Validate
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Display a browser through which you can
locate and open the file containing the
grammar you want to edit.

The grammar validation will run a series
of tests on the current grammar to ensure
its validity. Errors and warnings will be
displayed informing you of both errors
that will make the grammar unusable, and
conditions where you might get
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unexpected results.

Language The Grammar Editor defaults to normal
Backus—Naur Form (nBNF). The mBNF
option is also available.

Line Turn line numbers on or off in the
Numbers grammar editor.
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Parsing AST Results

The Abstract Syntax Tree (AST) is the code that Enterprise
Architect sees as 1t processes a grammar.

You parse the text in the bottom half of the Grammar Editor
window and review what is displayed as a result. You can
either open a file or paste text in. If you have pasted text that
corresponds to something that cannot appear at the file level
(such as Operation Parameters) you can select an alternative
rule to use as a starting point. The parse will then commence
from that rule.

Access
Ribbon Develop > Preferences > Grammars >
Grammar Debugger > AST Results
Toolbar Options
Option Action
Open File Open a sample input file to test against.
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Recent Recently opened source files can be
selected from this combo box.

Parse Perform the parse operation. If the parse
1s successful, the 'AST Results' tab will
contain the resulting AST.

Select Rule This drop down allows you to select an
alternative root rule for processing your
sample source.

Help Display this Help topic.
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Profiling Grammar Parsing

When you parse a grammar that you have created, it might

show errors that you cannot immediately diagnose. To help
you resolve such errors, you can review the process that the
parser followed to generate the AST you can see, using the

Grammar Profiler.

You again parse the text in the bottom half of the Grammar
Editor window, but this time the tree shows each rule that
the parser attempted, where it got to and if it passed or not.
Rules for opening a file, pasting a file and setting the
starting rule remain the same.

Access

Ribbon Develop > Preferences > Grammars >
Grammar Debugger > Profiler Results

Toolbar Options

Option Action

Open File Display a browser through which you can
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locate and open the file containing the
grammar you want to edit.

Parse Perform the parse operation. If the parse
1s successful, the 'AST Results' tab will
contain the resulting AST, and the
'Profile Results' tab will contain debug
information regarding the path that the
parser took through your grammar. The
profile data 1s extremely useful when
debugging a new grammar.

Select Rule If you want to use a different root rule for
processing your sample source, click on
the drop-down arrow and select the
alternative rule.

Help Display this Help topic.

Notes

. Because profiling can take a very long time for large files,
the 'Profile Results' tab is not filled if you are not
displaying that tab when you begin parsing
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Macro Editor

The macro editor allow a user to supplement the grammar
with a list of keywords and rules to exclude macros during
grammar parse operations. The macro definition list is
particularly useful when developing grammars for languages
that support macros such as C++. It avoids the necessity of
describing these rules in the grammar itself, and can be used
with multiple grammars.

This feature 1s available from Enterprise Architect Release
14.1.

Access

Ribbon Develop > Preferences > Grammars >
Macro Editor

Editing Macros

Open File Open an existing macro definition list
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Recent Recently opened macro definition lists
can be selected from this combo box

Save Saves changes to the opened macro
definition list

Save As Saves a copy of the existing macro
definition list

Validate Validates the grammar of the macro
definition list
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Example Grammars

The Code Samples directory set up by the Enterprise
Architect installer contains an example Grammar that you
can load into the Grammar editor to review, and into the
Grammar Debugger to parse and profile.

The Grammar example consists of two files:

. test.ssl - a simple sample language source file, in the style
of C, and

. ssl.nbnf - a grammar for the simple sample language
The example illustrates:

. Tokenization (using the Lexer)

. Creation of a Package

. Creation of a Class or Interface

. Creation of an attribute

. Creation of an operation (with parameters)

. Importing comments

The Code Samples directory also contains two other
Grammar files that you can examine:

. Expressions Sample.nBNF - this illustrates how
expression parsing is set up and processed, with detailed
comment text providing explanations

. CSV Sample.nBNF - an example grammar for processing
CSV files
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Code Miner Framework

The Code Miner system provides fast and comprehensive
access to the information in existing source code. By
parsing all source code and storing the resulting Abstract
Syntax Tree in a read-optimized database, the system
provides complete access to all aspects of the original
source code, in a machine understandable format.

The core goal behind the system is to provide access to the
data hidden within source code in a timely and effective
manner. Great pains have been taken to ensure maximum
performance, while providing the simplest interfaces
possible. As a result the system can be used to analyze
program structure, calculate metrics, trace relationships and
even perform refactoring.

Information from Code Miner databases is retrieved using
queries written in mFQL, Code Miner's own language. The
language itself is reasonably simple, providing a small
number of commands. Simple as the language is, it supports
queries of arbitrary size and complexity. The design
provides extreme performance for all queries, great and
small.

This feature is available from Enterprise Architect Release
14.1.
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findMethodCalls()

REE- -8 REB Beg@m oo

P Edjava 1@ ] .
4 (sparx ;1) ?uery. : findUse0fAttribute($paraml)

v findArtribureByName() 13 distinct( intersect( getByNode('"VARIABLE_ACCESS"),getbyvalue($paraml)))

v findClass() 14}

v findClasseslnPackage() 15 .

) - 16

¢ FndClassesinAtribu) 17 // Find use of method name 'paraml' by all methods

v findClassesWithMethod() 187/

v findMethodByName() 19 query: : findMe thodUse0fMethod($paraml)

v|findMethodCalls() 20 {

v findMethodUseOfMethod()
v findMethodsUseOfArribute
v findPackagesUseOfClass()
v findUseOfAttribute()

21 move( "OPERATION",intersect( getByNode('PROCEDURE_ACCESS"),getbyvalue($paraml)))
22}

23

24 guery: : TindMe thodCalls($paraml)

254

26 intersect(getByNode("FPROCEDURE_ACCESS"), getbyvalue($paraml))
27}

28

290//

30 // Find use of class 'paraml' within all packages

31//

32 query: : TindPackagesUse0fclass ($paraml)

34 offsetintersect( "FILE", GetByMNode('"Fackage"), move(2, offsetintersect (1,GetByvalue(t

The Intelli-sense features of Enterprise Architect's code
editors and it's search tools can make use of the information
mined from these databases.

Find in Files - 1 x

File Search 1 Find File

cpp ~| | findMethodCalls - || begin -8 V@
Result Address
c\ea\ea?S0Vibsource\spidermonkey\srcibuild_xB6.obj\dist\include\mozillavintegerrange.h -~
const_iterator cbegin{) const { return begin(); } 491064
c\ea\ea?30ibsource\spidermonkey\src\buil d_x86.obj\dist\include\mozillavrangedarray.h
iterator begin() { return mAm.begin(); } 539604
const_iterator begin() const { return mArr begin(); } 540144

c\ea\ea?30Vibsource\spidermonkey\src\builtinveval .cpp

const charle_t* chars = linearChars.twoByteRange() . begin().get(): 4344708
c:\ea\ea 7 30\ibsource\spidermonkey\src\builtinVint\collator.cpp
charsl.begin().get(). charsl.lengthi{), 4468612
chars2.begin().get(), chars2.lengthi{}}; 4462352
c\ea\ea?S0ibsource\spidermonkey\src\ctypesilibrary.cpp
fnptr = PR_FindFunctionSymbel(library, symbol.finish{).begin(}); 5150100
data = PR_FindSymbel(library, symbol.finish{).begin(}); 5152884 il

Analyzer Script: Model. Testcase Projects. Import Folder testcases. files in folders.spidermonkey Query: cpp:findMethodCalls ? begin

The currently active Analyzer Script, and also the query
parameters, are indicated across the bottom of the 'Code
Miner' page of the search too
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Code Miner Libraries

Code Miner libraries are managed in Enterprise Architect
using the Analyzer Script Editor. These Libraries are a
collection of Code Miner databases, one of which would
normally exist for each framework or project. The Editor
allows new databases to be created, and existing databases
to be added, updated or removed. Together, these databases
form the Code Miner Library used by the Intelli-sense
features of Enterprise Architect. The library can be used
locally, or it can be deployed to a server location where it
can service multiple clients. You select the scenario to use
on the 'Code Miner Service' page of the Analyzer Script.

This feature is available from Enterprise Architect Release
14.1.

Execution Analyzer: Exchanger.debug. jdwp

El-Build Code Miner Database Library
i+ Build
i Clean MNew

[l Test
Test Library Path Language  Source Recursive
5....Testpgint5 E\java\jdk-1.8.0 31\java|DK.cdb Java E\java\jdk-1.8.0_21\srcy  True

El- Debug E\cladonia-xistiexchanger.cdb Java E\cladonia-xdst\exchan... True
Platform E\java\gwt-2.8.cdb Java E\java\gwt-2.8. 1\samples\ True
DebugRun

i Tracepoints
.. Workbench
[l Code Miner
Service
.. Libraries
= Private Options
L. Senvices 4 4
- Run ' - .
- Deploy Code Miner Query Library

- Recording
.. Simulation e:'da\.'&hsparx-queries.qul

- Merge

Cancel Help
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Access

On the Execution Analyzer window, locate and double-click
on the required script - the script editor dialog will display.
On that dialog, select the 'Code Miner > Libraries' page.

Ribbon Execute > Tools > Analyzer, or

Develop > Preferences > Analyzer > Edit
Analyzer Scripts

Creating a new Database

Use the 'New' button to create a new database. In the new
dialog, enter the parent folder of the project source code,
select the programming language and enter the destination
path for the Code Miner database. When you click the
Create button details of the build are displayed in the log
window.
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Create Code Miner Database

Source E:'-Java'-hnmdrj-dnm"rj 1_6 Iisrcijaval

+| Process subdirectories

Language Java -
File Extensions. | *.java

Database path: | E\codemineriw2 1\dom4j.cdb
Macro List:

eljavatdom4dj-dom4dj_1_e_lisrc\javalorg\domdj\Node java
eljavatdom4j-dom4j_1_6&_ lisrcjavalorgidom4jirulelRule java
eljavaldom4j-dom4j_1_6&_lisrc\java\org\dom4j\swing\XMLTableDefinition.java
eljavatdom4dj-dom4dj_1_6&_lisrcijavalorg\domdjitreelAbstractDocumentType. java
eljavatdom4j-dom4j_1_6&_lisrcljavalorg\dom4jitree\BackedList. java
e\javaldom4j-dom4j_1_6&_l\srcljava\org\dom4jitree\DefaultDocumentType java
eljavatdom4j-dom4j_1_6&_lisrcljavalorg\dom4djitree\ElementONamelterator.java
eljavatdom4j-dom4j_1_6&_lisrc\javalorg\dom4jitree\ONameCache java
eljavatdom4j-dom4dj_1_e_Lisrcjavalorg\domdjiutinsSimplesSingleton.java
eljavatdom4j-dom4j_1_6&_ lisrcjavalorg\dom4jixpath\DefaultkPath java
eljavaldom4j-dom4j_1_6&_l\src\java\org\dom4j\xpp\ProexyXmlStartTag. java

Library created Evcodeminerw2. \dom4j.cdb

Create Add Cancel

When the process is complete press the 'Add' button to add
the newly created database to the library.

Adding an existing Database

Select an existing Code Miner database using the "..."
selection button in the database path field.

(Code Miner databases have the .CDB file extension), then
click on the Add button. Details about the database are listed
in the library. The information presented displays the
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programming language grammar used to build the database.
Also shown is the code base path parsed during the build
and whether the parsing process was applied recursively
through any sub directories.

Updating a Database

To update a single Code Miner database, select it from the
list and choose "Update Selected" from it's context menu.
Code Miner will recreate the database from the updated
code base.

Removing a Database

To remove a single Code Miner database, select it from the
list and choose "Remove Selected" from it's context menu.

Configuring Enterprise Architect to use a
Code Miner Library

In an Enterprise Architect Analyzer Script, choose the 'Code
Miner Service' page and select 'Use Library'. Enterprise
Architect then source its Intelli-sense information from the
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databases listed in the 'Libraries' section of the currently
active Analyzer Script.

Execution Analyzer: Intel |ava

- Build

- Build

i Clean

B Test

é----Test

L Te stpoints

- Debug

Platform Host : Port Macro

i~ DebugRun

E----Tracepoints Use Server 172.16.17.184:3001 #INTELHOST#

.. Workbench

[l Code Miner

Service

‘.. Libraries

= Private Options
L. Services

- Run

- Deploy

- Recording Code Miner databases provides support to Enterprise Architect intellisense, metrics and

- Simulation search tools. You can choose between a local library or server.

Code Miner Service:

Limit Query Results to: 200 FOWS

- Merge
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Code Miner Queries

Code Miner queries are best considered as functions written
in Code Miner's mFQL language. As such, they have
unique names, can be grouped by namespace and can take
one or more parameters. Queries are bundled together into
one source file. This source file 1s identified to Enterprise
Architect by naming it in your Analyzer Script.

When specified, the queries it contains are available in the
Code Miner control. Parameters to these queries can be
taken from selected text in a code editor, the model context
or typed directly into the search field of the control.

This feature is available from Enterprise Architect Release
14.1.

188

189 namespace java

190 {

191 //

192 // Find all references

193 //

194 query: : findByName($paraml)
195 {

196 distinct{GetByvalue( %paraml +))
197 }

198

199 query: : findMethodByName($name)
200 {

201 move( 1, "METHOD", intersect( GetByMode("MNAME"), GetByvalue( $name ) ) )
202}

203

204 query: : findMethodcall($name)

205 {

206 filter( "METHOD_ACCESS", intersect(GetByMNode("NAME"), GetByvalue( $name }) )
207}

20

o]

This image illustrates an mfQL query from the Sparx
Queries file distributed with Enterprise Architect
installations. The syntax for composing an mFQL query and
the mFQL language itself is described here.
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Query Syntax

The syntax for composing mFQL queries is:

namespace

{
query:name([ Sparaml [, Sparam?2 ]])

{

mfql-expression

where:
. namespace names the collection of queries
. name 1s the 'function' name of the query

. $paraml and 2 are placeholders for argument
substitutions at runtime

. mfgl-expression is an mFQL expression
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Code Miner Query Language (mFQL)

The Code Miner system provides fast and comprehensive
access to the information in existing source code. By
parsing all source code and storing the resulting Abstract
Syntax Tree (AST ) in a read-optimized database, the
system provides complete access to all aspects of the
original source code, in a machine understandable format.

The core goal behind the system is to provide access to the
data hidden within source code in a timely and effective
manner. Great pains have been taken to ensure maximal
performance, while providing the simplest interfaces
possible. As a result the system can be used to analyze
program structure, calculate metrics, trace relationships and
even perform refactoring.

mFQL

mFQL is the query language of the Code Miner. The
language itself is reasonably simple, providing a small
number of commands. Simple as the language 1s, it supports
queries of arbitrary size and complexity. The design
provides extreme performance for all queries, great and
small.

The language 1s set-based; it operates primarily on sets of
abstract data obtained through discrete vertical indices. For
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our purposes, a set i1s an ordered array of numbers, each of
which is a pointer to a node in the AST Store. A discrete
vertical index provides a mechanism to retrieve sets by
discrete value.

The language includes the three basic set-joining operations.
These are 'intersect', 'union', and 'except'. The 'except' join
1s, more precisely, a 'symmetric difference' join. A
'complement' join can be achieved by using a short
sub-query; this is detailed in the 'except' join documentation.
The 'offsetIntersect' join 1s also discussed in detail there.

The Code Miner database provides three discrete vertical
indices in 1ts AST Store. These indices are 'node name',
'attribute name', and 'attribute value'. Each vertical index
can be queried for a discrete value, which will return a set of
all nodes where that value is present. The three vertical
indices are queried using the functions 'getByNode',
'setByName' and 'getByValue', respectively.

Set 'traversal routines' provide mechanisms to filter sets
based on patterns in the AST. The traversal routines are
either destructive (move) or non-destructive (filter).
Destructive traversals modify the set member values to point
to the target node; non-destructive traversals ensure the
target node exists. In both cases, nodes that cannot
complete the traversal are removed.

Please note that all traversals in mFQL are upwards.
Downwards traversals are technically complex, as a node
could have any number of child nodes. Conversely, upward
traversals are much simpler, with every node having zero or
one parent node. For these reasons, downward traversals
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are not supported in the query language.

Although there are only a small number of operations in
mFQL, the language 1s capable of expressing very finely
grained and complex queries. The language 1s functional in
design, and supports arbitrary nesting calls.

mFQL queries execute at lightning speed. The backend
database was designed from the ground up for read
performance. The query parser was hand optimized.
Knowing that it always has pure ordered sets, the low-level
code takes several shortcuts to perform joins with minimal
work effort.

In order to use nBNF effectively one must possess a
working knowledge of the target language, and an intimate
knowledge of the grammar used to parse it.
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Set Extraction

These procedures extract sets from discrete vertical indices.
There are three indices available, each with a specific
extraction function. String literal parameters to these
functions could be case sensitive. Case sensitivity 1s defined
by the language of the source code used to populate the
database. If the source language is case sensitive (as C++
is) all string literal parameters are case sensitive. If the
source language is case insensitive (as SQL 1s) all string
literal parameters are case insensitive.

GetByNode

getByNode(value: string)

Extract a set based upon node name. The exact name for a
node 1s defined by the grammar used to parse the original
source. In this example, all nodes with the name

"OPERATION" are returned.
getByNode("OPERATION")

GetByName

getByName(value: string)

Extract a set based upon attribute name. All nodes with one
or more attributes of the specified name are returned. If a
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single node has two attributes of the same name, one
instance of that node is returned. This example returns all
nodes with one or more attributes named "NAMEPART".

getByName("NAMEPART")

GetByValue

getByValue([+] value: string [+ value: string] [+])

Extract a set based upon an attribute value. When extracting
nodes by attribute value, the value of all attributes for the
node are considered. Wildcards allow for specifying a
subset of attribute values for a node.

When a single value is provided, all nodes that have a single
attribute with the value specified are returned. If a node has
any other attributes, it 1s excluded. In this example, all nodes
with exactly one attribute with the value of '1' are returned.
getByValue(''i")
More than one value can be specified by using a
concatenation symbol. When more than one value 1s
specified, the resulting set will contain all nodes that have
attributes with exactly the values specified, in the order
specified. Any node with extra leading or trailing attributes
is excluded. This example retrieves a set of all nodes with a

set of three attributes with the values “com™, “.” and “sun”,
1n that order.

getByValue("com" 4" "Sllll")
Wildcards can be used at either the beginning or end of a
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value specification. A leading concatenation symbol allows
for any number of attributes preceding the first matched
attribute. A trailing concatenation symbol allows for
arbitrary trailing attributes. In both cases, 1f the node would
match without wildcards, it will match with them — the
wildcard specifies any number of leading/trailing attributes,
including none.

In this example, we retrieve a set of nodes that have their
last two attributes being “.” and “sun”. The leading
concatenation symbol specifies that any number of attributes
(including none), with any value, can exist before the

matched attributes, but none can follow.
getByValue(+ “.” + “sun”)
The next example has a trailing wildcard. Any node with

29 ¢¢ 9

attributes “com”, ““.” and “sun” as the first three attributes
will be returned. Any number of trailing attributes can exist.

getByValue(“com” + “.” + “sun” +)
Both wildcards can be used together. In this example, nodes

with attributes named as the three values specified, in order,
regardless of leading or trailing attributes, will be returned.

getByValue(+ “com” + “.” + “sun” +)
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Set Traversal

Move

move(count: number, source: set)

move(value: string, source: set)

move(count: number, value: string, source: set)

The move function traverses each node in a set up a number
of parent nodes, excluding any nodes that fail the traversal.
The number of nodes to traverse, the name of the target
node for the traversal, or both can be provided as
parameters.

. When the number of nodes is provided, but the target
node name is not, any nodes with the specified number of
parents will pass the traversal; any node that runs out of
parents will be dropped from the set

. When the name of the target 1s specified, but the number
of nodes to traverse 1s not, nodes with a parent with a
matching name at any point in the hierarchy will pass the
traversal; any node with no matching parent is excluded

. When both the number of nodes and the target name are
provided, only nodes that have a parent node with the
specified name at the specified offset pass the traversal;
all other nodes are removed from the set

It 1s possible - even likely - that these calls will generate sets
having duplicate values. This is by design, as the concrete
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rules for sets do not define them as being discrete. If (as in
most cases) you want your set to be discrete, use the
'distinct' function described in the Helper Functions Help
topic.

This sample extracts a set of all nodes named
'OPERATION!', then traverses each node up one level to its
immediate parent. Any 'OPERATION' node with no parent
1s excluded.

move(l, getByNode(""OPERATION"))

This sample extracts a set of all nodes named
'OPERATION!', then traverses each node up to the first
'CLASS' parent node. Any 'OPERATION' node with no
'CLASS' parent is excluded.

move(""CLASS", getByNode("OPERATION"))

This sample extracts a set of all nodes named
'OPERATION!', then traverses each node up one level to its
immediate parent. If the parent node is not a 'CLASS' node,
or the node fails to traverse though a lack of parent nodes, it
1s excluded.

move(l, "CLASS", getByNode("OPERATION"))

Filter

filter(count: number, source: set)
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filter(value: string, source: set)

filter(count: number, value: string, source: set)

The 'filter' function 1s the same as the 'move' function,
except that it does not modify nodes — it is non-destructive.
If a node 1s unable to pass the specified traversal, it is
removed from the set. Nodes that pass the traversal are left
in place, unmodified.

It 1s often desirable to filter a set by the current node name.
This can be used to ensure that the nodes returned from a
'setByName' or 'getByValue' call are of a particular node
type. This example returns all nodes with an attribute with
the value of “CFoo0”, where the resulting node is a “TYPE”
node.

filter(0, “TYPE”, getByValue(“CFo00”))

For more details on the use of the 'filter' function, see the
'move' function.
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Set Joining

Intersect

intersect(left: set, right: set)

An 'intersect' join will return a set containing all nodes that
exist in both the left and right set. This join 1s comparable to
a bitwise AND operation. In set theory, this type of join is
called an 'intersection'.

{1, 2, 3} intersected with {2, 3, 4} results in {2, 3}
This example returns a set that contains all nodes that have a
single attribute with the name of “TYPE” and the value of
“Int”.

intersect(

getByValue("int"),

getByName("TYPE")

)

Union

union(left: set, right: set [, right: set])
'Union' joins return a set that includes all nodes found in
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either the left or the right set. This join is used to combine
the results of two or more sub-queries into a single set. A
'union' join 1s similar to a logical OR operation. In set
theory, the 'union' join 1s known as a union.

The 'union' join is able to operate on more than two sets.
The result is a set that contains all nodes from all supplied
sets. The 'union' join is the only join able to operate on more
than two sets.

The result of a 'union' join 1s always a discrete set, unless
one of the source sets contained duplicates. This means that
duplicates in source sets will be preserved, but the 'union'
join itself will not generate duplicates.

{1, 2, 3} unioned with {2, 3, 4} results in {1, 2, 3, 4}
This sample creates a set containing all nodes with an
attribute named “TYPE” or a single attribute with the value
of “int”,

union(

getByValue("int"),

getByName("TYPE")

)

Except
except(left: set, right: set)
'Except' joins return sets that contain any nodes from either

set that do not appear in both sets. This join 1s similar to a
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bitwise XOR operation. In set theory, this type of join is
referred to as a 'symmetric difference' join.

{1, 2, 3} excepted with {2, 3, 4} results in {1, 4}

For more information on the 'symmetric difference' join in
set theory, see
http://en.wikipedia.org/wiki/Symmetric_difference.

This sample returns a set of all nodes with an attribute
named “TYPE” but no single attribute with the value of
“int”, plus all nodes with an attribute with the value of “int”
that are not named “TYPE”.

except(
getByValue("int"),
getByName("TYPE")

)

Exclude

exclude(left: set, right: set)

'Exclude' joins return a set that contains all nodes from the
left set that do not appear in the right set. In set theory, this
type of join 1s referred to as a relative complement join.

{1, 2, 3} complemented with {2, 3, 4} results in {1}

This sample returns a set of all nodes with a value of “int”
that are not “TYPE” nodes:

Exclude(
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getByValue(“int”),
getByName(“TYPE”)

)

Offsetintersect

offsetIntersect(count: number, left: set, right: set)
offsetIntersect(value: string, left: set, right: set)

offsetIntersect(count: number, value: string, left: set, right:

set)

The offsetIntersect function performs both a non-destructive
tree traversal and an intersect join in one operation. Each
node 1in the left set is traversed according to parameters
provided, then the result of the traversal 1s intersected with
the right set. If the intersect passes, the original node i1s
added to the result set. If the intersect fails, the node 1s
excluded from the result set.

The traversal parameters for offsetIntersect are the same as
for 'move' and 'filter'. For more information about the
traversal parameters, see the 'move' function described in the
Set Traversal Help topic.

This sample takes all “NAME” nodes, traverses them up one
parent, and intersects them with a set of all “CLASS” nodes.
If a “NAME” node passes both the traversal and intersect
join, it 1s added to the result set. The result is a set of all
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“NAME” nodes whose immediate parent is a “CLASS”
node.

offsetIntesect(1,
getByNode(“NAME”),
getByNode(“CLASS”)

)
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Helper Functions
These functions are helpful in mFQL query compositions.

GetByAddress

The getByAddress function is used in applying the results of
one query to another. For example, we might have a node of
particular interest, and we want our query to return only
nodes that join (in some way) to the specified node.

getByAddress(node: number)

This sample builds a set containing the single node related
to the address specified:

getByAddress(11256)

To create a set of more than one node, use several calls to
the node function from within a union join. This sample
creates a set of three specific nodes:

union(

getByAddress(11256),
getByAddress(55388),
getByAddress(117740)

)

GetByPosition
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getByPosition(File: String, Offset: Number)

The getByPosition function is used to return the inner most
node that covers a certain position in a file. This function 1s
useful for locating a position in the AST based upon a file
position.

Distinct

distinct(source: set)

The distinct function ensures that a set has no duplicate
values. All duplicate values are excluded from the result
set.

This function is required to handle a side effect of the move
function; it can create a set that includes duplicate nodes.
The move function operates in this manner by design — it
should only remove nodes that fail the specified traversal,
ensuring the resulting set is discrete 1s beyond its scope and
(in some cases) undesirable behavior.
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Code Miner Service

The Codeminer service program provides a means for
development projects and players to gain valuable insight
into the code bases and software frameworks they are
working with. The service acts as a provider to Enterprise
Architect clients, allowing access to Intelli-sense in code
editing and insightful search results in search tools.

The Codeminer service is part of the Sparx Satellite

Services umbrella. The service can run on a local network or
Cloud running Microsoft Windows. The Codeminer
Satellite service can be installed as a Windows service or
run as a standalone process. The service allows multiple
Enterprise Architect clients to access and query the same
information from many different software domains and
frameworks.

This feature is available from Enterprise Architect Release
14.1.
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Service Configuration

Service program

The name of the service program is SparxintelService.exe

Configuration File

The service 1s configured by the file
SparxIntelService.config

The file must be located in the same directory as the service
program.

The file contains a number of directives and also lists the
Codeminer databases to be served.

The file is read once when the service is started.

Directives Description

port The port number on which the service
will listen.

allow Names a domain or 1p address that 1s
allowed access.: 198.% or 127.0.0.1

nn

network Values can be "public", "network" or
"private".
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Use "private" when allow directives
specify one or more single ip addresses.

Use "network" when allow directives
specify a wildcard domain: 198*

Use "public" to allow all clients.

database Names the full physical file path of a
Codeminer database on the server.

Running the program standalone

From a normal console enter the command:
SparxIntelService -listen

icrosoft Windows [Version 6.3.7688]
(c) 2013 Microsoft Corporation. All rights reserved.

sUsersssparxsys>od Cisservers

tsservers *iparxIntelfervice —listen
Liztening on port 900
Loaded database e:“scodeminersjdkl.cdh
Loaded database e:>codeminershogsoftiB.cdh
Loaded database e:“codeminersatlmfc.cdh

Installing as Windows Service

From an Administrative console enter the command:
SparxIntelService -install
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Client Configuration

Configuring Enterprise Architect to use a
Codeminer Service

Enterprise Architect uses components known as Analyzer
Scripts for the configuration of many support systems. This
1s where the location of the server 1s specified. This image
shows the Code Miner service page of a script.

Execution Analyzer: Code Miner Services

= Build

- Build

i Clean

- Test

E----Test

L Te stpoints
- Debug
Platform Host : Port Macro

i DebugRun

E----Tracepoints *! Use 5erver 172.16.17.124:3000 #INTELHOST#
- Workbench

Code Miner Senvice:

Use Library

+| Use Service for Intellisense

‘.. Librarie

- Private Options
... Bervices

- Run

- Deplaoy

Limit Query Results to: 300 FOWS

- Recording Code Miner databases provides support to Enterprise Architect intellisense, metrics and
- Simulation search tools. You can choose between a local library or server.

- Merge

Access
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Ribbon Develop > Preferences > Analyzer > Edit
Analyzer Scripts
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